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Introduction 
cncKad is an NC code generator for CNC Punch and Laser machines. In this 
manual we will be covering the use of cncKad by punching machines 
The cncKad modules include a complete set of tools to aid you in creating the 
optimal program for your machine. Some of the functions included are listed below: 

• CONTOUR CREATION: The contours of the parts that you want to cut can be 
created either graphically by the user, with the aid of cncKad, or by importing 
a file from another drafting package (See the Punch Tutorial for a full 
description of this module). 

• GRAPHIC PROGRAM DEFINITION: Graphic interaction with the user that 
enables defining the desired CAM process, including the setting of all 
program options. 

• PROGRAM GENERATION (G-Codes Post Processor): Automatic generation 
of CNC programs. cncKad supports a very wide range of controllers and 
CNC languages. 

• FILE EXCHANGE: cncKad supports import of files in DXF, Iges or Cadl 
format from other drafting packages. 

• PROGRAM ARCHIVING: Sorted directories of CAM processed drawings, 
drafts and CNC programs, for backup and retrieval. 

This current version of cncKad is intended for use on Windows2000, Windows XP 
and Windows Vista® workstations.  
cncKad includes five modules: 

• Drafting 
• CAM placement (processing)  
• Nesting 
• Simulation 
• DNC (communication to machine) 
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1 Punch Manual 
 
From this menu you can place the actual punches on your part. There are two 
options for placing punches on your draft, adding a Single Punch, or using Auto 
Punch, and several options for defining your CAMing: 

 

1.1 Add Punch 
You can also click the Add Punch button  from the Common Toolbar –  

.  
The following dialog will appear: 

 

1.1.1 Single Punch 
Adding single punches to your part will place one instance of a selected tool at a set 
position. A single punch can be a hole in the sheet or a punch on a contour. 
There are several ways to add single punches to your geometry, the one that you 
choose depends on the cut you need. 
Single punches are selected by clicking the Single option in the punch type area. 
The precise type of punch can be selected from the Single Type dropdown list: 
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All single punches visible on the drawing are marked with hatched lines. 

1.1.1.1 Single 

 
With this option the user will be able to add a single punch to a specified entity. After 
selecting the single option, click the entity on the drawing that you wish to punch. It 
will be punched using the currently selected tool. 

 
If you are punching a circle place the cursor near the contour of the circle and click 
the mouse button. Don’t try to fit the punch outline into the circle. The tool selected 
does not have to fit exactly to the hole to be punched. 
When a single punch is placed on the part, it is defined as the tool shape filled with 
hatch lines. 
If you selected a line entity for punching, the placement of the punch on the line will 
depend on the option selected from the Tool Positioning dropdown list. For more 
information on this option, see the Tool Positioning section of this chapter. 

1.1.1.2 On Line 

 
This option will punch all the entities that lie on the same line at equal distances. 
The user is required to locate two entities that lie on the line. cncKad will take the 
angle and the distance between the two points and will search for more holes which 
were placed at the same angle and distance. Selected holes will be punched with the 
current tool. If the Auto Tool option is checked, the cncKad will select the 
appropriate tool from the Tool library. 
Depending on the type of controller that your machine has, the NC code will differ for 
this command. For instance with Fanuc controllers, the created code will be G28. 
 



cncKad 

4 

      

1.1.1.3 On Arc 

 
This option will punch all the entities that lie on the same radius, with the same angle 
between them. 
The user is required to locate three points on the circumference of the arc, the 
cncKad will then check if there are any more holes on the same radius and the same 
angle between them. All selected holes will be punched with the current tool. If the 
Auto Tool option is checked, cncKad will select the appropriate tool from the tool 
library. 
Depending on the type of controller that your machine has, The NC code will differ for 
this command. For instance with Fanuc controllers, the code issued will be G29. 

      

1.1.1.4 In Window 

 
This command will punch the selected closed contours that fall within a user defined 
window, providing they are either Squares, Circles or Ovals. If the Auto Tool option 
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is not checked, the cncKad will only punch contours that fit the currently selected 
tool. If checked, all the contours that have suitable tools in the tool library (or the 
Setup File, whichever is chosen) will be punched. 

Contours that fall only partially within the boundaries of the window will also 
be punched (if they conform to the above mentioned shapes). 

1.1.1.5 Punch All 

 
This option takes all the closed contours on the part and punches them with the 
appropriate tool, when the Auto Tool option is checked. If it is in the manual mode, 
only contours that fit the currently selected tool will be punched. 

1.1.1.6 Punch Free Hand 

 
With this option, the user can freely punch with the currently selected tool, anywhere 
on the part. 
When this option is selected, an Angle field is opened: it allows the user to enter the 
angle for the punch placement. 

1.1.1.6.1 Dynamic Angle Change 
There is a function for single free hand punches, which allows for dynamical change 
– increasing or/and decreasing the angle of the tool we want to punch with. All you 
have to do is to press on your keyboard the "+" button, in order to increase the angle 
of the tool or "-" button, to decrease it. 

1.1.1.7 On Punched Entity 

 
With this option, operate a split on an already Punched Entity and place a Single 
Punch. While placing it you can define two values: an Offset from the beginning of 
the Entity and the Distance separating the new Single Punch from the Existing 
Punch. 
For the following example, 
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a Single punch on a Punched Entity will look like the following: 

 

1.1.2 Nibble Entity 
This command will nibble one selected entity. Select a tool to nibble with, define the 
positioning of the tool on the entity, define the spacing (if needed) and click the OK 
button to close the punching dialog. Choose a line entity you wish to punch and click 
the near one of its endpoints. The endpoint that is nearest to your selection point will 
be defined as the starting point. If you have defined offsets, the first offset distance 
will be from this endpoint. 

      

1.1.3 Nibble Chain 
This command will nibble, with a selected tool, a chain of entities. For this command 
to work, all the entities in a chain must be connected at their endpoints. 
When selecting a tool to cut a chain of entities, you must select a tool that can cut at 
different angles. This means that if you select a rectangular tool, that tool must be in 
an index station, or at an angle that fits the desired cut. 
Select a tool to nibble with, define the positioning of the tool on the entity, define the 
spacing (if needed) and click the OK button to close the punching dialog. Next locate 
and click with the cursor the first entity in the chain, and then the last one. These two 
entities and all those in between them will be punched.  

1.1.4 Nibble Contour 
This command nibbles a closed contour. The contour can be made up of lines and 
arcs, the end points of the entities must be touching. 
Select a tool to nibble with, define the positioning of the tool on the entity, define the 
spacing (if needed) and click the OK button to close the punching dialog. 
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Select an entity on the contour and the contour will be punched. 

1.1.5 Nibble Start-End 
This command will nibble entities that are not connected with each other, lying along 
the line.  
Select a tool to nibble with, define the positioning of the tool on the entity, define the 
spacing (if needed) and click the OK button to close the punching dialog. Select the 
first entity and then the last one, as shown below. As you can see, all the entities 
lying on the same line will be punched. 

 

1.1.6 Crunch 
This command works on closed contours of circular areas. On rectangular areas it 
works also on open contours.  
Select an appropriate tool for crunching with. If you are crunching a rectangular area 
you should use a square or a rectangular tool and if you crunch a circular area you 
should use round tools.  
Define the offsets, if any, and click the OK button to close the punching dialog. 
Click with the mouse cursor next to one of the corners (entity's endpoint) of the 
rectangular shape to be crunched, e.g. the bottom left, and then select the 
perpendicularly opposite one, e.g. top right. The area in between will be punched. 
When you want to crunch the circular shape, just choose the proper tool and click the 
area you want to be punched. 

     
 
The following shows crunching of a circular hole: 
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The below example shows crunching of the outer contours between two parts: 

 
The same way this option can be used to crunch material between any two 
perpendicular points. 

1.1.6.1 Crunching a notch with one tool 
This feature makes it possible to punch two adjoining entities of the notch with one 
tool equal or bigger than a notch. This can be done with the aid of Crunch option. On 
the picture below you can see the 20mm notch punched this way with RE 30 tool. 
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1.1.7 Crunch Right-Angled Triangle 
This option only becomes available for Square tools. If you will choose and 

try using any other tool type – you will be presented with the following 
warning: 

. 
This option enables you to crunch a triangular geometry only if there is a 90 degree 
angle. 
After selecting this option in the dialog, you must choose the starting point for the 
crunch, (the Status Bar will show the following: 

). 
Now choose the opposite end point (the Status Bar will show the following:  

).  
The area between them will be punched. 

 

1.1.8 Crunch Chamfer 
This option enables you to crunch a Chamfered Entity, and it can be done with 
Square, Rectangular, as well as with Double-D tools: 
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1.1.9 Crunch Arc 
This option enables you to crunch an outside Arc. This can be done only with round 
tools: 

 

1.1.10 Punching Grids 
This command creates an array or grid of punches. When selecting it, the following 
area of the punch dialog is activated. 

 
There are four options in the grid dropdown list: 

• Snake X 
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• Snake Y 
• Uni-direction X 
• Uni-direction Y 

The difference between these options is the way (Snake, Uni-direction) and the 
direction (X, Y) in which the grid will be punched. 
 
Creating a Grid: 

• Select the Grid option and select the tool that you wish to punch with. 
• Define the amount of punches in the X and Y directions. 
• Define the distances between the punches. The distance is defined from the 

center of each punch to the center of the next punch. 
• Click the OK button to close the punch dialog. 
• Locate the entity on which the first punch of the grid will be placed. 
• The grid can be deleted by selecting the first punch in the grid. 

 

 

1.1.11 Choosing a Tool 
Pressing the Tool button, from the Tool Section of the Add Punch dialog, you will be 
redirected to Tool Selecting dialog, where from Tool Library and Setup File tabs you 
will be able to choose desired tool for processing entities with. 

1.1.12 Tool Positioning 
Before positioning the punch, the user must define two parameters: 

• The Side of the punch:  
The Side Button can be found on the State Bar, on the left side of the 
screen; there are three options which define how the tool is placed in relation 
to the line, arc, or circle selected for punching: 
o Side – the edge of the punch will be placed on the side of selected entity. 
o Tip – the center of the punch will be placed on top of the line. 
o Auto – the punch will be placed automatically on the correct side of the 

entity. Before activating this option, make sure to run the contour 
recognition checks on the current part, so that the program would 
recognize the difference between holes in the part and sheet metal and 
would know on which side of the contour to place a punch. 

• The Index definition: 
The Auto Index button can be found on the State Bar, and has two states: 
o On – In this state, the currently selected tool will rotate itself to the angle 

of the line selected. This is only for machines that have Auto Index 
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stations (rotating stations). There are usually only a few rotating stations 
on most machines, therefore you should be careful not to use more 
rotating tools than you have stations for. 

o Off – In this state, the tool will be placed on the selected line at the angle 
that was defined, for the tool within the tool library. If this angle is incorrect 
for the line selected, a warning will appear giving the user the option to 
cancel the punching procedure or to continue. 

After defining all the above parameters, from the dropdown menu choose the 
Positioning for your punch: 

 

1.1.12.1 Offset 
This option gives you an opportunity of offsetting the tool from the edges of the 
entity, of the part (rectangular block) or of the sheet, by a given distance (from Start 
and End dropdown lists you can choose one of the options). 

 
You can set the Start value of the offset for instance from the end of the entity and 
the End value for the end of the part.  

The Start and End dropdown lists are available for Nibble Entity, Nibble 
Start-End, Crunch and Crunch Chamfer options. 

The offset distance values are defined in the offsets Start and End fields within the 
Tool Positioning section. They can be positive or negative. If the value is negative, 
the punch will be placed in from the start of the chosen element, if it is positive it will 
overhang from line's end. 

The second offset value (End) is used for nibbling and crunching of non 
restricted spaces. Therefore for single punches, crunch triangle and 
grid options there will be only one offset value field available.  

Entering a negative offset value can be used for creating Micro Joints between parts. 
The following are examples of different offsets: 
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- i.e. "-2", in the offset field 

1.1.12.2 Entity's End 
With this option, the center of the tool will be placed at the endpoint of the line. This is 
done automatically with no need for any additional parameter input.  

    

1.1.12.3 Tool's End Tangent 
Using this option will place the end of the tool tangent to the end of the line. This is 
equivalent to Offset = 0. 

      

1.1.12.4 Next Entity's Tangent 
This option is useful for round and oblong tools. 

This option will place the tool tangent to the next entity in a chain of entities. The 
endpoints of the entities must be connected. 

 

1.1.12.5 Centered 
This option will place the punch on the center of the line selected. It doesn't matter 
where you select the line, the punch will always center itself on the line. 

 

1.1.12.6 On Shape Center 
This option will place the shape of the tool exactly in the middle of the shape (NOT 
entity) we want to punch. 
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This way we will be able to process a hole with a tool that is not an exact match, and 
the punch will be still placed in the hole’s center, e.g. an oval hole of 31 by 10 
processed with an OB 30 10 tool: 

 
This option works only for standard shapes – Rounds, Squares, 

Rectangles, Ovals, Rounded Rectangles and Single/Double D. 

1.1.13 From Base Line 
This option is available for Crunch and Crunch Chamfer Punch Types.  
Marking this checkbox allows you for crunching nonstandard notches, of an angle 
larger than 90°. This means that the offsets set for the crunch will be measured from 
the Base Line of the notch. 

This option is unavailable for Crunch punch type for which scallop type of 
Tool Spacing was selected. 

1.1.14 Tool Spacing 
The Tool Spacing options define how much overlap there will be on the tool when 
nibbling. 

1.1.14.1 Overlap Definition 
When the overlap is defined as 0%, the current tool will arrange itself on the contour 
with the minimal overlapping. If you choose to nibble an entity with a tool that is 
longer than one and a half times the length of the entity, you will receive a warning 
(provided you have marked the appropriate option in the Punch and Cut Warnings 
of the Workspace Settings dialog in Drafting and Nesting Manual). Clicking OK 
button will nibble the entity, clicking Cancel button will annul the operation, and the 
entity won’t be punched. 
See the examples presented below. The punches here were made with 0% overlap: 

• The following case produces no warning because it is a correct procedure: 
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• The following case will produce a warning because more than half the punch 
is overlapping: 

   
When the overlap is defined with a percentage other than 0, the tool will be 
overlapped by that percentage. This can be used for cutting arcs and circles. The 
greater the overlap, the smoother the cut will be. See the following two examples: 

• Cut defined with 0% overlap. 

 
• Cut defined with approximately 75% overlap. 

 
If you define an overlap that has a step less than the sheet thickness, you 

will receive a warning (as before, only if you mark this option in Punch 
and Cut Warnings). 

1.1.14.2 Step Definition 
With this option the distance between the centers of each punch in a nibbling cycle, 
is defined. If a distance, that is less than the sheet thickness is defined, a warning will 
be received. 
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1.1.14.3 Scallop Definition 
This option is accessible only when a circular tool is being selected. The scallop is 
the height of the tooth that is left between the punches of a circular tool. See the 
following picture: 

      

1.1.15 Tool Sequence 
Here the user can set the sequence of the tool.  
For more information on this function go to Set Tool Sequence section of the CAM 
Menu chapter of this manual. 

1.1.16 Use Tool Data 
With this function you will be able to utilize any special features assigned to a certain 
tool. Here you can view and edit chosen tool's data – add a comment, choose the 
station for it and define whether it should be used as Close to Clamps tool or not.  
In this example we will view the Tool Data of a Wilson Wheel Louver tool: 

 
Special tools have one more option – Type Properties tab. Clicking it will enable you 
to define specific parameters for a punch made with the tool you chose: 
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This means that for every punch you place on your part with this tool you can use 
different settings. 

1.1.17 Directional Punch option 
Choosing this option will add a direction to your punching. When you place the punch 
on a part, clicking the entity endpoint, you will see that a blue arrow (or a red one – 
depending on the background you are working on) was added to the beginning of 
your placement, showing a direction the punch was made in. 

 

1.1.18 Punch as Singles 
This option concerns Nibbling and allows the user to execute the Nibble as Single 
Punches. Thereby, each punch will get a separate line in the NC code. 

1.1.19 Wheel Connect 
This function is available, when the Wilson Wheel Tool is currently chosen. 
If this box is checked, the Wilson Wheel will process the part's contour continuously 
(without stops, which it usually does) – it will connect between one punch and the 
next one. 

By default this option is checked for all nibbling types, except for nibble 
entity. 

1.1.20 Functions button 
This option allows you to access the Functions for Selected CAM dialog directly 
from the Add Punch dialog.  

1.1.21 Stop or Push Out 
This command is for machines that have a chute on the table. Parts that have been 
punched/cut out of the sheet can be pushed out via the chute. This prevents from 
having to use a Stop Machine command, in order to remove the part. The position of 
the chute varies from machine to machine.  
See full explanation in the Push Out (Chute) section of CAM Menu chapter in this 
manual.  

1.1.22 Wire Joint 
Choosing this option (by checking the Perform box) you will be allowed to place 
Wires as an integral part of the Punch.  
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You can set the width of the Wires (W) as well as the maximum distance between 
them (ML), and they will be integrated into the Punch, without splitting the entity 
being punched: 

 
Choosing one of the After First Hit and Before Last Hit options enables creating 
Wires after the first and before the last punch. They address the issue of rounded 
corners when punched by round tools. 
After placing the punch, you can return and Edit it (clicking on the Edit CAM icon – 

 from CAM Toolbar) changing the parameters, without having to edit several 
entities (as it would happen with regular Micro Joints that have been placed after the 
entity has been punched). 

1.1.22.1 Width 
This parameter sets the width of the Wire joint(s) placed for this punch. 

1.1.22.2 Max Length 
This option is very useful when the precise position of the Wire joint(s) is not 
important. This parameter sets the maximum distance between two Wires, and NOT 
the position relative to the entity’s end. 
If you define a Max Length of 80 for an entity with a length of 100, this does not 
mean that there will be a Wire at 80mm from entity’s beginning. The exact position 
will depend on the tool chosen for the punch – the Wire will be placed at tool's Hit 
Boundary. 
Below there are two punches defined with a Max Length of 80: 
The punch on the left was made with an RE 50 5 tool and the Wire was placed 50mm 
from the entity’s beginning.  
The one on the right was made with an RE 20 10, and the Wire was placed at 60mm. 

 
(These Wires were made with a Width of 5 for demonstration purposes.) 

1.1.22.3 At Least One 
This option is very useful when you want to place just one Wire more or less in the 
middle of a punch, and the exact position is not important: 
Set the Width at the desired value, and the Max. Length at a very large value (larger 
than possible, such as 10000). 
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The result will be one Wire positioned the tool Hit Boundary nearest the middle of the 
entity being punched. 

1.2 Auto Punch 
By using this feature you allow the program to punch the whole part automatically.  

You can also click an icon  from the Common Toolbar – 

. The following dialog will appear:  

 

1.2.1 Auto Punch Parameters tab 
On this tab you will be able of defining optional settings for automatic processing of 
the part. 
Auto Punch will only work on closed contours and viable entities, so before using 
this feature we would recommend to run a Check. Even if there are some bad 
contours, this will not prevent processing the correct ones. 
There are two options for running Auto Punch: 

o Auto will run Auto Punch for the whole part. 
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o Single will use Auto Punch on a selected entity. This option will punch 
just one entity at a time. But when you want to punch next entity you don't 
have to come back to this dialog. All you need to do is just to click the 
cursor next to it and it will be punched. 

See the subsequent sections for explanation on all the features which can be found 
on this tab. 

1.2.1.1 Tool Spacing Defaults 
These options address the issues discussed in Scallop Definition topic of the Tool 
Spacing section of this chapter. 
The value in this section is given in millimeters or inches, depending on your 
machine and the option you chose from working units section of Settings Menu 
chapter of Drafting and Nesting Manual. 

1.2.1.1.1 Minimum Tool Overlap 
Select a desired minimum Overlap to be used when tool overlap occurs.  

1.2.1.1.2 Scallop for Round Tools 
Here the user can enter the value of Scallop size, which will be implemented for 
round tools. 

1.2.1.2 Cutting Tools Restrictions 
In this section some limitations for the tools can be set. 

1.2.1.2.1 Minimum Width 
When punching the outer contour, use tools of no less than this width. 

1.2.1.2.2 Maximum Width 
When punching the outer contour, use tools of no more than this width. Use this 
parameter, to prevent the material waste on the outer side of contour. 

1.2.1.3 Tool Selecting Preferences 
Choose a strategy for selecting the tools. Move the slider between these two poles 
and set the proper option, using your judgment based on the situation. 

1.2.1.3.1 Best Tools 
Use as many tools as it is necessary (up to maximum quantity of tools that can fit the 
turret), in order to achieve best punching results. 

1.2.1.3.2 Minimum Tools 
Try, as much as possible, to re-use tools. This reduces efficiency. 

1.2.1.4 Odd hits, then Even hits 
Select a strategy for the last punch in the middle: 

• Never – don’t ever place the last punch in the middle. 
• Always – always, in every case, place the last punch in the middle. 

Choose an option between these two poles, based on the situation. 

1.2.1.5 Punching scope 
You can choose which range of entities will be punched. 

1.2.1.5.1 Holes 
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If you enable this option, the holes in your part will be processed, in accordance with 
the settings in the Holes tab. 

1.2.1.5.2 Notches 
If you want that all the notches in your part would be processed while running Auto 
Punch, you need to activate this option by marking the checkbox. Otherwise the 
Notch section will not be active and you won't be able to edit any of the following 
options: 

• Perform crunches – Selecting this checkbox will allow for automatic 
crunching the notches of the part; otherwise each entity will be processed 
separately. There are three types of notches that may be processed by Auto 
Punch: Corner Notch, Corner with Chamfer, and Right Angle Triangle 
Notch. See the below picture: 

 
Checking this option enables editing of the Maximum crunch tool ratio and 
Minimum Offset features: 

• Maximum crunch tool ratio – You can define maximum ratio between Width 
and Height of the tool that will perform the crunch. If you don’t care much 
about this option – set large number like "80"; if you want that a hole will only 
be crunched with a square tool – set "1".  

• Minimum Offset – Use this parameter to create an offset for the processed 
notch. The actual offset will depend on the tools and strategy chosen for 
processing the notch. Its value will be measured from the part's bounding 
rectangle, not from the contour edge of the notch. 

 
o a – the part's outer contour. 
o b and c – the slitting. 



cncKad 

22 

o d – the bounding rectangle 

In this case, a Maximum Offset of 0 will mean that the arc (q) cannot be 
processed! 

• Maximum Offset – This parameter will be used as a maximum – the actual 
offset will depend on the tools and strategy chosen for process the notch. 

1.2.1.5.3 Slitting 
If you enable this option, all the outer contours of your part will be processed. 

1.2.1.6 Use Tools Library 
This option will allow Auto Punch to process the parts on the sheet, using any fitting 
tool from the tool library. 

This setting DOES NOT apply to processing Holes. When you want that the 
holes would be processed using Tools Library, you need to set this 
option on the Holes tab. 

1.2.1.7 Use Setup File 
This option will make Auto Punch to use only tools from the selected setup file (any 
tools you have already added yourself to the part, will remain). 
You can select the appropriate setup file with the Select Setup button. 

This setting DOES NOT apply to processing Holes. When you want that the 
holes would be processed using Setup file, you need to set this option 
on the Holes tab. 

1.2.1.8 Select Setup 
Clicking this button you will be moved to the Turret Setups dialog of the Tools Menu. 
There you will be able to choose the setup file you want to use for processing the 
current sheet. 

1.2.2 Holes Tab 
Use this tab to define how holes will be processed by Auto Punch: 
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1.2.2.1 One Hit Only With matching Tool 
Checking this option means that all holes will be processed with single punches. 
Holes that cannot be punched in this way, will be left unprocessed. 

This option disables the Crunch option. 

1.2.2.2 Tolerance Settings 
In the following window it is possible to set tolerance for punching with specific tools. 
This means that by checking Active box and entering a value in either positive or 
negative column by the particular shape, the user will be able to punch holes whose 
size does not exactly match the size of the tools he possesses. 
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For example: If you have a hole with a 3.1 diameter and only a RO 3 tool, you can 
define a negative Tolerance (in "–" column type positive value) of 0.1, and when 
running Auto Punch, the RO 3 will be used. If on the other hand you have a hole of 
9.5 diameter and have no exact fitting tool, but only a RO 9.6 tool, set the positive 
value (in "+" column type positive value) of tolerance to 0.1 and when running Auto 
Punch the RO 9.6 tool will be used. 

Keep the Active row checked for all Shape types, unless you do NOT want 
a specific type to be processed. 

1.2.2.3 Crunch 
This option is used for setting the maximum size of rectangular holes that will be 
crunched, by entering their width and length in the appropriate fields. 

1.2.2.4 Wire Joint 
These parameters define how to place Wire joints when processing holes. 
For an explanation about how to set the size of the Place Every parameter, see the 
Wire Joint section in the Add Punch dialog. 

Regardless of the settings defined here, Auto Punch will place at least one 
wire on the long sides of rectangles, to ensure they remain attached to 
the sheet. 

1.2.2.5 For Holes 
Selecting one of these options you define the source from which the tools will be 
taken for processing holes: 

• Use tools library – this option will allow Auto Punch to use any tool from the 
tool library. 

• Use setup file – this option will force Auto Punch to use only the tools from 
the setup file chosen in the Auto Punch Parameters tab.  

1.2.2.6 Automatic Detection 
In this section, you can order the Auto Punch process: 

1. Not to detect groups of single punches – no group detection will be 
operated. 

2. To automatically detect lines of single punches – cncKad will detect 
automatically a line of single punches and turn their type into a "single; on 
line". 

3. To automatically detect grids – cncKad will recognize grids of singles and 
will change their punch type into a grid.  

The advantages of this option are the shortening of the NC code, but also the 
widening of edition possibilities for entities within cncKad: for instance, a punched 
grid will be shortened or extended more easily. 

If you are not interested in activating this option while using the Auto Punch 
feature, you can still define Automatic Detection for the NC code via 
the NC Program Creation => Post Processor Options dialog. In this 
case, the part will contain singles but the NC will contain "single on line" 
punches and grids. 

1.2.3 Slitting tab 
On this tab you can define various aspects of automatic placing of Micro Joints on 
the processed entity. 
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1.2.3.1 Micro Joint Parameters Section 
Here you have the possibility of setting various parameters for placing Micro Joints. 
They will be enabled only after you check the Apply Micro Joints box. 

1.2.3.1.1 MJ Width 
In this field you can set the general width of the Micro Joints to be created. 

1.2.3.1.2 MJ Width at Sheet Edge 
In this field you can set the width of the Micro Joints to be created on the sheet 
edge(s). 

1.2.3.1.3 MJ on corners 
There is an option of automatic setting the Micro Joints on the corners. This can be 
achieved in two ways: 
On One Edge: 

 

On Both Edges: 

 

1.2.3.1.4 Every corner 
Marking this checkbox you choose to place the Micro Joints on each corner of the 
part. But choosing this function disables the usage of The Minimal number of Micro 
Joints for this part option. 
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1.2.3.1.5 The Minimal number of Micro Joints for this part 
As the topic says, from the dropdown list you can select the minimal quantity of the 
Micro Joints to be placed on the current part. 

1.2.3.2 Wire Joints Parameters Section 
The options of this section will be enabled only after you check the Apply Wire 
Joints box. 
Here you can define parameters such as the width of the Micro Joints (W) as well as 
the maximum distance between them (ML).  

1.2.4 Shapes Tab 
From this dialog you can create special treatment for particular cases by creating 
Profiles, and using Predefined Shapes: 

 

1.2.4.1 Special Punching Section 
This section presents the options of special punching of untypical sized round holes. 

1.2.4.1.1 Profile 
A Profile is a set of instructions telling how specific holes will be punched.  
You can use the dropdown list to select which from the available profiles you want to 
use. If there are none, use the New button to create a new one, and the Delete 
button to delete an existing one. 
In our example we created a profile called Customer A, in which we have three 
round holes of atypical sizes. From the Shapes table let's take a round shape of 4.44 
diameter and in the Tooling table let's add the tools we want to process this hole 
with and set them in desired sequence. See the below picture: 
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After running Auto Punch each circle with a 4.44 diameter will be punched with the 
sequence of tools we just have set – first RO 3.5, then a Pre-tapping tool, and last a 
Tapping tool.  
Our hole processed with this sequence will look this way: 

 

1.2.4.1.2 Shapes 
In this table we can see various shapes that are specified in the current Profile. 
When a specific shape is selected, the tooling sequence defined for it appears in the 
Tooling section of this dialog. 

You can use the  button to add a shape to the profile, and the  button to 
delete a shape from the profile. 

1.2.4.1.3 Tooling 
This table shows the specific tooling sequence set for the item selected in the 
Shapes section of this dialog. 

You can use the  button to add a tool to the list, and the  to delete it from the 
list. 

1.2.4.2 Predefined Shapes Section 
After saving some specific shape, together with its process, as predefined one (see 
the Save As Predefined Shape section of this chapter) this section allows you to 
add such a predefined shape to the list: 
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After clicking Auto button all the Predefined Shapes from this table will be used to 
punch suitable notches and contours of the part. If there are neither suitable notches 
nor contours, the Predefined Shapes won't be used. 

1.2.5 Punch and Cut Warnings Tab 
The following dialog is displayed: 

 

1.2.5.1 Do Not Allow Over Tonnage 
Will not allow punching if a tool exceeds the Tonnage Limit of the machine. If the 
over tonnage will be detected, the following warning will appear on your screen: 

 
Here, as well as in the subsequently described other processing warnings dialogs, 
you will be able to decide about the action to be taken – you can choose not only 
whether continue the CAM or not, but also you will be given the possibility of 
choosing a default option for the similar situation in the future. 
To do so, check the Do not ask again this question box, and click one of the 
buttons. From now on, depending on your answer, cncKad will or will not process 
the entity, when there will be a danger of over tonnage will be detected. 

The action undertaken, chosen from the warning dialog, will be the case for 
the current part only and as long as you do not re-run cncKad. 

1.2.5.2 Do Not Allow Punch Destroys Part 
Will not allow punching if a punch will destroy the part. cncKad identifies also when 
the punch destroys the part for D, double-D, Cross and Special Tools. 
If in the Workspace settings on the Punch And Cut Warnings tab a proper option 
will be checked, a warning will be issued whenever Punch will destroy the part: 
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1.2.5.3 Do Not Allow No Station for Tool 
The warning appears only during NC creation. 

This option will not allow placing a punch on the part if there are not enough stations 
on the turret needed for placing the tools for this punch. 

1.2.5.4 Do Not Allow Over Travel in Y 
The warning appears only during NC creation. 

This option will not allow placing a punch if the tool cannot reach the point to be 
processed from where it sits in the turret. 

1.2.5.5 Do Not Allow Punch Less than 1.5 Tool 
This option will not allow placing a punch if the size of selected nibble or crunch is 
less than 1.5 times the tool size. 

1.2.5.6 Do Not Allow Punch Step Less than Thickness 
This option will not allow placing a punch, if the tool's step is less than the material’s 
thickness. It will not allow for punching also when during using Single punching the 
tool is smaller than the thickness. 

1.2.5.7 Do Not Allow CAM in Clamp Dead Zone 
Will not allow placing a punch in a clamp Dead Zone. 

1.2.5.8 Do Not Allow CAM is out of X working Range 
Will not allow placing a punch outside the table limits. 

1.2.6 Punching sheet edge  
The Auto Punch checks if the Automatically remove punches on sheet edge box 
is selected on the Post Processor Options tab of Workspace Settings. If yes, then in 
all cases where the part is placed at the sheet edge, the sheet edge won't be 
punched; if no, the sheet edge will be punched. 

1.3 Deleting Punches 
There are three methods for deleting punches: 

• Press Alt+F3 keys. 
• From the Edit menu select the Delete CAMs option. 

• Click the Delete CAMs icon –  from the Delete Toolbar – 

 
Use the standard Selection options to choose punches for deletion, and click Enter 

to confirm the selection; it is recommended you click Redraw icon –  in order to 
clean the draft after completing the deletion. 
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1.4 Set or Clear Last Hit on Center 
When crunching or nibbling, you can set the order of punches so that the last punch 
in the nibbling process will be in the middle. 

1.5 Directional Punch 
A directional punch is a cut that is defined to punch in a specified direction. This 
option may be used for tool technological reasons as well as for optimization 
reasons. 

1.5.1 Uni Directional 
This option is used for making a punch directional: 
Click the punch that you want to make directional. 
A red X will be placed at the starting point of the cut and you will be asked if you wish 
to reverse the direction of the punch, reply Yes or No and the dialog will be closed. 
A blue arrow (or red one – depending on the background you are working on) will be 
placed on the punch showing the direction that the cut will be made in. No 
optimization will change the direction of the cut. 
You can continue and select more cuts and make them directional: 

 

1.5.2 Bi Directional 
This option converts a directional punch to a punch with no specified direction, 
meaning that during the post processing stage the direction of this punch will be 
determined. 
Click the punches that you wish to make non-directional. 
Press Enter when you have selected all the cuts to change to non-directional. 

1.6 Save As Predefined Shape 
This feature enables you to define a specific shape with its punch(es), which will be 
recognized by cncKad and processed automatically with predefined tools assigned 
to it, after you run Auto Punch.  
After choosing this option, click on chosen punch, and save it. 
Then go to the Shapes tab of Auto Punch dialog, create new profile (or choose an 
already existing one) and in the Predefined Shapes section, clicking on the asterisk 
sign, choose the name of the file(s) you want to use. 
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2 The CAM Menu 
 
This menu deals with all matters pertaining to the manufacturing process, from 
placing the CAMs on your draft to various definitions governing the actual machining 
of the part. 

 

2.1 Setting Offsets 
These options allow you to create Offsets or edit existing ones. 

Changes may produce technological warnings. 

2.1.1 Edit Offsets 
After you have drafted your part and placed CAMs on it, this option allows you to 
choose a specific CAM and define an Offset for it. 
Choose this option from the menu, and click the CAM you wish to offset. The 
following dialog will open: 
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Define appropriate Offsets from the ends of the entities, and click OK button. 

2.1.2 Set Offsets 
With this option, first you define the Offset you want to set, 

 
and then click the CAMs you wish to apply it to. 

2.1.3 Set All the Offsets 
This option allows you to change a previously defined Offset. 
For example, if you have defined five punches with an Offset of "-5", and now you 
want to change all of these Offsets to "-2.5", this option lets you do this with one 
command. 
After you choose this option, the following dialog will open: 

 
• Old – here type the value of existing Offset. 
• New – here type the value of the offset you wish to change the previous one 

into. 

If you define Old as "0", it will change all the punches without any Offset. 

2.2 Change Tool for Existing Punches 
Select this option after choosing a tool in the Used Tools List of the State Bar. The 
following dialog will appear: 
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Here the user will have the possibility of assigning one new tool for all the selection. 
Choose the new tool, and confirm your choice clicking OK button. Then, on the part, 
click all the CAMs you want to apply this tool to.  

2.3 Edit CAMs 
This option allows you to edit the tooling on an already processed entity. 
After you choose this feature from the CAM menu, click the CAM you wish to edit. A 
dialog, presenting its settings, will open: 
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• For punching: 
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• For cutting: 

 
As you can see, not all of the CAM parameters are open for editing – you cannot 
change, respectively, the Punch, the Cutting Types, the Offsets, Cutting Direction 
and a few more settings. 

2.4 Add MicroJoint 
This option is also accessible by clicking the  button from the CAM Toolbar.  
Micro Joints are small bridges of material that are left to make connection between 
different parts on a sheet, in order to prevent them from falling into the machine. 
There are two options for adding a MicroJoint: 
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2.4.1 MicroJoint 

 
This option allows adding MicroJoints at the ends of entities. The parameter entered 
here is in fact an equivalent of the Offsets field of the Add Punch dialog. In other 
words – using this option is in fact editing the punch’s offsets.  
The following example shows an entity to which one's end a MicroJoint had been 
added (with the setting shown above). The Edit CAM dialog shows the resulting 
Offset parameters: 

 
As with the Offsets, entering a negative number will create a Joint, while a 

positive one  will result in an overlap. 
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2.4.2 Wire 

 
This option also lets you add joints, but here you can create a joint in the middle of an 
entity. This is done by splitting entity into two parts with a Joint between them, and 
CAMing them individually.  
The Split Position setting determines the positioning of the Joint: 

• At Hit Boundary – will place the Wire at the nearest Hit Boundary to the 
clicking position. 

• At Snap Point – will position the Wire according to the current Snap setting. 
• At Specific Distance\Angle –   

o For Line entities – will treat this parameter as a distance, and place the 
Wire accordingly. 

o For Arc entities – will treat this parameter as an angle, and place the 
Wire accordingly. 

The following Wire example was created with the setting shown above, that is – 
Width value equals 2, At Snap Point, with . As you can see, the 
entity is being punched with two distinct punches. Using Edit CAM option, you will be 
able to see the resulting Offsets parameters: 

 

2.5 Set Tool Sequence 
This option is very useful when on the part there were placed a few CAMs with the 
same tool, but you don’t want all the CAMs to be made in one sequence (for 
example, if for each of the CAMs you want to apply different Optimization strategies). 
In this case for one group of CAMs with the same tool you can set a certain 
Sequence and for the other group you can set another Sequence. 
When you choose this option, a following dialog will appear: 
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Enter desired tool sequence number and confirm your choice clicking OK button. 
When the dialog will close, click on the project the instance of the tool you want to 
apply this sequence to, or, with the help of Select Option Toolbar, assign it to 
several different tools at a time. 

The default sequence number is "0", and it denotes the main tool. 
From now on these CAMs will be considered as if they were made with different tools 
– you can apply to them different strategies, place them in different positions in the 
general CAMing sequence, etc.  
In the list of used tools, which can be found on the panel on the left side of the 
screen, you will see the tools to which sequence was added, behaving as if they 
were different tools:  
For punch: For laser: 

  
You can also add sequence to the tool in Add Punch dialog, Add Cut dialog and in 
the Used Tools dialog, in the Sequence column.  
Let's presume that a certain part is being CAMed with three tools. The following 
picture shows  an area of Used Tools dialog, containing these tools: 

• For punch: 

 
• For laser: 

 
As a result of optimization considerations, the CAMs have been split up into different 
Sequences. See the below pictures: 

• For punch: 
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As you can see above, the tools with sequence assigned to it have the same station 
as the tools without it, since machine controllers see them as just one tool. 

• For laser: 

 

2.6 Common Cuts 
If you are going to use multiple parts on a large sheet, you will probably wish to save 
time and utilize the sheet as much as possible. This can be done with the usage of 
this option. It allows you to process outer contours of two adjoining parts at a time, 
even when they are processed by special tools. 
After choosing this option, the following dialog will appear: 

 
Choose the desired direction of Common Cuts – they can be either Vertical, 
Horizontal, None or both directions, and confirm your choice clicking OK button. 

For Trumf machines choose Use Bottom for horizontal cuts. 
For punching (turret) machines it is recommended to choose Use Top for horizontal 
cuts, since if the machine has a chute, the processing of a part should finish on the 
bottom of the part. 
For information on laser common cuts go to: Laser Common Cuts section of 
Appendix chapter of current manual. 

2.6.1 Vertical 
Use Common Cuts to process together parts adjoining in the Y direction. Here you 
can see an example of utilizing the Use Left option: 



cncKad 

40 

 

2.6.2 Horizontal 
Use Common Cuts to process together parts adjoining in the X direction. Here you 
can see an example of utilizing the Use Bottom option: 

 

2.6.3 Common Cuts Example 
Naturally, you can choose None for both directions: 

 
Or you can use both directions: 
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2.7 Reposition and Transformation 
After selecting this option, the following dialog box is displayed: 

 

2.7.1 Transformations 
In this section you can not only select the Type of transformation, but also for each of 
them you will be able to enter the values of the Offsets from the sheets' edges in X 
and Y directions. 

 
In this section of the dialog you can Add the following options of Sheet 
Transformations: 

 
After adding a Transformation type, you can also Delete it, however you cannot 
delete the Sheet’s initial state - Transformation None. 
In order to set the offsets in X and Y directions, click th appropriate field and enter 
desired value. 
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For information about using Repositions with Transformations, see the 
Sheet Transformation with Reposition section of Appendices chapter 
in this manual. 

2.7.2 Reposition and Head position 
In this section you can add, edit, delete and assign CAMs to specific Repositions: 

 
The window in this section shows which Repositions are defined for the 
Transformation selected in the Transformations section. 

2.7.2.1 Add 
You can add Repositions by clicking the Add button; you will be presented with the 
following menu: 

                                                         
The options for manual determining the Head position are intended for those 
occasions when prior punches have been placed where the Post Processor might 
have positioned the Head. 

After you have set a user defined Reposition, initiating the Repositions by 
Post-Processor is no longer possible! 

This means that when you wish to add more Repositions to your part, you will only be 
offered the manual options: 

 

2.7.2.2 Edit 
This option enables you to edit pre-defined Repositions. 

2.7.2.3 Set CAMs to Current 
This option enables you to associate specific CAM(s) to a specific Reposition. 
After clicking this button and using the selection options, from the Selection Toolbar, 
you can select the CAMs you want to associate with the particular Reposition. 

2.8  Push Out (Chute) 
This function is designated for machines that have a chute on the table – parts that 
have been cut out of the sheet can be removed from the table via this chute. This 
avoids having to use a Stop Machine command and remove the part manually. The 
position of the chute varies from machine to machine.  
When you choose this option, the following dialog appears: 
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After setting desired parameters, confirm your choice clicking OK button. The dialog 
will close and you will be able to add this attribute to an existing CAM. All you have to 
do is click the punch you want to Push Out through a Chute. It will be marked with 
green color.  
You can also use this option to place a Stop Machine command. 

2.8.1 Chute Type 
From this dropdown list you will be able to select the position of the chute in relation 
to the punching/cutting head on the machine: 

• Stop – choosing this command equals applying the Add or Remove Stop 
Machine option from CAM menu. 

• Push Out on Center – if the machine has a chute in the middle of the table, 
choosing this option will allow you to push out the processed part or the 
remnant (depending on your preferences) through this chute to the bin. 

• Push Out to Left – if your machine has a chute on the left side of the table, 
choosing this option will give machine a command to use it. 

• Push Out to Right – if your machine has a chute on the right side of the 
table, choosing this option will give machine a command to use it. 

• No Movement Push Out – selecting this option cause only the part which is 
above the chute to fall through it to the bin. Other parts won't be moved by 
machine towards the chute. 

• Fixed Push Out – this option is designated for machines that have a fixed 
chute, with no possibility of opening or closing the chute door. 

• Remove Push Out – choosing this option you resign from using an already 
set Push Out function. 

2.8.2 Push Out Modes 
The chute has two modes: Open and Close. They are designated especially for 
Trumpf machines, which have an option of opening the chute at the beginning of the 
process and closing it afterwards. 
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2.8.3 Last Hit On Center 
Choosing this option you decide to place the last hit on center of processed entity. 

2.8.4 Open Chute, then Last Hit 
Marking this checkbox tells the machine to open the chute first and then place the 
last hit on the processed entity. 

2.8.5 Head up 
If you want the turret head to be raised during pushing the part out, select this option. 

2.8.6 Bin Number 
Here you enter the number of the bin/palette to which the pushed out part will fall 
into. 

2.8.7 Auto Tool Order 
Marking this checkbox allows you setting automatic tool order according or opposite 
to the hands of the clock (CW or CCW), by selecting the appropriate option. 

2.8.8 User Defined Movement 
In this section you will be able of defining how the machine should move the part in 
order to push it out through a chute to the bin. 

2.8.8.1 Move 
If you mark this checkbox, you will be able to enter values, in the dX and dY fields, of 
the point to which the machine should move. 

2.8.8.2 Open Chute, then Move 
Checking this option you make machine open the chute first and then move the part. 

2.8.8.3 Reduce Speed for Movement 
When you mark this checkbox the Reduced Speed option becomes available for 
editing. From the Reduced Speed dropdown list you will be able to choose the most 
fitting speed for your movement: Low, Medium or High. 

2.8.9 Push Out Profiles 
This option is useful for machines with a few chutes. You can create and store the 
profile with settings for each chute and load it, when needed, without having to 
assign all the definitions form the beginning every time you make a Push Out. 
After configuring definitions for specific push out type, go to Profile section. In the 
dropdown list field type the name for the profile you want to create and click Save As 
button. If such a name already exists, you will be presented with following warning: 

 
If you want to overwrite (update) the existing profile, click Yes button; otherwise click 
No.  
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Profiles are stored separately for each machine you have. You can’t use one 
machine’s profiles on another one (you have to create a new profile), but you can 
give profiles of different machines the same name. 
When you assign a Push Out to a CAM, this action will be executed after the CAM is 
performed. 

A CAM defined as a Push Out will be colored green. 
For loading an existing profile configuration, from the dropdown menu choose the 
name and click the Load from button.  

2.9 Add or Remove Stop Machine 
This function adds or removes a Stop Machine from a specific CAM. To do this, after 
choosing this option simply click the CAM you want to apply the Stop to. To remove 
the Stop from it, click again on the CAM. 

Using this option is the same as choosing a Stop type of the Push Out.  
A punch with assigned Stop Machine function to it will be colored red. 

2.10 Positioning (No CAM) 
A No CAM means that the machine will go to the coordinates of the chosen CAM, 
but the selected position will not be processed, when the program is run.  
To apply this feature click the CAM you want to change. The processing will 
disappear and an X will be located in its place (the color of the X will depend on the 
nature of the CAM it replaced, e.g. a Push Out CAM colored green will become a 
green mark, a Stop Machine CAM colored red will become a red mark, etc.): 
Before: After: 

  

This command is useful for forcing the machine to traverse a selected path even 
when there are no CAMs in that path, for example when you want to avoid a clamp. 
A No CAM can be converted back into a CAM by clicking the same position again. 

2.11 Cut Sheet 
This feature enables you to cut your sheet to a predefined size. After selecting this 
option, the following dialog will appear: 
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After setting the Tools and Wire Joint click OK button to close the dialog. Click one 
side of the sheet, and then click another one. As you now move the cursor, you will 
see a line under its crosshairs – this is the Cutting Line, and it will be drawn 
perpendicular to both sides chosen. When you click the mouse, the sheet will be cut 
in the defined position: 

• If you have chosen opposing sides of the sheet, the cutting line will be drawn 
up-down or left-right. (see example below). 

• If you have chosen un-opposing sides, e.g. left and top, two intersecting lines 
will be drawn (see example below): 
o The first one, left-right or top-bottom (depending where you clicked first), 

will cut the sheet from side to side. 
o The second one will be placed from the side of your second click to the 

first line. 
Apart from the direction of the cut, advanced programmers can set a value for the 
offset from the sheet’s edge. 

2.11.1 Tools 
Marking the Auto Tool Selection checkbox you can let cncKad select appropriate 
tools for Cut Sheet operation or you can decide about it yourself by clicking on 
horizontal and vertical tool buttons. The tool library will open allowing you to choose 
the tools. 

2.11.2 Offset 
The Cut Sheet Offset can be defined according to your processing needs – by 
entering the value in the Offset field or by entering the value in the machine’s MDL 
file, in the [Sheet Cutting] section, e.g.: 

Cutting Offset = 5.0 // To be used for CutSheet command 
The value can be: 
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• Positive – the CAM (punch or laser cut) will be offset beyond the edge of the 
sheet. In this case a Stop Machine feature will be added after this CAM. 

• Negative – the CAM (punch or laser cut) will be offset into the sheet, leaving 
a MicroJoint. In this case a Stop Machine feature will NOT be added. 

2.11.3 Wire Joint 
This option is available only for punching machines. 

If in this section you will check Perform box you will be allowed to place Micro Joints 
(Wires, actually) as an integral part of the punch. You can set the width of the Micro 
Joints (W) as well as the maximum distance between them (ML), and they will be 
integrated into the punch, without splitting the entity being punched. 
Choosing one of the After First Hit and Before Last Hit options enables creating 
Micro Joints after the first and before the last punch. They address the issue of 
rounded corners when punched by round tools. 
More information on this option you will find in the Wire Joint section of the Add 
Punch dialog of Punch Manual chapter of Punch Manual. 

2.11.4 Cut Sheet Examples 
See below: 

2.11.4.1 Cut Sheet Left Right 

 
In this example the punching is colored red to denote a Stop Machine, as 

the Offset is 5mm over the sheet’s edge. 
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2.11.4.2 Cut Sheet Left Down 

 
In this example the horizontal punching is colored red to denote a Stop 

Machine, as the Offset is 5mm over the sheet’s edge.  
However, Stop Machine option wasn't assigned to vertical punching 
and at this time there is no need doing this. 

2.12 Defining Functions 
Functions are special machine related commands that can be inserted into NC codes 
at specific positions. The codes and the quantity of functions available vary from 
machine to machine. For instance, an older mechanical punching machine will have 
fewer abilities than a newer hydraulic machine. 
These special commands can be associated with specific CAMs, tools or programs: 

 

2.12.1 Punch or Cut Functions 
These options allow for adding functions immediately before or after a CAM: 

 

2.12.1.1 Set CAM Functions 
This option allows you to set function/s for various CAMs. 
After choosing this option, the following dialog will open: 



Punching Manual 

49 

 
Define the Pre- or Post-CAM functions you desire, and click OK button. 
You will be returned to the drafting window, where you can click all the CAMs you 
want these functions to apply to. 

2.12.1.2 Edit CAM Functions 
This option allows you to edit already existing functions for a specific CAM, or set 
new ones if none are defined. 
After clicking this option, you will be moved to the drafting window, where you can 
click the CAM you want to assign the selected functions to. After choosing a CAM, 
the following dialog will open: 

 
Define the Pre- or Post-CAM functions you desire, and click OK button. 

2.12.2 Defining Tool Functions 

This option is accessible also by clicking the  icon from the Common Toolbar and 
loads the Used Tools dialog, allowing you for adding functions to a specific tool. In 
the dialog, from the tools list, select the tool that you wish to add the functions to, and 
click the Tool Functions… button; the following dialog will be displayed:  
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Clicking the dropdown lists displays the functions that can be added to the program 
(they vary for machines). Select the ones you want to add – you can add two 
functions for each of the following options: 

• Before Tool – Before loading the tool. 
• After Tool – After putting the tool back. 
• Before every Punch with this Tool 
• After every Punch with this Tool 
• In Tool Change – When changing one tool for another one. 

After defining the functions confirm your choice clicking OK button. 

If you don't want to assign any function to any of above mentioned fields, 
select from the dropdown list the option NONE. 

The selected functions will be shown in the Used Tools dialog, in given tool’s line: 

 
It is possible to add default functions to a tool so that every time that specific tool is 
used, in any program, it will always come with the defined functions. 

2.12.3 Defining Program Functions 
This command gives the user the option to place special machine commands at the 
beginning or at the end of the program. 
After choosing this option you will be presented with the following dialog: 
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From this dialog you can define functions that will be activated before or after running 
NC program. 

2.13 Set Sheet and Clamps 
This dialog can also be accessed by pressing the Set Sheet and Clamps button – 

 from the Common Toolbar – .  
The parameters you define through this dialog determine how the part you created 
will be processed. 
Click the tab you wish to view: 

• For punching machines: 

 
 

• For laser machines: 

 

2.13.1 Sheet Tab 
This tab varies for punch and laser machines. The parameters in this tab pertain to 
the Sheet you will be placing your part on.  
For punch machines it looks like this: 
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and for laser machines it looks like this: 
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2.13.1.1 Sheet Size 
In the Sheet Size fields you can view and manually define the X and Y sizes of the 
sheet. 

2.13.1.2 Set Sheet = Part 
Clicking the Set Sheet = Part button will cause the Sheet to become the same size 
as the Part. If you use this option, you should pay attention to the clamps' status. 

2.13.1.3 Select Sheet 
By clicking this button the following dialog will appear from which you will be able to 
select standard sized sheet: 
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The sheet sizes presented here are being taken from Material Database, which can 
be accessed from Settings menu => Workspace Settings => Material tab => 
Standard Sizes button. 
In the Quantity column you will see the number of specific sized sheets which are 
stored in Material Database. 

2.13.1.4 Number of Parts 
In the X and Y fields you will see the maximum number of parts (or actually – 
geometries) fitting each direction. These copies of the part are called multiple parts. 
Changing the sheet dimensions will automatically update this data. 
In the X x Y fields, which are not available for editing, you will see the amount of the 
geometries (which sometimes consist of one and sometimes of more parts) fitting the 
currently chosen sheet size. Changing the sheet dimensions will automatically 
update this data.  
In the Total field, also not available for editing, you will see the entire amount of the 
parts (NOT geometries, but all the parts in geometries) fitting the currently chosen 
sheet size. 
Changing the sheet dimensions as well as manually updating the number of Parts in 
Geometry field on Part tab will automatically update data in this field. 
You can set manually the number of parts on the sheet in two ways: 

• Enter the desired number in the X and Y fields. 
• Change the size of the sheet.  

2.13.1.5 Offsets 
The parameters entered in these fields define the distance by which the parts will be 
moved from the edges of the sheet. 

2.13.1.6 Sheet Area and Weight 
This section, not available for editing, presents the area of the sheet (in square 
meters) and its weight (in kilograms). This data is calculated on the basis of the 
sheet size, it's thickness, material type it is made of. The values presented here will 
be automatically updated any time you will change the material, thickness or the 
size of the sheet. 

2.13.1.7 Material Choice 
From the dropdown Material List you can choose or change the material for the 
sheet you are working on. The materials in this inventory are being taken from the 
Sheet Database of Material tab of Workspace Settings. 
For more information on this subject go to the appropriate section of Settings Menu 
chapter of Drafting and Nesting Manual. 
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2.13.1.8 Program Functions 
This option is available just for punch machines. 

Using this option you can add functions for current part that will be included to your 
NC program.  
For a full explanation of this feature go to the Defining Program Functions section of 
this chapter. 

2.13.1.9 Sheet Thickness Choice 
From the dropdown Sheet Thickness list you can choose or change the thickness 
for the sheet you are working on. The thicknesses in this inventory is being taken 
from the Sheet Database of Material tab of Workspace Settings.  
For more information on this subject go to the appropriate section of Settings Menu 
chapter of Drafting and Nesting Manual. 

2.13.1.10 Choosing Sheets Quantity 
In this field you can enter the number of the sheets you want to process with this 
part. 

2.13.1.11 Technology Parameters 
This option is available just for laser machines. 

The definitions of the options seen in Technology Parameters section, like Gas, 
Head and Lens type, are being taken from the Cutting Technology Table described 
in Settings Menu chapter of Drafting and Nesting Manual. 

2.13.1.12 Technology Table 
This option is available just for laser machines. 

The non-editable parameters presented in Technology Table section are taken from 
the Cutting Technology Table described in Settings Menu chapter of Drafting and 
Nesting Manual. Sometimes the thickness here may differ a bit from the one you 
chose in Thickness dropdown list. This means that your machine's Cutting 
Technology Table doesn't contain exactly the same the thickness your sheet has, 
and that's why it shows the value closest to it. 

2.13.1.13 Sheet Type 
Here the user can define a type of the sheet to be used. This parameter is important 
for your machine, that she would know when to increase the height of the head, if 
necessary.  
The types of sheets are: 

• Normal – this type designates regular, plain sheets. 
• Formed – sheets that have been formed beforehand. 
• Irregular – sheets with rough surface. 

2.13.1.14 Run the program 
This option defines how your sheet will be utilized. Some machine operators tend to 
process a half of the sheet, turn it over or rotate it and then continue processing the 
other half.  
Select the most suitable option for your machine: 

• Once per Sheet – the program will be run once, on the entire sheet. 
• Twice with Rotation – the sheet will be split and rotated, therefore the 

program will be run twice. 
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• Twice with Flip – the sheet will be split and flipped, therefore the program 
will be run twice. 

Your choice may be changed at any time during the NC program creation process. 

2.13.1.15 Start Parts Placement 
This section allows the user to determine from which side of the sheet the parts' 
placement will be initiated. You can choose one of two options, as their names 
suggest: From Clamps or Opposite Clamps. 

2.13.2 Auto Tab 
All the options presented in this tab relate to the export of files from cncKad to the 
Automatic Nesting module – Auto Nest. After setting here proper parameters 
cncKad will analyze contours and allow automatic processing to occur.  

 
All the parameters set in this dialog are being defined for the current part you are 
working on. After exporting the part to Auto Nest you will be able to view and edit 
them in Part Information and in Global Info dialogs: 
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2.13.2.1 Buffer 
Buffer is the area around a part that separates it from the other parts placed in the 
nest. There are a few options for setting parameters for buffer: 

2.13.2.1.1 Use Global 
If this option is checked in cncKad, before exporting parts into Auto Nest, the default 
buffering parameter will be taken; else the parameters you defined on the Auto tab 
will be used. 
When importing a part, while being in Auto Nest, you will have the option to set a 
default buffering parameters in the Import Setup dialog.  

2.13.2.1.2 Hole buffer size 
This parameter defines the size of the area around a hole inside the part. 

2.13.2.1.3 Use Rectangular Border 
If you check this option, the buffers will be calculated according to the part’s 
bounding rectangle. Use the Left, Right, Top and Bottom parameters' fields to set 
the desired buffering values for each side of this rectangle. 

2.13.2.1.4 Use Part Border 
When you check this option and define the Buffer Size value, the buffering will follow 
the part's contours.  

2.13.2.2 Mirror Allowed 
Here the user can define whether the part can be mirrored on the sheet during 
automatic nesting or not. When the Global option will be chosen, the mirroring 
settings will be set to default, determined during the importing to Auto Nest. 
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2.13.2.3 Direction 
This option allows user to define the number of directions the part can be rotated in, 
while being nested. When the Global option will be chosen, the mirroring direction 
will be determined during the importing to Auto Nest. 

2.13.2.4 Common Cuts for Grouped Arrays 
In this section the user will be able to determine whether, and how, the part will be 
nested utilizing common cuts option for arrayed group.  
This is done by choosing desired direction of the CAMs and selecting the side of the 
part they will be connected to: 

• Vertical – use Common Cuts to nest parts adjoining in the Y direction; the 
available side options are: Right, Left or None. 

• Horizontal – use Common Cuts to nest parts adjoining in the X direction; the 
available side options are: Top, Bottom or None. 

It is also important to define the Distance between Parts for common cuts. You can 
choose a Default Value, which is being taken from Auto Nest module or by entering 
some other,  Manual Value.  

2.13.3 Global Cut tab 
This tab is available for laser machines only. 

The options in this tab allow you to define Z option and Corner parameters for the 
current part: 
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These definitions will be active for all the entities and corners that are set to 
GLOBAL. 
The full explanation on the options presented here, you will find in proper sections of 
Laser Manual chapter of Laser Manual. For explanation on specification of the 
colors we use to mark cutting speeds with go to View menu => Colored Tool Path 
by Speed section of Drafting and Nesting Manual. 

2.13.4 Cutting Parameters Tab 
This tab is available for laser machines only. 

In this tab you will be able to set the cutting parameters for the current sheet: 
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2.13.4.1 Piercing 
The parameters presented in the Time and Set fields, not available for editing here, 
give an information on the current sheet’s piercing properties. This information is 
taken from the Piercing tab of Cutting Technology Table of the current laser 
machine.  
See the appropriate section of Settings Menu chapter of Drafting and Nesting 
Manual. 

2.13.4.2 Sheet Thickness and Material 
The data presented here for Sheet Thickness and Material type, not available for 
editing from here, is being taken from the Sheet tab. 

2.13.4.3 Vaporization 
This command is useful when the sheet is covered with nylon film: the laser beam 
will pass a first time, with low power, over the parts in order to burn the nylon, before 
it passes a second time for actual cutting. 
From the dropdown list the user can choose how he wants his Vaporization to be 
set: for Whole Cut, for Pierce Only, or None. If you choose None, the Use 
Vaporize for Engrave function will be deactivated. 

2.13.4.4 Dynamic Piercing 
Checking this box activates the Dynamic Piercing option. 

2.13.4.5 Use PrePiercing 
If you check this option, the "Pierce Only" command will be generated a for the 
entire sheet – once the piercing will have been executed, the sheet will be cut without 
piercing. 
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2.13.4.6 Use Standard Shapes 
Activate this option to define Laser Standard Shapes in the NC code as one-line 
codes (if the machine supports this option; otherwise it will be unavailable for editing). 

2.13.4.7 Use Vaporize For Engrave 
The user can choose here whether he wants to use vaporization for engraving.  
This option becomes available only when the Vaporization is set for Whole Cut or 
for Pierce Only.  

2.13.4.8 Cutting Speed 
The parameters presented in this section, not available for editing here, give 
information on the current sheet’s cutting speed properties. This information is being 
taken from the Cutting tab of Cutting Technology Table of the current laser 
machine.  
See the appropriate section of Settings Menu chapter of Drafting and Nesting 
Manual. 

2.13.4.9 Point Marking Style 
In this section the user can select the style and define the size of Point Marking 
Styles, which will indicate the location of the hole(s) you are not interested in cutting. 
These holes will be engraved instead. 

 
Usually this function is being used for marking the undersized holes. By default the 
style of point marking is defined as a spot. For this option there is no possibility of 
setting the point size, but if you will choose one of the other marking signs, you will 
be able to define its dimensions. 

2.13.5 Part Tab 
The attributes of this tab are concerning various aspects of the current part: 
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2.13.5.1 Part section 
This section gives you various information about the part in your draft. Most of these 
options, but some, are unavailable for editing.  

2.13.5.1.1 Part Size View 
In the X and Y fields you can see the dimensions of the current geometry. Any 
number of parts copied and placed on the draft will be always treated by cncKad as 
one geometry, and not as multiple parts. Therefore in these fields you will see the 
size of the whole geometry area, and not an area of a single part (unless your 
geometry contains just one part). 

2.13.5.1.2 Number of Parts 
This field reveals you how many parts does your geometry consist of. If there is more 
than one copy of the part placed in your geometry, here you will see how many. 

2.13.5.1.3 Number of Holes 
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In this field you will be able to see how many holes are in your geometry. If your 
geometry consists of a few copies of a part, the number of holes will be a total 
number of all of them. 

2.13.5.1.4 Entities Section 
In this section you will see the specification of all the Lines, Arcs, Circles and 
Points placed on your geometry. If your geometry consists of a few copies of a part, 
the number of entities will be a total number of all of them. 

2.13.5.1.5 Distance Between Parts 
In the dX and dY fields of this sections you will be able to enter the distance you wish 
to be between the geometries placed on your draft, if your geometry consists of a few 
copies of the part. If a geometry actually equals a part, the value entered here will be 
in fact a distance between the parts. 

2.13.5.1.6 Parts in Geometry 
cncKad has an ability to maximize sheet usage by placing on a draft a number of 
parts that behave as a single part.  

    
cncKad sees the two (or more) contours as a single part, and this way when you 
enlarge the sheet, make multiple-parts and use common cuts the upshot of this 
procedure is, in fact, a very efficient "Nest". 
When you use such a procedure, you must also manually update the Parts in 
Geometry field, otherwise the program will not be able to give you a correct total 
number of parts for your sheet. 

2.13.5.1.7 Part Area 
This field, not available for editing, presents the area of geometry (in square meters). 
This data is calculated on the basis of the geometry size, sheet thickness and the 
material type it is made of. The values presented here will be automatically updated 
any time you will change the material, thickness or the number of parts the 
geometry consists of. 

If the part is an open contour, the program will give an approximation of the 
values, indicating this with the sign ~. 

2.13.5.1.8 Part Weight 
This field, not available for editing, presents the weight of geometry (in kilograms). 
This data is calculated on the basis of the geometry size, sheet thickness and the 
material type it is made of. The values presented here will be automatically updated 
any time you will change the material, thickness or the number of parts the 
geometry consists of. 

If the part is an open contour, the program will give an approximation of the 
values, indicating this with the sign ~. 

2.13.5.1.9 Bend Line K Factor 
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In this field you will be presented with the default Bend Line K Factor. Here you 
have also a chance of changing it for current part you are working on. 
More on K Factor you will find in appropriate section of Drawing Entities chapter, in 
Drafting and Nesting Manual. 

2.13.5.2 Sheet section 
cncKad gives you the ability to place parts in Sheet Mode, as distinct from the parts 
that are placed in Part Mode. 

2.13.5.2.1 Sheet Area  
This field, not available for editing, presents the area of the sheet (in square meters). 
This data is calculated on the basis of the sheet size, it's thickness, material type it is 
made of. The values presented here will be automatically updated any time you will 
change the material, thickness or the size of the sheet. 

2.13.5.2.2 Sheet Weight 
This field, not available for editing, presents the weight of the sheet (in kilograms). 
This data is calculated on the basis of the sheet size, it's thickness, material type it is 
made of. The values presented here will be automatically updated any time you will 
change the material, thickness or the size of the sheet. 

2.13.5.2.3 Entities on Sheet 
In this section you will see the specification of all the Lines, Arcs, Circles and 
Points of which the shapes placed on your sheet consist of. 

2.13.5.2.4 Parts in Geometry on Sheet 
You should fill in this field, in order to allow cncKad for a correct counting of overall 
parts on the sheet. 

2.13.5.2.5 Create unique IDs for entities 
This option is designated for the parametric design. It gives the user control over 
every entity in the draft file (.DFT) by activating the allocation of unique IDs for each 
entity, generating a unique ID for all the existing entities in the drafting and for every 
new entity that will be created from now on in this part.  
These IDs can be used for methods dealing with Entities, Drawing, Punching, Cutting 
and adding Dimensions. 

2.13.6 Clamps Tab 
If your machine has movable clamps, you can define their settings here: 
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If your machine doesn't have movable clamps, you won't be able to edit their 
positions from here. 

2.13.6.1 Clamp Coordinates 
Normally, when you set a new Sheet Size in X, the Clamps are automatically being 
set at recommended values, according to the current machine's options. 
You can change these values manually, either by dragging the clamps with the 
mouse or by entering values in the appropriate fields of the Clamps tab dialog.  
cncKad will NOT allow you to place clamps in positions which cannot be set 
physically on the machine, but you will be able to choose any other legitimate 
position you wish.  
These positions will be changed automatically in the following situations: 

• Working in the Dead Zone  
• Changing the Sheet Size in X  
• Changing the machine  

2.13.6.1.1 Working in the Dead-Zone 
In this case, cncKad will try to generate an NC program based on the current 
positions of the Clamps, and if successful, will NOT change their positions. However, 
if unsuccessful, cncKad will set new positions for the clamps. This means that the 
positions will be changed (if necessary) during the Post Processing stage – the 
change will not appear during the drafting and processing stages. 

2.13.6.1.2 Changing the Sheet Size in X 
After you change the sheet size in X, cncKad will recalculate the recommended 
positions for the new size, and will automatically set the clamps accordingly.  

2.13.6.1.3 Changing the machine 
After you change the machine, the clamps positions will be corrected only if needed 
(e.g. when a clamps positions are off the new machine's table) 
If you want to set the clamps to the recommended positions for the new machine, 
you can change the sheet size in X, and their positions will be recalculated. 
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2.13.6.2 Max Used Clamps 
You can choose the number of clamps you want to use, if your machine allows it. If 
your machine doesn't support clamps, this option will not be accessible for editing. 
If you have a machine with four clamps (such as Trumf 6000L ), you can choose, 
from dropdown menu, one of the below listed options: 

 
If you choose ALL, the maximum number of clamps will be used – in this case 4. If 
you choose NONE, no clamps will be holding your sheet. If you want your sheet to be 
holed by one to three clamps, select the appropriate number from the dropdown list. 

2.13.6.3 Restore defaults 
Clicking this button will return to the primary settings of the clamps for your current 
machine. 

2.13.7 User Data Tab 
On this tab you can include the information about the customer who ordered the part 
to be created, the programmer who designed it, and about the project itself – its 
number, description, as well as other additional information. This data can be saved 
together with the part file. 
Entering it into these fields is not compulsory and can be added at any stage of part 
drafting as well as during NC code creation process. 

 
You can copy the information entered here and later on paste it to different part, as 
well as edit the default titles of these fields. 
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2.13.7.1 Edit Titles 
The default titles, which will appear later on in the Report File, of User Data dialog, 
can be edited and customized according to your needs. To do so, click on the Edit 
Titles button. The following dialog will appear: 

 
The numbered titles here refer to the titles of the fields in the User Data tab and they 
are set to their default (for reminder see the right side of this dialog). You can change 
them just by clicking on the field and inserting the new title (as shown on the picture 
above). It will be then updated in the User Data, and eventually also in the 
corresponding fields of Report File. 
If you wish to restore a title’s default, just leave its field empty. If you want all the titles 
to be restored, click the Restore Default Titles button. 

2.13.8 Sheet Processing Technology Tab 
This tab deals with overall strategies to be used while creating your part.  
More explanation on the reasons for using the Sheet Processing Technology and 
other important issues concerning this topic you will find in the Sheet Processing 
Technology Tab dialog of Machine Settings dialog in Settings Menu chapter. 
The difference between that tab and this one is that the settings defined here 
influence only the current part, and the ones defined there are general defaults which 
will be used only after you reload the current part, create a new one or the next time 
you open cncKad. 
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2.13.8.1 Tools' Processing Strategy 
From this section of the dialog you can set the strategy cncKad will use when 
creating your NC code. Here you can decide how to distribute the CAMs of various 
tools. 

2.13.8.1.1 All Sheet Processing 
First the machine will perform all the CAMs on the sheet with a one tool, and only 
then it will move on to the next tool. 

2.13.8.1.2 Part Processing 
Perform all CAMs on one part with ALL the tools (actually, all the Blue tools), and 
then go to the next part.  
This option is useful when working with thick material or with old machines, where 
there is a high risk of the machine getting "stuck" – in such case, at least some of the 
parts are completed. Mark the "safe" tools as Blue – they will work all over the sheet, 
the Red tools will work Per Part. 

2.13.8.1.3 Stripe Processing 
Perform all CAMs with all the tools (actually, all the Blue tools) on current stripe, and 
then go to next stripe. Use this option for parts with many holes, where the sheet may 
easily get bent. After completing processing a stripe, you can remove it.  

This option will not work on nestings. 
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2.13.8.2 Tools Section 
This section shows the tools used in the processing of your part. If you have selected 
the strategy for All Sheet, this field will be grayed out and thus unavailable for 
editing. If your strategy is either Part or Stripe, you will be able to mark here "safe" 
tool as Blue ones and the tools, which are allowed to work only per selected 
strategy, as Red ones. 

2.13.8.3 Optimization Strategy 
The options presented in this section govern the way your CAMs will be optimized. 
For processing of Parts, Vertical and Horizontal Cuts you can define here the 
Starting Corner and the Optimization Path: 

• Starting Corner – sets the point where the optimization path begins. 
• Optimization Path – sets the optimization type; Snake X, One Way Y, User 

Defined, etc. 
More explanation on this subject you will find in Starting Corner and Optimization 
Path in the Settings Menu chapter of Drafting and Nesting Manual. 

2.13.8.4 Stripe section 
These options provide settings for the Stripe Processing strategy:  

• No. of lines per Stripe – here you need to enter the quantity of parts per 
rows, which will be processed in one stripe, at a time. 

• Remove Stripes – with this option you select whether or not to remove the 
stripe when the machine finishes processing it. If this option is marked, a 
trimming cut is created. 

• Direction of Stripes Removal – when you choose to remove the stripe, you 
can select the direction of the punch (or cut) that will disconnect the stripe 
from the rest of the sheet. 

• Removing Tool – when you choose to remove the stripe, you must choose 
the tool that will be used for the cut removing the stripes.  

2.13.9 Trim Sheet Tab 
After you have finished processing all the parts on your sheet, you will be left with the 
outer remainder of the sheet. The options of this tab let you dispose of this 
remainder. 
After selecting the trimming tool, choose the way you want the sheet to be trimmed. 
For more information on trimming the sheet go to Creating a Trimmed Sheet 
section of Appendices chapter of this manual. 
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2.13.10 Reposition Tab 
This tab gives you an opportunity of defining the reposition parameters that will be 
used during the Post Processing stage, during which the NC code is created for the 
part. Repositions are typically performed by moving the clamps and placing ‘pins’ on 
the sheet to hold it in place when the clamps change their position. 
Here you can see various repositioning options: 
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2.13.10.1 Manual Reposition 
This option is valid only when you have already defined repositions manually, with 
the aid of the Reposition and Transformation function described in current chapter. 
This will give priority to repositions you have already set and will make no changes to 
them. 

2.13.10.2 Auto Reposition 
When selected, cncKad will set the repositions as you specify in the dialog, 
overriding any previous reposition definitions you may have set. 

2.13.10.2.1 Quantity of Repositions 
In this section the you will be able to define the number of repositions you want to be 
made for your sheet. Choose the option that fits you best. 

2.13.10.2.1.1 Minimum repositions 
Choosing this option causes the machine to create as few repositions as possible in 
order to perform the needed CAMs. If necessary, it will split the processing of a part. 

2.13.10.2.1.2 Minimum part breaks  
With the aid of this options the machine tries to set the minimal number of repositions 
needed, so as not to split the processing of any part. This may result in having more 
than the minimal number of repositions possible, but cncKad will make sure that 
each part is processed in a single reposition (unless the part itself is bigger than the 
reach of a single reposition).  
For example, when your parts are placed on a sheet that extends beyond the table, 
and therefore requires repositioning, cncKad will try to process the entire part, make 
the reposition, and then process the next part. In this way there will be less of a 
chance for inaccuracies resulting from repositioning.  
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Another reason for using this function is when your machine has a slow repositioning 
mechanism and you want to make as few repositions as possible.  

2.13.10.2.1.3 User defined  
This option lets the user define the repositions by himself. If he selects illegal 
positions, or the Post Processor cannot reach the whole sheet due to the defined 
repositions, an error message will be issued and abort the NC creation. In any case, 
the repositions set by the user will not get changed.  
When defining repositions, the user chooses the position relative to the sheet’s left 
edge, where the machine’s Working Range will begin. 
For example, for a machine with a Working Range of 1000, processing a sheet 
2000x1000 the following repositions have been defined – 600 and 1000. The 
processing will proceed as follows: The machine will first process the CAMs in the 0-
600 range, then the ones in the 600-1000 range, and lastly the ones in the 1000-
2000 range 
There are a few things to be noted when entering reposition values: 

• No negative values are allowed. 
• Each reposition value must be bigger than the previous one (it doesn't apply 

to the range). 
• Make sure that in the last reposition, the machine reaches the end of the 

sheet. 
• The "zero" position is always the sheet origin, therefore it is unavailable for 

editing. 

2.13.10.2.2 Max/Min Processing 
The options presented in this section allow you to choose the minimal or maximal 
range of the sheet to be processed during each reposition. 

• Max at 1st grip – at each grip (reposition) the machine will try to process as 
much of the sheet as possible. 

• Max at last grip – whenever two grips (repositions) overlap, the machine will 
let the overlapped section to be processed in the next grip. 

When a Forming Tool is used, it is often placed in a turret as the last tool, so that the 
tools following it (especially punching tools like a long RE tool) will not "flatten" the 
form. However, if the sheet you want to process is longer then the working range, 
and Reposition is required, the cutting tool used after the Reposition (in the 2nd 
"grip") can flatten the forms that were created in the 1st "grip". To solve this issue, we 
can define the Min/Max Reposition per tool. 
For example, suppose that we are processing a 2000mm sheet on a 1250mm 
machine. We will set in Set Sheet and Clamps => Reposition tab to have: 

o [x] Max at 1"st Grip 
However, in Used Tools  => Tool Data => Reposition Types we will set for the 
Forming Tool: 

o [x] Max at last Grip 
Now, all the tools will process up to 1250mm, but the Forming Tool will process only 
up to 750mm. 
After the Reposition, all the tools will process between 1250 - 2000, but that will not 
be a problem for the forms – they were made only up to 750. Finally the Forming 
Tool will complete the forms from 750 - 2000. 

2.13.10.2.3 Reposition Safety 
These options deal with the repositioning of the Sheet before and after it has been 
processed: 
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• None – will not add any reposition before or after the sheet processing.  
• Reposition Back – after the sheet have been processed it will be brought 

back to its original position by repositioning the clamps. 
• Start process from right side – the processing of the sheet will start at the 

opposite side of the sheet than the one usually in use (left corner at 0,0 
location). Therefore, the sheet will be repositioned before the processing will 
start and in the end it will have the same position as when it was loaded. This 
option is useful for sheets that contain few micro-joints, for instance, in order 
to avoid loss or damaging of parts.  

2.13.10.3 Tool Reverse Order for Reposition/Transformation 
This function is being used after the reposition/transformation in order to save the 
tool change. Choosing this option we reverse the order of tools set in Used Tools 
dialog of Tools Menu chapter, for processing the parts on transformed or 
repositioned sheet. 

2.13.11 Load/Unload Tab 
This tab presents options intended only for machines with an ability of automatic 
sheet loading or unloading. Their attributes are as follows:  

 

2.13.11.1 Sheet Loading 
This section allows the user to define parameters for loading a sheet. 

2.13.11.1.1 Loading Mode 
The mode of loading the sheet can be manual or automatic, depending on machine 
you have. 

2.13.11.1.2 Pin 
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Pin refers to those machines that have a second pin, for pinning smaller sheets. 

2.13.11.1.3 Load On Opposite Side of Pin 
This option is available for machines who have two pins. Choosing it your sheet will 
be loaded from the opposite side of the pins. 

2.13.11.1.4 Sheet Measuring 
Some machines know how to make measuring of the sheet loaded. If they don’t, the 
default option "No" will be set. 

2.13.11.1.5 Offset 
Here the user can define an offset for the loaded sheet. If you will select Auto option 
the offset will be defined automatically by cncKad. If you will choose the User 
Defined option, you will be able to enter offset value in dX field. 

dX is the distance between the 0.0 point (the endpoint of the table) and the 
endpoint of the sheet. 

2.13.11.2 Sheet Unloading 
In this section you can define the parameters for the sheet unloader. 

2.13.11.2.1 Unloading Mode 
The mode of unloading the sheet can be manual or automatic, depending on 
machine you have. 

2.13.11.2.2 Size of Processed Sheet 
After the sheet has been processed, it is often smaller than it used to be to begin 
with. The automatic unloader has to know this new size, therefore you should enter 
its new dimensions in X and Y fields. 

2.13.11.2.3 Correction for Processed Sheet 
If the sheet’s size has changed during processing, it may appear that the sheet’s 
edge is no longer flush against the table’s edge. In such a case the unloader will 
have to compensate for this difference. 

2.13.12 Laser Optimization tab 
This tab is available for laser machines only.  

This tab is similar to the Laser Optimization tab of the Auto Cut dialog of Laser 
Manual chapter, with one important distinction – the parameters set here are the 
default settings for a part, offered when the Auto Cut dialog is opened for a new cut. 



cncKad 

76 

 
For more information about the parameters in this tab, please go to the appropriate 
section of Laser Manual chapter of Laser Manual. 

2.14 Check Process 
This option examines the part for unprocessed contours. If any such contours are 
found, the following message will be shown: 

 
If you select Yes, the unprocessed contour(s) will be highlighted in blue. If there are 
no unprocessed contours found, you will be presented with the following message, 
instead: 

 
The Check Process feature is run automatically after Auto Punch and Auto Cut, 
allowing you to make sure all the desired contours have been processed. If you want 
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to set this option to be run automatically as a default, select the Check For Not 
Processed Contours option of the Post-Processor Options tab in the Workspace 
Settings dialog. 

2.15 Set Program Origin 
Program Origin refers to position, which is considered to be a "zero position" (0,0), 
or a reference point, from which you start running the program. 
For many machines, this position is fixed, and defined as for example: bottom-left 
corner of the sheet. In some cases, usually in cutting machines such as 
Laser/Plasma/OxyCut, the operator can bring the machine head (cutting head) to any 
position on the sheet, and start the program from there, thus establishing that 
position to be (0,0) or Program Origin.  
Normally, the operator will ALWAYS bring the head to the same position, which is 
one of the sheet corners. In this case, the Set Program Origin dialog will be grayed 
and cannot be used. 

 
If the machine is able support this mode of operation AND you wish to control the 
settings of the Program Origin (for each Part/Sheet), then this dialog can be 
enabled in the MDL file (see Support for Program Origin section in the Appendices 
chapter of current manual). This means that, for example, you want to start some 
programs at bottom-left, others at top-left, and yet another one, at some specific point 
– maybe at the center of a teeth-wheel for which you have prepared some fixture on 
the machine. 
When this dialog is enabled in MDL file, you should enable it also within the dialog 
itself. Only then the other features of this table will be available for editing, and you 
will be able to set the Program Origin position by choosing one the four sheet 
corners, defining it by yourself, entering its values in X and Y fields or by pressing the 
Click on Part button to snap to any position on the Part. 
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The Program Origin is displayed as a bold, red coordinates origin, with arrows 
pointing to positive direction of X and Y, as shown on below presented picture: 

 

2.16 Unload Part 
This feature is intended for machines that have a part removing device. It can be 

accessed from the CAM Menu or by choosing the Edit CAM icon –  from CAM 
Toolbar. When you click the latter one you should click this part's entity you want to 
process as the last one before unloading the part. After you do so the following dialog 
will appear and on its right side, in Unload section, you will be able to choose the 
Unload Part option: 
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Once you have selected it, the dialog will be closed and you will be moved to the 
drafting dialog, where the following Unload Part dialog will appear: 

 
In this dialog, you will be able to determine where to move the unloaded part, 
defining the position of the bin, by entering its coordinates on the X axis (and Y axis, 
if applicable). 
Checking the Auto Tool Order box you allow your machine for automatic arranging 
the part processing order. 
Clicking Select cups… button you will be moved back to drafting dialog and there 
you will see an interface that facilitates the cups selection. The rectangles represent 
the unloader's arms and the circles – the vacuum cups. To move the arms, drag and 
drop the arrows alongside. 
Click on the cups you wish to use. They will be marked with red color to indicate they 
are active.  

On some machines the cups that must be activated together are joined by a 
line. 
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If you want to select all of the cups, press the Alt key while clicking any cup. If you 
want to select just cups on one arm, press the Ctrl key while clicking any cup of this 
arm. If you wish that the machine to mark all the cups that are on parts, click on 
either one of the P boxes next to the arrows. And if you wish to mark each cup 
separately, click it with the right mouse cursor. 

 
To confirm the position, click on either one of the tick (V) boxes next to the arrows. 
The Unload Part dialog will reopen, and there you should press OK button to confirm 
your choice. 
If you wish to discard the position, click on one of the cross (X) boxes. 

 
After adding Part Unload function to your part, it will be presented on your sheet this 
way: 
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The green marked entity is the one, after processing which, the part will be unloaded 
from the sheet. The red arrows show the direction of processing of the part. 
To define the type of cups available, go to Settings Menu => Machine Settings => 
Machine tab => Machine Settings dialog and make changes to the appropriate 
machine file in Metalix Editor.  

2.17 Cutting Table 
This option is a shortcut to the Cutting Technology Table accessed through the 
Settings Menu => Machine Settings => Cutting Parameters => Cutting Table button.  
For more information on this feature, go to appropriate section of Drafting and 
Nesting Manual. 

2.18 Adjust Travel Path 
This option gives you an opportunity to correct machine's travel path. After selecting 
this option you will be able to select new machine path, by clicking the places on the 
part you want the machine to process in the new order.  

2.19 Restore Default Clamps 
Choosing this option will restore the clamps to their default positions. 
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3 Tools Menu 
 
This menu allows you to edit various tool-related setups: 

 

3.1 Edit Tools Library 
With this option you can access and edit the Tools' Library: 

 
Accessing this dialog from few other places of cncKad you will be presented also 
with Setup File tab. 

3.1.1 Tool Library tab 
On this tab you will find large choice of various tools and options of manipulating 
them. 

3.1.1.1 Tool Field 
When from the Tool Library you select a tool for processing your part its definition 
will appear in this field. You can also enter here the tool's definition manually. If the 
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tool you typed in doesn't exist in your tool library you will be asked if you want to add 
it to library. In order for the tool to be used for processing it is not necessary to add 
it to the library. 

3.1.1.2 Add Tool to Library  
The Tool Data dialog can be opened either when adding a new tool, or by clicking 
the Tool Data button at the bottom of the Tools Library dialog. 
If you wish to add a tool (for CTC tools, see the appropriate section of this manual), 
just enter the tool's name in the Tool Field and either press Enter key or click the 
Add tool to library button. 
You will be presented with the following dialog:  

 

3.1.1.2.1 Common tab 
In this tab, user will be able to add detailed features to the new tool, such as: choose 
Allowed angles, enter Tool Number (ToolN) as well as Tool Quantity and write a 
Comment. They all will be later seen in Tool Table of the Tool Library tab. 
From here you can also see the Tonnage of the tool, but you can't enter here nor 
change already existing parameters. The value displayed here is being calculated 
according to the material tonnage, taken from Material List (Settings => Workspace 
Settings => Material tab => Edit Material button), and tool's circumference. 
Note that the new tool is being shown on the display, on the left of the screen: 
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3.1.1.2.2 Allowed station sizes 
In this tab, you can define whether the station size for a tool is selected 
automatically according to the tool size, or manually. In the latter case, select the 
User defined option and check the box next to desired standard station size: 

 
Clicking on the Set Fitting Station Size button will make cncKad choose the most 
fitting station for the tool you are adding to your library. 

3.1.1.2.3 Close to clamp 
When assigned to a tool, the Close to clamp option allows performing punches 
closer to clamps while avoiding clamp/die collision. This option is available for 
machines of which dies are not entirely round, but have one or two straight side(s). It 
is per tool, and it can be defined for the following tools only: RO, RE, SQ, OB and 
MJ. 
When creating/adding a new tool to the Tool Library, define a tool as CTC by 
entering the tool type followed by the abbreviation "CTC” or “CTC2” (if you wish to 
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use a die with two straight sides). Else, you can define the CTC tool through the 
Close to clamp tab. RE 45 50 CTC2 will look like the following: 

 
 
And the punch: 

 

3.1.1.2.4 Type Properties 
For some of the Special Tools you can set an additional information in Tool Data, 
which is Type Properties. They vary according to the type of the tool: 

• For Tapping Tools you will be able to set the Speed and Rotation. 
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• For Forming Tools you will be able to define the values of Bottom Dead 
Center and Top Dead Center. 

 
 

• For Wilson Wheel Tools you will be able to set the Depth of the CAM and the 
Cutting Speed. 

 

3.1.1.3 Create Tool 
After clicking the Create Tool… button you will be presented with a dialog where you 
can define the exact tool you need.  
On the example presented below, you can see how easy it is to create a Triangle 
tool: 

 
All you need to do is enter the desired values to proper fields of base (B) and height 
(H). When you do this, the angle (A) and the triangle's center (C) will be calculated 
automatically by cncKad. 

The center value here is the center of the triangle’s bounding circle. 
If you are using Milling machine, you will be able to see also Drill and Mill tabs. 
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3.1.1.4 Tool Table 
In this chart you will find eleven tabs containing various tool types. Go to Tools 
Definitions section of this chapter, to see what kind of tools you can find on each of 
these tabs.  
In order to choose the tool you desire to use for your part's processing, click on it in 
tool column, or type its name in the tool field, at the top of the window, and then 
confirm your choice clicking OK button. 

3.1.1.4.1 Die Selection 
The user has a possibility to define Dies for tools. In order to do so, click on the row 
with the tool you are interested in, in the Die column. The following dialog will open: 

 
Here you will be able to define the die’s clearance and quantity. You also will be able 

to edit the already existing ones. Click the  button, to add your definitions to the 

list, or the  button to delete the existing ones. Then click OK button to return to 
the Tool Library. There you will be able to view the dies’ list in the appropriate 
section:  
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As you can see, each tool has its own die list.  
cncKad checks what material you are working with, and what is its thickness. Then 
according to these parameters, and after verifying in Material List (see Settings => 
Workspace settings => Material tab => Edit material), what are the Minimal, Best 
and Maximal Clearances for that material cncKad will decide which of the dies will 
be used for current tool. 

 
The results of which die had been chosen for which tool, you see in Die column of 
Used Tools dialog: 
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Die’s clearance will not be below or above the minimum and maximum percent 
clearances of that sheet’s thickness, and it will be as close as possible to the Best 
clearance defined. If the program will not find the proper die for some tool, in a Die 
column a word None, highlighted in blue, will be displayed.  

3.1.1.4.2 Allowed Angles 
In this column you will be able to see the angles in which tool will be allowed to work. 
Clicking on this column next to chosen tool, you will be able to change, choosing one 
of the dropdown list options, the angles for this tool. 

3.1.1.4.3 Tools Quantity 
In this column you will be able to see the quantity of instances of specific tool, which 
exist in your library. Clicking on this column next to specific tool, allows you to 
change this number. 

3.1.1.4.4 Comment column 
The comments you entered on Common tab of Tool Data dialog will be visible here. 
They can be edited by clicking on this column next to desired tool row. 

3.1.1.4.5 ToolN column 
If in the Common tab of Tool Data dialog you assigned a specific number to any of 
your tools, it (Tool Number) will be visible in this column. You can edit and change it 
from here, simply clicking on the chart. 

3.1.1.4.6 Tool ID column 
This option is designated for Trumpf machines.  

cncKad creates automatically the Tools ID for the tools which don't have ones. From 
here you can enter the Tool ID's manually, edit and change them, by simply clicking 
this column next to desired tool row. 
If on the Common tab of Tool Data dialog you entered a Tool ID, it will be seen in 
this column.  

3.1.1.5 Printing the Library 
When you click the Print button the printers settings will appear. Set printing 
definitions according to your wish, and the whole Library will be sent to your printer. 

3.1.1.6 Renaming a Tool 
This button is available only for the special tools tab.  
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Clicking the Rename button you will be presented with the following dialog: 

 
Enter the name you want the selected tool to be called by and click OK button. The 
following warning will appear:  

 
That means – if you have used this special tool on your part, before renaming it, it will 
still contain the old name as long as you will be using it on the current part. When you 
will use it on a new part – it will be called by its new name. 

3.1.1.7 Tool Data 
Clicking this button will bring you to the same dialog, which appears while you are 
adding a new tool to the library. Here you will be able to add or/and edit tool data. 
For more details on this dialog, go to: Add tool to library section of current chapter. 

3.1.1.8 Copying Tools from one Library to another 
Tools can be copied from one tool library to another. In order to do that, select the 
Tool(s) you wish to copy to another Library, by the help of regular Windows selection 
conventions (hold down Shift key while selecting different tools located one next to 
the other, hold down Ctrl key while selecting tools which are far from one another), 
and then click the Copy Tools button. 
A dialog will appear, offering you to copy selected Tools into one of the existing 
Private Libraries. Select the Target Library and confirm your choice, clicking OK 
button. The tools will be copied to the designed Target Library. 

3.1.1.9 Deleting a Tool 
Select the tool you wish to delete, and click the Delete Tool button. The following 
warning will appear: 

 
After confirming the action, the tool will be removed from the library. 

3.1.1.10 Tool Report  
This feature enables you to find all the DFT files on which a specific tool has been 
used for processing. In our example we will look for RO 10 tool. 
After pressing the Tool Report button the following dialog opens: 
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Choose the directory in which you want to search and confirm your choice clicking 
OK button.  
The following Tool Report will display all the instances of the tool found in the 
directory we selected: 

 
If no DFT files with such tools were found, no Tool Report will be displayed. 

3.1.2 Setup file tab 
This tab is visible from CAM Menu => Punch CAM => Add Punch, when you click 
the tool button, intending to choose a tool to process your part with. It is also 
accessible from Tool Selection Button of the State Bar (see the Introduction 
chapter of Drafting and Nesting Manual).  
The tools displayed here are being taken from the Turret Setups database. 
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In the Station Number field you will be shown the number of the station of the tool 
you chose from the table. The Setup File dropdown list allows you for selecting 
desired setup file from available ones for currently used machine. 
More information on other issues presented in this tab you will find in Edit Existing 
Setup section of this chapter.  

3.2 Used Tools... 
This option opens a dialog, which shows all the tools currently used for processing 
your part: 
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3.2.1 Setting Stations for Tools 
There are two ways to set a specific station for a tool: 

• If you know the station number you desire, click the Stations field of a 
specific tool, type-in the number and move on to the next tool. 

• If you wish to choose from the stations’ list, click the tool’s Stations field. You 
will be presented with a dropdown list of the stations and the tools assigned to 
them: 

 
Choose the station you prefer and click elsewhere in the dialog. 

3.2.2 Change Tool 
With this option the user will be able to replace the current tool with another one. 
When you click this button, you will be redirected to Edit Tools Library dialog and 
there you will be able to choose a new tool. 

3.2.3 Tool Data option 
Here you can also add or/and edit Tool Data. But this dialog varies from the one in 
Edit Tools Library window.  
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3.2.3.1 Common 
This tab differs from the Common tab described in Add Tool to Library section of 
this manual. In this tab user can only edit Tool Number and Tool ID and can add his 
Comment. 

3.2.3.2 Optimization Strategy 
In this tab you have the option to determine the optimization strategy for each tool 
individually. You can get to this dialog also by clicking chosen tool's field of Optimize 
Path column. 

 
You can choose one of two options: 

• Global Optimization, in which case the parameters will be those defined for 
the part. 

• Tool–Specific optimization, where you have two parameters with which you 
will be able to determine your strategy: 
o Starting Corner – in this dropdown list there are five options of setting the 

initial processing corner: Auto, Bottom-Left, Bottom-Right, Top-Left 
and Top-Right. Selecting one of them will determine the place of cut 
entrance onto the contour. 

o Optimization Path – in this dropdown list you will find six variations of 
optimization paths: Fastest, Snake Y, Snake X, One Way Y, One Way X 
and User defined. Choosing one of them determines the way the cut will 
be made. 

o Stripe width – in this field you can set the width of the Stripes, that will be 
optimized, before the machine will move to the next stripe. 

o Cooling distance – here you can define the minimum Cooling Distance 
between the future cuts. 

For each choice you make, you will be shown a corresponding icon in the tool’s 
record on the Used Tool dialog: 
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After you finish defining all the tools, you will see the corresponding icon for each 
tool’s strategy: 
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3.2.3.3 Reposition Types 
There are three options of reposition types: 

• Global 
• Max at 1st grip 
• Max at Last grip 

For more information on these options, go to Max/Min Processing section of CAM 
Menu chapter of this manual. 

3.2.4 Delete Tool 
Clicking this button removes selected tool from the current processing. 

3.2.5 Make Optimization 
This option activates the optimization algorithm, which recalculates the processing 
sequence making any changes, e.g. defining tool-specific optimizations. 

3.2.6 Ordering the CAMs 
After placing your CAMs, you can rearrange the order in which the entities will be 
processed. 
Mark one of the tools in the dialog, and then click one of the following buttons: 

• Order by List – to rearrange the processing according to a list of the entities 
processed by the tool. 

• Order by Mouse – to graphically rearrange the processing on the part itself. 

3.2.6.1 Ordering by List 
You will be presented with your part and a list of the entities processed with selected 
tool (the number of entities is shown in the Hits field of Used Tools dialog): 
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As you move the cursor inside the list, each corresponding entity will be highlighted. 
To change the order of the processing, mark an entity’s number and with the arrows 
move it up or down inside the list. When you move to the desired position, click Done 
button to see the change. After you finish setting the order for all the instances of the 
tool, confirm changes clicking OK button. If you want to resign from changes, click 
the Cancel button.  

3.2.6.2 Ordering by Mouse 
After clicking this button you will be presented with your part and with marked and 
numbered entities processed by this tool.  
To determine the ordering, click the entity you wish to be processed first, then the 
second, and so on. After arranging the processing sequence of entities, you will be 
returned to the previous dialog.  

3.2.7 Sorting by Stations 
You can sort the tools, used on the part, by their stations, clicking Stations column 
heading.  
The tools will be organized in a sequence designated to minimize turret rotation – the 
trimming tool will be placed last, then the tool nearest to it, then the tool nearest to 
that one, and so on for the rest of the tools. 

3.2.8 Sorting by Type 
You can also sort the tools by their types, clicking Current Tool column heading. The 
tools will be grouped by round, oblong, rectangular (which includes also square tools) 
shapes etc. Within each group the tools will be arranged by their size. 

3.2.9 Locking Stations 
If you want the tool to be assigned to the station no matter what, you can lock/un-lock 
all the stations with a click on the Lock Station column heading. 

3.2.10 Die Selection in Used Tools 
In the Die section of the Used Tools dialog, the most appropriate die (if such exists) 
out of the dies' list entered in the Tool Library is displayed for each tool. 
The considerations taken into account for the choice of the suitable die depend on 
the sheet’s thickness and on the definitions entered in the Material list for the 
current Sheet type (see Workspace Settings dialog => Material tab => Edit 
material button): the Die’s clearance cannot be below or above the minimum and 
maximum percent clearances of that sheet’s thickness, and it will be as close as 
possible to the Best Clearance defined. 
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However, if you wish to change this decision, or to enter a die for a tool directly into 
the Used Tools dialog, just click on the Die column of selected tool, ignore the 
dropdown list that appears and simply type-in the desired clearance. As you do, the 
Lock Die checkbox (in the nearby column) will be automatically checked, meaning 
that the value just entered will be kept. 

3.2.11 Tool Functions… 
This option allows you to set functions for a specific tool. They will be enumerated in 
the Functions column; when there is not enough room to preview all the functions 
set for a tool, you can see them as a tool-tip when you lower the cursor over the cell: 

 
For more information on this subject, please refer to the Defining Tool Functions 
section of CAM Menu chapter of this Manual. 

3.2.12 Group/Ungroup 
This option allows you to group together a number of tools, making them subject to 
the same optimization strategy. This feature is especially practical in those instances 
where it is important to use a number of tools in the same sequence, for example: 
when you are using two (or more) forming tools, where it is advisable to punch from 
the clamps outwards and not make several passes. In such a case you can group 
these forming tools together, and set an Optimization Strategy of Snake X and 
Starting Corner of Bottom Left, both tools will be optimized together. 

3.2.13 Turret Setups section 
This section of the Used Tools dialog deals with the usage of Turret Setups and NC 
files: 

• Use Current NC – checking or unchecking this option determines if an 
existing NC file will be used instead of creating a new one.  

• NC exists – this check-box in not available for editing. It indicates if there is 
an existing NC file to use for current DFT. 

• Setup Window – this dropdown menu allows you to choose which setup file, 
from existing ones, to use. 

• Create Setup From Used Tools – clicking this button allows user to save 
current list of used tools as a new tools setup. 

3.3 Create a Special Tool File 
When you choose this option you are in fact attempting to define a new tool. 
Before doing this you need to follow a few steps: 

1. View the Tool Definitions. 
2. Follow the directions outlined in Creating User Defined Tools. 
3. Make sure to view the rules for naming tool files. 

3.3.1 Tool Definitions 
There are several types of tools, each defined by the shape of the tool and the 
parameters that define it. 
The following describes the parameters for defining the various tools: 

• RO – Circular tools  
• RE – Rectangular tools  
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• RR – Rounded Rectangle  
• SQ – Square tools  
• OB – Oval or Oblong tools  
• TR – Triangular tools 
• SD – D shaped tools (Single D)  
• DD – Double-D shaped tools  
• CR – Corner Radius tools 
• MJ – Micro Joint tools 
• F – Special tools, user defined 

3.3.1.1 Circular Tool 
Definition: RO 20 
Where 20 is the circle diameter. 

 

3.3.1.2 Rectangular Tool 
Definition: RE 40 15 30 
Where 40 is the length, 15 the width and 30° the declination of the Rectangle (if you 
do not define an angle, it will be set as 0°). 

 

3.3.1.3 Rounded Rectangle 
Definition: RR 40 15 2 45 
Where 40 is the length, 15 the width, 2 the radius of the corners and 45° the 
declination of the Rectangle (if you do not define an angle, it will be set as 0°). 
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3.3.1.4 Square Tool 
Definition: SQ 40 15  
Where 40 is the side and 15° the declination of the Square (if you do not define an 
angle, it will be set as 0°). 

 
Usually, the angle is left at 0°, or defined as 45°. 

3.3.1.5 Oval Tool 
Ovals are rectangles, with half-circles as two of the sides. 
Definition: OB 40 15  
Where 40 is the length of the oval 15 is the width (the diameter of the arcs). 

 
You can also give this tool a declination, e.g. OB 40 15 45. 

3.3.1.6 Triangular Tool 
Definition: TR 30 50 13 
Where 30 is the basis, 50 is height and 13 is the center of the triangle’s bounding 
circle. 
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3.3.1.7 D Shaped Tool 
D shapes are cut circles, and the D-shape will be located on the part by its straight 
side, not the circular one! 
Definition: SD 40 35 
Where 40 is the diameter and 35 is the width, measured from the straight side to the 
opposite rim of the circle. 

 
You can also give this tool a declination, e.g. SD 40 35 45. 

3.3.1.8 Double D Shaped Tool 
Double-D shapes are circles cut on opposite sides, and the shape will be located on 
the part by its straight side, not the circular one! 
Definition: DD 40 35 
Where 40 is the diameter and 35 is the width, measured from one straight side to the 
opposite one. 

 
You can also give this tool a declination, e.g. DD 40 35 45. 

3.3.1.9 Corner Radius Tool 
The main use for these tools is to punch Fillet outlines.  
Definition:  CR 3.5 20 20 6 6 
Where 3.5 is the fillet diameter, 20 horizontal length, 20 vertical length, 6 horizontal 
cutting width and 6 vertical cutting width. 
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3.3.1.10 Special Tools  
While adding a new special tool to the library it is important to pay attention to 
naming them. It is substantial, since various machines "understand" only the precise 
naming and if the tools won't be given proper names, the machine will not be able to 
find them in the library. 
The standard tool library supplied with cncKad contains a variety of special tools like: 

• Beading Tools 
• Embossing Tools 
• Slitting Tools 
• Forming Tools  
• Tapping Tools  
• Wilson Wheel Tools and others.  

For more information on the special tools see the Names for Special Tool Files 
section of this chapter. 

3.3.2 Creating User Defined Tools 
Here you will learn how to define a special tool whose parameters do not fit the 
ones available in the Tool Library. In this example we will be creating a new radius 
tool. All you have to do is to follow procedure described below.  
This procedure will be divided into three stages: 

1. Creating the outline of the tool 
2. Adding the new tool to the Tool Library  
3. The Tool Reference Line 

And at the end we will Test the New Special Tool we just created. 

3.3.2.1 Creating the outline of the tool  
The first stage of creating a new tool is to draw its outline of the tool as a regular DFT 
part.: 
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1. Open a new part. Give it the name of the intended tool, e.g. "radius10.dft", 
and save it in the ..\Metalix\P\TOOL-DFT folder:  

 
Important: The name must not contain spaces. 

2. The size you define here is not really important, so you can enter any values 
here. For this example we will set X=20, Y=20: 

 
3. Now from Shapes Toolbar we will choose the Draw Rectangle option. The 

following dialog will open: 
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Type the values as presented in the dialog, and click OK button. 

4. The center of highlighted, with blue color, rectangle will appear on the cursor 
crosshairs. Click the cursor at the beginning of the origin coordinates (0,0). 
The centre of rectangle will be placed in (0,0). 

 
5. If the following dialog will appear asking you whether you want to punch the 

shape with fitting tool, choose NO for an answer. 

 
6. Press Esc key, to leave the Draw Rectangle command. 

7. Now delete the bigger contour, click the  button, and then refresh the 

drawing, clicking the  button. This is the picture you should see on your 
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screen now: 

  
8. Now from the Shapes Toolbar select Draw Circle button. Type the diameter 

value as 5 and click OK button. 
9. Now with the circle's middle point click the right bottom corner of the 

rectangle. And then press Esc key, to leave the Draw Rectangle command. 

10. Refresh the drawing, clicking the  button. Now from Edit Toolbar select 
the Trim button. The drawing will be highlighted in blue color. 

11. Click the lines, as marked on the picture below: 

 
Now press Esc key to escape the command, and Save your drawing. 

3.3.2.2 Adding the new tool to the Tool Library 
Now we will add the new tool to the Tool Library: 

1. From the Tools Menu choose Create Special Tool File:  

 
2. The following dialog will open: 
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Note that the name of the new tool is the same as the one you defined for 

the DFT part, and that it will be saved in the ..\Machines folder. 
3. Don't forget to Save the new tool. 

3.3.2.3 The Tool Reference Line 
Now you must choose the entity of the tool – the Tool Reference Line, according to 
which the punch with this new tool will be placed on the part. 

1. Click on the radius and it will be marked in red, and the rest of the tool will be 
marked in blue.  

 
Important: If the tool includes more than one contour (such as a Cluster 

Tool), click all of them.  
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2. Press Enter key to confirm the chosen contour(s), and the following dialog 
will appear:  

 
3. Click Add to tool library button, and the tool will be added to the Tool 

Library. 
4. Check that you have indeed added a new tool to the library: Click the No Tool 

button on the State Bar, and the Tool Library will open. Go to the F tab and 
scroll down to the new tool: 

 
Whenever you choose a special tool to process with, its representation will appear on 
the Tool Display, with the Tool Reference Line highlighted in red: 
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There also is an option of changing the Tool Reference Line location: toggle on the 
Index button on the Info bar and then press the S key: the red line on the tool 
indicating the Tool Reference Line will move to the next side of the tool. Press the S 
key until you are satisfied with the cutting line’s location on the tool and then proceed 
with the punch. If needed, the tool will be indexed. 
Notice that you can also select two parallel lines on the tool as Reference lines: the 
program will then choose which one is best, with major concern of avoiding using the 
Auto Index function. 

3.3.2.4 Testing the New Special Tool 
1. Open the part you want to process.  

This will be our notch, which we want to process with the new special tool: 

 
2. From the Common Toolbar click the Add Punch button. In the dialog which 

will open, click the Tool button. In the Tool Selecting dialog, which will 
appear, go to the Special Tools tab (F) and choose the tool you have just 
added to the library: 

 
Click OK button to confirm your selection.  

3. Turn the Index Button On, and press the S key to toggle the Tool Reference 
Line, highlighted in red (on the gray background this line will be highlighted in 
blue). When you will are satisfied with the cutting line’s location on the tool, 
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proceed with the punch: 

 
 
4. Now, in the same way, place the second punch:  

 
 
5. The processing results of our notch will look this way: 

 

3.3.3 Names for Special Tool Files 
Different tool files have different names and there are several categories of tools. 
Therefore it is important to give special tools proper names, since various machines 
"understand" only the precise naming.  
Below you will see find more information on Forming Tools, Tapping Tools and 
Wilson Wheel Tools. 

3.3.3.1 Forming Tools 
Use the format FTL<dd>, where each "d" is a digit. 
For example – FTL27.T 
After the number, you can include some relevant info, e.g. a forming tool that is used 
before an M4 Tapping tool will be named this way: 

FTL54-PreM4.T 

3.3.3.2 Tapping Tools 
The names for these tools are pre-defined; there are two types of Tapping tools: 

• MM Tapping tools  
• Inch Tapping tools  

3.3.3.2.1 MM Tapping Tools 
The following tools are available for mm tapping: 

• TAP52-M25 
• TAP53-M3 
• TAP54-M4 
• TAP55-M5 
• TAP56-M6 
• TAP58-M8 

3.3.3.2.2 Inch Tapping Tools 
The following tools are available for inches tapping:  
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• TAP256 
• TAP348 
• TAP440 
• TAP540 
• TAP632 
• TAP832 
• TAP1032 

3.3.3.3 Wilson Wheel Tools 
In cncKad the following Wilson Wheel tools are available: 

• WW01.T - Wilson Rolling Shear 
• WW02.T - Wilson Rolling Rib 
• WW03.T - Wilson Rolling Offset 
• WW04.T - Wilson Rolling Louver 
• WW05.T - Wilson Rolling Pincher 

For use with Fanuc controls they are named this way: 
• WW01 
• WW02 
• WW03 and so on. 

For use with Siemens and Nisshnibo, they look this way: 
• WW11 
• WW12 
• WW13 and so on. 

Below you can see an example of Rounded Rectangle (200mm x 100mm, R=50mm)  
processed with WW12: 
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3.4 Turret Setups 
After you click this option, the following dialog will be displayed: 

 

3.4.1 Machine section 
Options of this section allow you to choose, from the list of installed machines, a 
Machine for which you would like to create new Turret Setups or edit already existing 
ones.  

3.4.2 Setup File section 
Here the user can determine settings for his turret's setup file, a file that describes 
how tools are arranged in the machine’s turret. 

3.4.2.1 Select Setup File 
From this dropdown list you can choose one of the existing setup files. 

3.4.2.2 Creating a New Setup 
Click on the Add/Create New button.  
You will be asked to provide a name for the new turret setup file. The file name can 
be any name you choose; no extension is needed, since one will be set by default, as 
the machine ID character followed by ET. For instance if you machine ID character 
is V, then the extension for the setup file will be ".VET". The user can create as many 
Turret Setup files as needed. 
After doing so, choose the new setup from the dropdown list and click Edit Setup 
button. A dialog will open, giving you possibilities of defining various parameters for 
your turret. 

3.4.2.3 The LASTSET File 
This setup differs from others, so it is important to explain it more thoroughly. 
What distinguishes this file from other turret setups is that it always is a 
representation of the exact tool arrangement in the machine and reflects the turret 
setup of the last NC (there is one exception to this rule, as we will later see). 

The LASTSET file is an alternative to the "whiteboard" often found next to 
machines, which machine operators use to update the current tools in 
the turret. 

Since it shows which tools are currently available in the machine, the LASTSET 
feature is useful in two important ways: 
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• it automatically calculates which changes the machine operators must make 
in the tooling in order to produce the next part. 

• it helps the engineers in tool selection when processing parts – different tools 
may often be used for the same job, and intelligent selection helps minimize 
tool changes (i.e. time). 

3.4.2.3.1 Creating the LASTSET file 

 
To create the file, select the LASTSET option from the Select Setup file dropdown list 
(shown above) and click the Edit Setup button. This will open the file and you will be 
able to edit it now: 

 
The initial values will be displayed according to the turret file selected for the 
machine. 

3.4.2.3.2 Using the LASTSET file 
In order to see how using the LASTSET file helps machine operators with their work, 
we will use the following example: 
We have created a LASTSET file according to our turret tooling, and now we will 
process a part that requires using a RO 5 tool that currently is NOT in the turret. 
To use the LASTSET option, you must first enable it on the Working Defaults tab of 
the Workspace Settings dialog: 

 
Important:  

Only workstations that are on the actual production floor and are used 
for sending NC to the machine may use this option! 

If you wish to generate NC simply to view the Graphic Simulation, do not enable this 
option (concerns workstations e.g. in engineering or design departments). 
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After enabling the above mentioned option, we can start the Post Processing 
procedure. In one of its steps, we come to the Used Tools dialog; here we must 
select LASTSET as the Turret Setup: 

 
This will ensure that if you processed your part with a tool that is already in your 
machine (and therefore assigned to a station in LASTSET), the correct station will be 
chosen for this tool in the NC, and thus this will minimize changes to the turret’s 
tooling.  
Next step is the Post Processor Options dialog; here we must enable the following 
option: 

 
This will cause cncKad to examine the part you want to Post Process, and check if 
NC code can be generated using the selected turret setup (i.e. the LASTSET file). 
If this is impossible (in this case because there is a tool missing from the setup), 
cncKad will update LASTSET to include the new tool arrangement needed to 
generate the NC, and then it will issue a warning: 

 
Important:  

This is not an idle warning – it means that the machine operator must 
change the tool arrangement in the turret, so that it corresponds to the 
new setup created. 
This is the only time that LASTSET does not match the turret, and thus 
must be corrected as soon as possible! 

To help in making the necessary adjustment, cncKad will include instructions inside 
the NC file – the word NEW will be added for stations that require it (with changed or 
added tool): 

 
In this case, we must put an RO 5 tool into station number 226. 
In addition, an asterisk (*) sign will be inserted into the Report File next to any 
station that needs correction: 
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Only after we make the specified change, and LASTSET is once again a true 
representation of the turret, we can produce the part we designed. 

3.4.2.4 Save Setup As 
Choosing this option gives you an opportunity of saving current setup file under a 
new name. 

3.4.2.5 Editing an Existing Setup 
To edit an existing Setup File, use the dropdown menu to find the one you want to 
use, and click Edit Setup button. The following dialog will open: 

   
• The Station column reflects the number of the turret station. 
• The Fixed column allows you to choose the station which all the time would 

be assigned and locked for a specific tool. 
• To place a specific tool in a station, click the Setup Tool column field for this 

station; the Tool Selecting dialog will open and you will be able to choose the 
desired tool. 

Important: You must set the tools in such way, so that the file will describe 
the exact arrangement of tools sitting currently in your machine’s turret.  

• After you have assigned a tool to a station, you can ascribe Functions to it – 
click the Functions field, and you will be presented with the Tool Functions 
selection dialog. 



Punching Manual 

115 

• In Clearance column you will see if any clearance was ascribed for current 
tool. 

• The Type field displays information on the type of the station. E.g. looking at 
this field you can see whether the station is specified for round tools only 
and if it is an Auto Index station or a normal one. 

• The Size and Size Type columns give information about the size of the 
station accordingly – the tool size for this station (how big tools can fit in) and 
the Standard annotation for the corresponding tool size (denotes the station 
type by a letter).  

• Multi-tool column displays the number of a Multi-Tool station, if you have 
such. 

• Notice that the data in this dialog can be sorted per column: just click on one 
of the columns’ headings and the entire file will be sorted in the ascending or 
descending order according to that column. 

• After you have finished defining the tools, do not forget to click Save button to 
preserve your selections and Print it, if you want. 

• There are few more options in this dialog – the user can Insert or Delete 
row(s), Remove Tool,  Restore Default Order of the tools, or Cancel the 
changes he made. 

• Clicking the Switch To Setup Layout button you will be moved to the Turret 
Display dialog.  

It is important to note that each machine has its own turret setups, so that if you have 
created a new setup for machine P, machine V will not have access to it. 

3.4.2.6 Editing the ToolFunc File 
You can edit the ToolFunc.?ET (where ? stands for the machine’s ID character), by 
clicking the Add/Edit ToolFunc button. The following dialog will open: 
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This table consists of the following fields: 

• The Station column should be permanently set to -1. This means that the tool 
can be placed in any station of the machine turret. 

• The Fixed column allows you to choose the station which all the time would 
be assigned and locked for a specific tool. 

• The Setup tool column displays the tool name, e.g.: F LUVER.T. You can fill 
this field in by clicking it. The Tool Selecting dialog will appear and you will 
be able to choose the desired tool: 
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• In the Functions column you can choose the desired function the same way 

as you selected the tool. On the beneath picture you will find an example of 
functions assigned to tool RE 20 10. 

 
After you have finished defining the settings, click Save button to preserve your 
selections. From now on, whenever the defined tool is used, the chosen functions will 
be added to NC program. 

3.4.2.7 Removing an Existing Setup 
The user can delete selected setup file by clicking the Remove Setup button. A 
following warning message will pop-up, asking you if you are sure of your decision: 
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Confirm your action clicking OK button and the currently chosen setup will be 
removed. 

3.4.2.8 Turret Display 
Pressing this button will open the following dialog showing the turret with tools 
assigned to stations; by each of the station its number will be displayed: 

 
On the panel situated on the right side of this dialog you will find options with which 
you can manipulate the turret's stations. 

3.4.2.8.1 Station number field 
When you click any station instance with the cursor, it will be marked with red color 
and its number will appear here. 

3.4.2.8.2 Tool Preview 
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In this window you will be able to preview the tool selected on the Tools' List. 

3.4.2.8.3 Tools' List  
Here you will see a list of tools assigned to selected station. 

3.4.2.8.4 Functions' List 
Here you can see a list of functions assigned to the currently marked tool in the 
Tool's List.  

3.4.2.8.5 Adding Tool 
Clicking the Add Tool button you will be redirected to tools' library dialog, where 
you will be able to choose the tool you wish to add to certain station. 

3.4.2.8.6 Removing Tool  
Clicking the Remove Tool button causes the tool to disappear from selected station. 

3.4.2.8.7 Changing Tool 
Clicking the Change Tool button redirects you to tools' library dialog, where you 
can select different tool for the current station. 

3.4.2.8.8 Tool Functions 
Choosing this button opens the Tool Functions dialog, from which you will be able 
to assign new functions for tool or edit the existing ones.  
More on this option you will find in Defining Tool Functions section of CAM Menu 
chapter of this Manual. 

3.4.2.8.9 Fix Station 
Marking this checkbox, you decide that the tool ascribed to the currently selected 
station will be used only with it. 

3.4.2.8.10 Switch To Setup List 
Clicking this button you will be transferred to the Setup File dialog. 

3.4.2.8.11 Radial View 
Checking this box you change the turret display. Now all the tools will be viewed as 
placed in the stations along the turret tracks.  
Normal View Radial View 

  

3.4.3 Multi-Tools section 
This section is available for machines which have Master turrets with Multi-Tools 
option, e.g. Finnpower, LVD, Strippit, Rainer and Muratec machines.  
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You should chose Master Turret for your machine in Settings => Machine Settings 
=> Machine tab => Machine Settings dialog: 

 
Your choice done there will be available in Multi-Tools section, where you will be 
able to select and manipulate it, with the usage of following buttons: 

• Add/Create a New Turret 
• Edit Turret 
• Remove Turret 

3.4.3.1 Add/Create a New Turret 
When you click this button a Save As window will appear. Type the new name for the 
multi-tool turret settings. It is recommended to type in the new name with "U_" in 
order not to override an existing turret and also to differentiate it from regular turrets. 
For example: U_CosFinn.  
After doing so, click Open button. You will be returned back to the Turret Setups 
dialog, and the new multi-tool turret will be shown in the dropdown list as a default: 

 
In order to enter the desired changes, click the Edit Turret button.  

3.4.3.2 Edit Turret 
After clicking the Edit Turret button, you will be presented with the following dialog, 
allowing you to personalize the mutli-tool turret: 
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The active station, we are defining settings for, is marked with red color. 
The legend on the left side of the dialog specifies the colors of the stations according 
to their sizes, as well as denotes the Irregular, Multi-Tool and Round Only stations. 
On the right side of the window you can see various settings options for the selected 
station: 

3.4.3.2.1 Station Number  
This field displays the number of the presently chosen station. The multi-tool stations' 
numbering varies for machines.  
More information on the Multi-tool Numbering you will find in Changing Turret 
Numbering section of Appendix chapter of this manual. 

3.4.3.2.2 Track  
Here you can view and change the track for the current station. It is by default set on 
2. 

3.4.3.2.3 Station Size 
From the dropdown list you can choose the best definition of your station size. 

3.4.3.2.4 Station Angle 
In this field you can see, as well as edit, the station's angle in turret – from 0° to 360°. 

3.4.3.2.5 Auto Index 
Checking this box we denote the station as rotating one. Choosing it makes the 90 
Degrees Only option available. 

3.4.3.2.6 90 Degrees Only 
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This option is valid only for Auto Index station and allows rotating the index station 
only at 90 degrees. 

3.4.3.2.7 Round Only  
Marking this checkbox the user denotes the station available only for round tools. 

3.4.3.2.8 Multi-Tool  
Notice (on the picture shown in Edit Turret section) that in Master Turrets there are 
no Multi-Tools as a default; therefore they should be added. Check the Multi-Tool 
box and from the dropdown list detailing Multi-Tools available for this turret select the 
desired one. 
In most turrets not all of the stations can be changed into Multi-Tool stations. It is 
possible though to add Multi-Tools to more than one station. To see what options can 
be edited for some station, just click on it and see on the right section of the dialog 
what options are available. 
After choosing the desired Multi-Tool, as you can see on the picture presented 
below, it is not possible now to change the track and the size of Multi-Tool stations. 
Only Auto Index option can be chosen and if you choose it the Round Only option 
will be also activated. 

If you would like to change other station properties, like track, size or angle please do 
so before adding the Multi-Tool to it. 

3.4.3.3 Remove Turret 
Clicking this button deletes currently selected turret. 
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3.5 Convert Old Boschert Tools 
This option is available for Boschert machines only. 

 
Before, in older versions of cncKad, the tools didn't have ToolN and their number 
was being taken from the station. So if you were using the old tools and recently 
have updated your cncKad to the new version, this converter is for you. 
For more information on converting old Boschert Tools and adjusting them for work 
with cncKad, go to Release Notes for BOSCHERT users section of Appendix 
chapter of this manual. 
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4 NC Program Creation 
 
There are several stages and options you must go through, leading up to the post-
processing stage, where the NC program is being created out of a part. 

4.1 Creating the Program 
Once you have finished assigning punches to your part and all the settings have 
been defined, you are ready to start the final phase of program development. In this 
stage cncKad will read the graphics, which you have processed, and convert it into a 
program in a language that your machine controller can recognize, and which can be 
simulated or/and sent to a machine.  
Post Processing is a multi-part procedure. This chapter takes you through it step by 
step. 

4.2 NC Generation Stage 1 
From the File Menu, select the Post-Process option or on the Common Toolbar click 

the Post Processing button – .  
If you hold down the CTRL key, as you click the NC button, the postprocessor will 
skip stages 2-4, and jump straight to Stage 5. Otherwise, the following dialog will be 
displayed: 

 
The User Data that you fill in will be used in the Report File. Entering this data here 
is not compulsory, unless you wish to produce a report file.  
You can use the Copy and Paste buttons to transfer the user’s details between 
parts. There is also a possibility to Edit Titles.  
After you are done with filling in the details click the Next button. 
For more information on the features of this dialog refer to appropriate section of 
CAM Menu chapter. 

4.3 NC Generation Stage 2 
In this stage, you can see for which machine the program is being created.  
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If you have more than one machine installed on your workstation, this enables you 
make sure you have selected the correct one. If everything is all right, click the Next 
button. 

4.4 NC Generation Stage 3 
In this stage the Used Tools dialog is being displayed, allowing you to set the order 
of the tools as well as defining other settings for them.  
It is advisable to make all major changes to the cutting at this stage. 

 
To go to the succeeding stage, click the Next button. 

4.5 NC Generation Stage 4 
This is the final dialog before the generation of the code. Here, you can set various 
options pertaining to the code generation: 
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4.5.1 Use Macros (Sub-Routines)  
This option is available only for machines which support it.  
It's very useful when using multiple parts on a single sheet, because it allows the 
user to shorten the program by using macros (or in other terminology – Sub-
Routines). Selecting this checkbox will enable them. 
If you want to set the Macros as a default for your machine, go to Post-Processor 
Options tab of the Workspace Settings menu in the Settings chapter of Drafting and 
Nesting Manual. 

4.5.2 Automatic Testing of Common Cuts 
If Common Cuts option is chosen, this function will check for duplicates – it will 
make sure that between two adjoining parts no double CAMs have been placed. 

4.5.3 Use Controller Compensation 
This option is available only for laser and combined (punch-laser or punch-

plazma) machines.  
It is useful in case you want to get CRS (Cut Radius Compensation) in NC command. 

4.5.4 Report File Creation Options 
From this dropdown list the user can define the default setting for creating a Report 
File. The options are as follows: 

• Do Not Create Report File 
• Create Report File 
• Print Report File 
• Create and Print Report File 

More information on creating Report File and the types of Report Templates you 
can find in Appendix chapter of this manual. 

4.5.5 Update LASTSET 
This option is available only when the Enable update of LASTSET 

checkbox is selected in Working Defaults tab of Workspace Settings 
dialog.  

If you check this option, the current Turret Setup will be saved as a Setup File called 
LASTSET.?et (where ? stands for the machine’s ID character). If you are working 
with such a file right now, and you made a few changes you would like to keep for 
processing other parts, checking this option will update it.  
You can use this setup for the next part you create, being certain that in both cases 
parts use exactly the same setup. 

4.5.6 Run Simulation After Post Processor   
After the Post Processing stage the graphic creation will remain open, and the 
simulation of created program will be loaded in a separate module, where the user 
will be able to test the program and make sure it runs with no problems. 
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4.5.7 Automatic Detection 
This function is available for punching machines only. 

Here you can choose one of the few options for automatic parts' processing: 
• Do not detect groups of single punches 
• Automatically detect lines of single punches 
• Automatically detect grids 

More information on these features you will find in Automatic Detection section of 
Settings chapter of Drafting and Nesting Manual. 
The only difference between the parameters set on there and here is that the settings 
selected here concern only the currently created NC Program. 

4.5.8 Program Number  
Some machine controllers demand, that there be a program number, others do not. 
That's why here the user can define a default program number. 

4.5.9 Sheets Quantity 
The user can set here the number of sheets he wants to process this time.  
If the checkbox Update Sheet Quantities in DB will be selected, the Number of 
Sheets entered here will be deducted from the quantity of sheets entered in Select 
Sheet dialog which is accessed from Sheet tab of the Set Sheets and Clamps 
window. 

4.5.10 Sheet Loading 
In this section of the dialog, the setting definitions are being loaded from 
Load/Unload tab of the Set Sheets and Clamps window. 
This is the last moment and your last chance for entering changes for sheet loading, 
before the NC code will be generated.  
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4.5.11 Name and Path of NC file  
From this dialog the user can set the name and path for the NC file. The NC file can 
be given a different name than the drawing file and placed in a different directory. To 
select a directory, click the Browse… button. 
When you have defined all the settings, click the Finish button. 

4.6 NC Generation Stage 5 
The following dialog will be opened: 

 
This is the code generation stage, during which you might be asked different 
questions concerning your machine. Clicking Enter button usually attains the default 
values.  
If the Post-Processor could not create the program or there are problems with the 
clamps or the tools, you will also be notified about them by an appropriate message. 
If you placed CAMs within the clamps dead zone and the Clamp Avoidance option is 
activated, you will be able to decide whether to attempt avoiding clamps or to 
continue without any automatic clamps avoidance. 
If you requested to print the report file, you will have to prepare the printer and, when 
requested, press a key to print it. 
When the Post Processing stage is over, click the OK button to open the simulation 
module. 



Punching Manual 

129 

5 NC Code Simulation and Editing 
 
This chapter deals with cncKad’s simulation program.  
The Simulation program is a completely individual module of cncKad and is run 
separately from the main program – the simulation is loaded into a separate window 
allowing cncKad to remain open in the original window. 
The following pages explain the options that can be used here, and how to run the 
simulation. 

5.1 Opening the Simulation 
There are three possibilities of opening SimW: 

• After Post Processing 
• When Simulation is selected from the File Menu within cncKad. 
• From the Start => Programs => Metalix =>Simulation menu  

In any case, the following window is loaded: 

 
The graphic results of the code are displayed on the left side of the screen.  
Any change in the code displayed on the right side of the screen will be updated on 
its graphic representation. 

5.2 Running the Simulation 
Once an NC code and graphics are visible on the screen, that code can be 
simulated. 
If there was no file loaded when you entered the simulation module, from File Menu 
you can Open the file you want to simulate. 
The progress of the Simulation is controlled in two ways: 
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• From the Execute menu: 

   
• From the Execute toolbar:  

. 

5.2.1 Starting the Simulation 

Click the  button to begin the Simulation, or to resume it after it has been paused. 
If you want to run the program line by line, click the Line = ON button on the left side 
of the screen and then click the Run button repeatedly. 

5.2.2 Pausing the Simulation 

Click the  button to temporarily suspend the Simulation. 

If you now click the  button, the Simulation will resume from its current position. 

5.2.3 Stopping the Simulation 

Click the  button to stop the Simulation. 

If you Stop the Simulation, it cannot be resumed from the same position, 
but will start from the beginning, when you Run it again. 

5.2.4 Simulation Speed 
The user can define the simulation velocity that suits his needs, before the simulation 
is run, as well as during it.  
To do this – move the mouse on the speed slider to the left for slower speed, and to 
the right for faster speed: 

 
The speed will be updated in effect only after the current line has been 

executed. 

5.2.5 Simulation Time 

 
This window shows the time it will take to run this NC program on your machine.  
The time displayed here varies for different machines. In the time factor there are 
various elements taken into account, such as X and Y travel time, turret rotation 
speed, tool placement within the turret, repositioning and tool change time. 

5.3 Simulation Screen Elements 
There are three elements in the Simulation screen: 
a – The State Bar  
b – The Graphic Simulation area  
c – The NC Code Editing area  



Punching Manual 

131 

 

5.3.1 The State Bar 
This is the area on the left side of the screen, containing different settings and 
information pertaining to the Simulation. 

5.3.1.1 Snap Button 
This button gives a variety of Snap options, giving the user a choice of choosing the 
most desired one.  
More information concerning this feature you will find in Snapping on an Entity 
section of Introduction chapter in Drafting and Nesting Manual. 

5.3.1.2 Dim Button 
This button enables or disables viewing Dimensions and Text on the part. 
Dimensions that have been placed on the drawing during the drafting stage can be 
toggled ON and OFF by clicking the  button on the State Bar.  

5.3.1.3 Tool Button 
If this button is in the ON state, the program will pause every time there is a change 
tool command in the code. Each tool's preview is being displayed in the tool port. 
To continue running of the program, click the appropriate button in the Execute 
toolbar. 

5.3.1.4 Stop Button 
If there is a Stop Machine command defined in the program, this button enables and 
disables that Stop (for the Simulation’s run): 



cncKad 

132 

When it is in the OFF state, the Simulation will not halt for any stop commands, (on a 
lot of machines the stop command is M00), however when it is in the ON state, the 
simulation will pause every time a stop command is encountered. To continue with 
the simulation, click the appropriate button. 

5.3.1.5 Clamp Button 
This button enables or disables the warnings that are issued when the Clamps' Dead 
Zone is entered: 
In the OFF state, the Simulation will run without any pauses, even if the tool enters a 
Dead Zone.  

Note: If the tool damages the Clamps, a warning will be issued and the 
program will pause running. 

However in the ON state, the Simulation will pause every time the tool enters the 
Clamps' Dead Zone. The tool might not be damaging the Clamps, but the warning is 
issued, so that you would be aware that the tool is now working in the area of the 
Clamps. 

5.3.1.6 OBS Button 
This option is a button of Optional Block Skip feature and appears on most of the 
machines. Its function is to allow the program to ignore or execute lines that have 
double slashes before them, e.g.: 

Y527. 
X78. 
//G72X61.5Y564.5 
//G66I8.J180.P-5.K8.T217 (R 5. 5.) 
//G72X253.5Y564.5 
G66I8.J0.P5.K8. 

When this button is in the ON state, the lines with double slashes before them will be 
ignored (not executed), but when this button is in the OFF state, these lines will be 
executed. 

5.3.1.7 Cursor Coordinates 
This section shows the coordinates of the cursor's current position, when it is being 
moved inside the graphics area of the Simulation screen: 

 

5.3.1.8 Program Information 
These coordinates show the current position of the turret in the graphics area of the 
Simulation screen, when the simulation is being run: 

 

5.3.1.9 Line section 
In this section of the State Bar you can see the station number the current tool is 
using, and a number of the line it is presently processing: 
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5.3.1.10 Tool information 
The square port displays a graphic representation of the tool that is currently being 
used for sheet processing, as well as the station number it is placed in and the button 
displays its name: 

 
If you click the button, a list of all the tools that are used in the program will be 
displayed, together with the station numbers there are placed in: 

 

5.3.2 NC Code Editing 
The NC code is displayed on the right side of the screen, and can be edited from this 
area. If the user makes changes to the code, the graphic display will be updated 
automatically to reflect these changes. 
In order to edit the code select a line you want to edit, modify it and then from the 
keyboard presses Enter key, so that the changes made to the current line would be 
updated on the graphic display. 
The editing commands, available from the Edit Toolbar 

, are: 

• Inserting a new line   

• Deleting a line   

• Inserting a G Code (Pattern)   

• Marking a CAM   

• Send to machine (DNC)  

Note: The Edit Toolbar is activated only when the user clicks the cursor in 
the NC code side of the screen. 

• Send NC to Diskette  

• Searching List  

• Find Previous  
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• Find Next  

5.3.2.1 Insert a New Line 
Place the cursor on the line of code before which you want to insert the new line and 

click the Insert Line button – . 

5.3.2.2 Delete a Line 
Place the cursor on the line you wish to delete and click the Delete Line button – 

. 

5.3.2.3 Insert a G Code (Pattern) 
Place the cursor at the position at which you wish to insert a G-Code and click the 

pattern button – . A following dialog will appear, where you will be able to enter 
the desired G-Code: 

 
When you have finished, click the OK button. 

5.3.2.4 Mark a CAM 
If you want to find out how a specific line of code is being represented in the graphic 

simulation click on a line of code and then click the  button. Simulation marker (a 
large cross) will jump to the corresponding CAM. 

Note: To see an additional CAM, repeat the preceding procedure. 

5.3.2.5 Send to machine (DNC) 

The  button sends the NC code to DNC program, so that it can be remotely 
transmitted to the machine. 

5.3.2.6 Send NC to Diskette 

Choosing the  button you can send the NC code to a diskette, so that it can be 
transferred to the machine. 

5.3.2.7 Searching List 

To this field  you can enter the value you are looking for in the 
NC code. When you press Enter key, you will be transferred to the line of the code 
containing this value. By the use of below described buttons, you can look for further 
instances of this value. 

5.3.2.8 Find Previous 

When you click the  button, the last found instance of the value typed in 
Searching List will be marked in the NC code 
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5.3.2.9 Find Next 

When you click the  button, the next found instance of the value typed in 
Searching List will be marked in the NC code. 

5.3.3 Graphic Simulation 
The Graphic Simulation area allows the user to preview how the NC code will be 
run on the machine. 
When the Simulation is run, the Simulation marker (a large cross) shows the graphic 
position of each line of code, as it is performed. 
There are several various options that enable the user to manipulate the display, and 

they can be accessed from the Zoom  and Graf 

 toolbars, as well as from the View menu: 

 

5.3.3.1 Toolbar... 
This option is used to customize the toolbars. 
More information on this subject you will find in Using the Toolbars section of 
Drafting and Nesting Manual, with this difference that in each cncKad module the 
toolbars list and their content vary, but the general rules are the same.  

5.3.3.2 Status Bar Enabled 
Choosing this option makes Status Bar appear on the screen.  
The Status Bar enables or disables viewing tips about the option you are selecting 
(outlined below):  
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5.3.3.3 Status Bar On Top 
Selecting this option positions the Status Bar above the toolbars, and unchecking it – 
places it  below the Graphic Simulation area. 

5.3.3.4 Beep  
This option enables or disables a beeping sound, which is used to mark each CAM 
during the Simulation’s run. 

5.3.3.5 Split 
After selecting this option, the line separating the Graphic Simulation area from the 
Code Editing area will follow the cursor. In order to set chosen position of the line, 
click the mouse. 

5.3.3.6 Zoom Part – F5 

 – This command fills the view port of the Graphic Simulation with the complete 
extents of the drawing. 

5.3.3.7 Zoom Sheet – Ctrl+F5 

 – This command zooms the full extents of the sheet; all instances of the part on 
the sheet will be displayed. 

5.3.3.8 Zoom Window – F6 

 – This command zooms into an area defined by the two opposite corners of a 
window.  
In order to use this command – place the cursor in the first corner of the area that 
you wish to zoom into, click the mouse and the window will open. Now drag the 
opened window to the opposite corner of the area you wish to zoom into and click the 
mouse again. The area selected within the window borders will fill the viewing port of 
Graphic Simulation. 

5.3.3.9 Zoom In – F3 

 – Each clicking on this command enlarges the display by twice the current 
magnification. 

5.3.3.10 Zoom Previous 
This command allows the user to return to the previous view of the Simulation. 

5.3.3.11 Zoom Out – F4 

 – Each clicking on this command decreases the magnification by half the current 
display.  
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5.3.3.12 Zoom Realtime 

 – This option enables you to zoom the display incrementally: after clicking this 
icon, click on the draft, and then move the mouse wheel up to zoom in, or down to 
zoom out. 

5.3.3.13 Pan Realtime 

 – With this option you can "grab" and move the draft on your screen to view 
different sections in it – click the right mouse button anywhere on the draft and move 
the mouse on the screen. As long as the button is clicked, the draft will follow the 
mouse’s movement. 

5.3.3.14 Redraw – F2 

 – This command allows for refreshing the screen and the drawing on it, cleaning 
any temporary markers that have been placed on the draft. 

5.3.3.15 Mark Line 
If you want to find out how a specific processing (punch or cut) is implemented in the 

NC code, click the  button, and then click a CAM. Its corresponding line of code 
will be highlighted in the NC code area.  
If you want to see an NC code representation of an additional CAM, repeat the 
preceding procedure. 

5.3.3.16 Ask 

 – Choose this option and click an Entity to view information about it. 

You can only select Entities in the original part, and not in the multiplied 
copies. 

5.3.3.17 Show Clamps Bar 
You should choose this option when you want to see the full extension of the Clamps 
holding the sheet. 
More information on this option you will find in the Clamp Bar section of 
Introduction chapter in Drafting and Nesting Manual. 

5.3.3.18 Fill Tools 
Choosing this option the tools will be filled on the display. The result will be as shown 
on the below picture: 
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5.3.3.19 Rapid Tool Path 
Choosing this option you will be able to see the path which the tool makes while 
processing the sheet. 

 

5.3.3.20 Display Bend Lines 
Enabling this option will allow you viewing the bend lines – if the currently processed 
part was bent. If it wasn't bent – no bend lines will be shown. 

5.3.4 Measure 
Use this option to measure distances on the part: 

 

5.3.4.1 From Base Point 
Use this option to measure distances from one point to multiple points on the part: 
The first position you click the mouse sets the base point. 
The second click measures the distance to the clicked position. 
Thereafter, the next click clears the selection and the one after that measures new 
distance. 

5.3.4.2 Point to Point 
Use this option to measure distances from one point on the part to another point. 

5.4 The Tools Menu 
These options allow you to manage and check the tool in the Simulation setup and in 
incoming NC files.  

5.4.1 Edit Tools Library 
Here you can add or remove tools from the Tools Library. 
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For a complete explanation see the appropriate section in this manual. 

5.4.2 Edit Setup 
Here you can edit the Simulation’s setup file. 

Use this option to create a turret setup that corresponds to the machine’s 
tooling. 
This will be the basis for comparison with the NC files, so it has to be an 
exact match for the machine. 

For a complete explanation see the appropriate section in this manual 

5.4.3 Check Stations 
After we have created the Simulation Setup we can check NC files for 
discrepancies.  
To do this load an NC file, select this option and the Turret Management window will 
open: 

 

5.4.3.1 Simulation tooling 
This is the Tools in Turret section of the dialog and it shows the Simulation’s tooling 
setup – which tools are specified for which station. 

As noted, this is supposed to be an exact representation of the actual 
tooling in the machine. 

5.4.3.2 NC tooling 
This is the New Tools section of the dialog and it shows the tooling as specified in 
the NC file, and if there are any changes that have to be made in order for the NC to 
run correctly on the machine. 
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This can be based on a setup file in cncKad, or simply defined by whoever 
processed the part. 
If there are any changes to be made, they are shown in the Operation column: 

• Blank – this station is not used in the NC. 
• OK – this station matches the setup: 

 
• OK (NC Change) – there is a discrepancy with the setup, but it can be 

corrected in the NC: 

 
• Move from xxx – the operator must make a change in the machine and 

switch between the tool in station xxx (e.g., 141) and this tool: 

 
• CHANGE – the operator must add this tool to the machine: 

    

5.4.3.3 Settings and definitions 
These allow you to change tooling definitions, display modes and the NC file. 

5.4.3.3.1 Change Station for New Tool 
This button is used to move tools between stations in the Simulation’s setup. 
Click on one of the stations and click the button – a dialog will open showing which 
stations are available to accept this tool.  

Only move them – not change. 
To change the tool, use the Change Turret Tool button. 

There are several restrictions for moving the tools: 
• You can only move tools that are used in the current NC. 
• You can move a tool only into an appropriate station – for a C sized tool, only 

C and larger stations will be available. 

There is also a matter of tool rotation – a tool in an Index station can only 
be moved to another Index station. 

• You cannot change to a station that is being used in the NC. 
If you do not follow these restrictions, you will either get a dialog without any stations, 
or none at all. 

5.4.3.3.2 Change Turret Tool 
This button is used to change the Simulation’s setup – add or change tools in a 
specific station. 

5.4.3.3.3 Display Mode 
These settings determine which stations will be shown. 

5.4.3.3.3.1 All Turret 
Shows all the stations in the turret. 

5.4.3.3.3.2 Used Tools Only 
Shows only those stations that are used for the NC (this includes those that have to 
be changed in the setup).  
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5.4.3.3.3.3 Changes Only 
Shows only those stations that require changing tools in the setup. 

5.4.3.3.4 Confirm All Turret Changes, Correct NC 
This will make all the changes needed to punch the part correctly: 

• Add the necessary tools to the setup. 
• Correct the stations in the NC to match those in the (newly changed) setup. 

5.4.3.3.5 Close, Do Not Update 
This will close the dialog without making any changes. 

5.4.4 Tooling Changes Example 
Below we have a section of an NC file showing station assignment as it was 
generated by cncKad: 

 
When we use the Check Stations option, we get the following: 

 
We see results for four tools: 

• RE 65 5 and RE 6 3 are in their correct stations. 
• SQ 30 is in the wrong station, but this does not require any change in the 

turret. 
• RO 6 is missing from the setup (and thus from the machine) and must be 

added by the operator.  
After we confirm the changes, the code changes to reflect the corrected station 
assignments: 
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Punching Manual 

143 

6 Appendices 
 
These topics provide explanations regarding some more advanced features in 
cncKad.  

6.1 The Report File 
Below you will find explanations concerning Report Files and directions of how to 
create them. 

6.1.1 Small Introduction 
A Report File is a document that provides information about a part created in 
cncKad.  
You can use the default Report Templates supplied with cncKad’s installation, or you 
can create your own ones. 
In order to create your own template you have to go through three stages: 

o Creating a template 
o Debugging it 
o Testing it with cncKad 

In the following pages we will be using several concepts that are important for 
creating good templates: 

• Plaintext – A file format that contains only text in a single font and nothing 
else; when viewing such a file with an editor, what you see is what you get. 
Windows supplies two plaintext editors – Notepad and DOS Edit. 

• RTF – A general format used by text editors to create documents with 
graphics and fonts. When viewed in Word or WordPad you will see the 
graphics and the fonts, but if you view such a file with a plaintext editor you 
will see that it is comprised of coded text that tells WordPad how to display 
the document. 

• DOC – A format used by Microsoft Word to create documents that contain 
complex graphics and fonts. When viewing such a file with a plaintext editor 
you will see a lot of gibberish with some regular text strewn among it. 

• Attribute – A characteristic of a part, such as its size, the material it is made 
of, which tools are used to process it and so on.  

• Token – A sequence of letters or numbers beginning with "@"; tokens cannot 
contain spaces, and must have a space after them. Each token is unique and 
represents a specific attribute of a part.  
For available tokens go to: Common Tokens and Additional Tokens 
sections of this chapter.  

• Post Process – Taking a draft of a part in DFT form and turning it into an NC 
file that can be sent to a machine. During the Post Process, cncKad keeps 
track of the various attributes of the part and each of these features is saved 
as a variable. These variables can be accessed and shown in the template 
you will create. 

• Template – A file in plaintext, RTF or DOC formats containing a document 
that uses tokens to display information about a part. Each token represents a 
specific variable. During the Post Process, when the template is loaded into 
cncKad, the post processor recognizes these tokens in the document, and 
replaces them with the values of the actual variables of part’s attributes. After 
the Post Processing is over the template is saved under the part’s name, with 
an extension denoting it as a Report File. 
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6.1.2 Types of templates 
In general, a template consists of pairings of an Attribute description followed by the 
token for this attribute, for example: 
 

Draft Number: @DRAWNUM   
or  

Customer Name: @CUST 
 
Before beginning with template creation, you must decide what kind of format you 
want to make. 
There are three main types of templates, with pros and cons for each: 

• Plaintext – very easy to create and debug, but limitations in font and graphics 
make this kind of template plain looking.  
Go to A plaintext template example section and see an example. 

• RTF – you can create very attractive templates, with different colors and fonts 
for highlighting key attributes, tables to delineate groups of attributes, etc. 
Creating this kind of template is a complex process, and it is hard to debug. 
Go to An RTF example section and see an example. 

• DOC – this format allows you to utilize all the options available from Word – 
fonts, tables, colors, backgrounds, etc. These are the most attractive Reports, 
and are very easy to create, but owing to the complexity of this file format, it 
takes cncKad longer to generate the actual Reports during the Post 
Processing stage. 
Go to A DOC example section and see an example. 

There is another type of template used in cncKad, but it is not advisable to 
create templates of this type. These are DOS text templates, created 
with DOS Edit. 

6.1.3 Creating the Template 
Before starting a template, you should decide first which attributes of the part you 
want to display, and make a rough draft of it on paper. 

6.1.3.1 Naming a Template 
Whichever type of template you create, there is a certain naming convention you 
must follow in order to allow cncKad to use it fully. 
The format for template names is: 

RPT_xxx_name.* 
Where: 

o "xxx" denotes language. Use the first three letter of the English name of 
the language – POR for Portuguese, SPA for Spanish, etc.  

o "*" is one of the four formats used by cncKad – DOC, RTF, TXT and 
OEM. 

It is of course possible to give different names for templates, but if you do this 
cncKad will not be able to recognize it automatically in the NC Report Template 
Tab of the Machine Settings dialog. See the appropriate section in Settings chapter 
of Drafting and Nesting Manual.  

6.1.3.2 Creating a Plaintext Template 
1. Open an editor, preferably a plaintext editor such as Notepad. 



Punching Manual 

145 

2. Type in the attributes you have chosen, leaving space for a token following 
the attribute. You can use dashes and underscores to delineate attributes.  

3. After each attribute write the corresponding token, making sure you leave at 
least one free space before the latter one. After each token you must leave a 
certain size of free space, to make a room for the attribute’s value. 

4. The size you must leave for each token varies – for a Time token (e.g. 
@PUNCH_T) you need 5 characters (mm:ss), whereas for a descriptive token 
(e.g. @DESCR) you will want to insert several words (30-70 characters). When 
designing your template it is a good practice to write down the size you allot 
for each token, so that you will know in the future not to attempt to insert too 
many characters in its place 

5. Save the template as Text Document (.txt) in the Machines folder of cncKad 
(to see its location, go to Settings => Machine Settings => Machine tab => 
Machine Settings => Machine Path). If you are working in a plaintext editor 
(Notepad etc.) simply save the document to the above mentioned folder; if 
you are using WordPad, you will have to specify the Save as Type as "Text 
Document", since there are no file type extensions displayed: 

 
6. Go over the template again, checking that each token has at least one space 

preceding it and at least one following it. 
7. That’s it – you are done. Jump to the Testing your Template section. 

6.1.3.3 Creating an RTF Template 
1. Open Word. 
2. Make your template, incorporating the attributes you have chosen; you can 

use different colors, font sizes and types, and tables. When drawing tables, 
be aware you can only use the plain line type.  

3. After each attribute write the corresponding token, making sure you leave at 
least one free space before the latter one. After each token you must leave a 
certain size of free space, to make a room for the attribute’s value. If you have 
incorporated tables, move their limits to accommodate for it. 

4. Because in this format you will probably wish to use tables, it is imperative to 
note the following: 
The size you must leave for each token varies – for a Time token (e.g. 
@PUNCH_T) you need five characters (mm:ss), whereas for a descriptive token 
(e.g. @DESCR) you will want to insert several words (30-70 characters). When 
designing your template it is a good practice to write down the size you allot 
for each token, so that you will know in future not to attempt to insert too 
many characters in its place. 

5. Save your template into the Machines folder of cncKad (to see its location, 
go to Settings => Machine Settings => Machine tab => Machine Settings => 
Machine Path), making sure you save it as an RTF file. 

6. Open the template with WordPad, and save it again. This removes all the 
extraneous coding Word inserted into it. Close the document. 

7. Open the template in a plaintext editor. 
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8. Go over the document, and make sure that every token is followed by a 
space. You cannot do this in WordPad, as the RTF format contains a lot of 
hidden code that only appears in plaintext. 

9. Save the document. You don’t have to worry about formats – it will be saved 
as an RTF. 

6.1.3.4 Creating a DOC Template 
Before beginning:  

o Always start from one of the Templates supplied with cncKad, and use 
the tables included in it (if you need tables).  

o Do not attempt to create new tables for Parts or Tools – in the supplied 
tables there is an underlying code, which you would need for report to 
work. 

1. Open Word. 
2. Open an existing Template and use Save As… option to create a new 

template (observing the Naming Conventions). 
3. Make the changes and additions you want, incorporating the Attributes you 

have chosen; you can use different colors, font sizes and types, and tables.  
4. Save your Template in the Machines folder of cncKad (to see its location, go 

to Settings => Machine Settings => Machine tab => Machine Settings => 
Machine Path). 

6.1.4 Testing your Template 
Open cncKad and go to Settings => Machine Settings => NC Report Template tab.  
In the File Name field, click the dropdown menu and choose your new template 
(assuming you have used the naming convention explained above).  
Open a previously created part, and run the Post Processor by holding down the Ctrl 

key and clicking the  button in the Common Toolbar. After the post process is 
over, go to File => Print Preview, and choose the Doc Report File option in the 
Select Print Mode dialog.  
A new window will open showing a Report File that was produced using your 
template. Go over it carefully, making sure all the values are in their proper places; 
this is especially important for RTF templates. 
 
Common problems: 

1. In a Text/RTF/DOC template, attribute’s value isn’t shown in the report.  
Resolution – reopen the template in a plaintext editor and place a space 
before the token. 

2. In a Text/RTF/DOC template, an attribute’s token is shown instead of its 
value.  
Resolution – reopen the template in a plaintext editor and place a space 
after the token. 

3. In an RTF/DOC template, an attribute has "jumped" a cell in a table.  
Resolution – check that you have allotted the correct free space for the 
attribute preceding the one that jumped. 

4. In a plaintext template, all the lines and text are out of place.  
Resolution – cncKad’s plaintext templates are read in DOS, so you must 
correct your template with DOS Edit; to do this, go to Settings => Machine 
Settings => Machine tab => Machine Settings. In the Selected Machines 
window choose your machine and then find your template in the Edit 



Punching Manual 

147 

Machine Files dropdown menu; click Edit button and your template will open 
in DOS Edit. Correct all the offsets and save the template. 

6.1.5 Tokens in cncKad 
Here you will find lists of cncKad tokens that can be used for creating template: 

6.1.5.1 Common Tokens 
Following is a list of the most common tokens: 
Token Attribute 
ANGLE The tool’s angle (Punch) 
CLAMPS The position of the clamps 
CLEARANCE Tool Clearance values: Min, Best, Max 
CLMP_QTY Number of clamps  
CUST The name of the part’s customer 
CUT_T Time taken up by cutting (Laser) 
CUT_TP Cutting time per Part: to be used in a Nesting Line (Laser) 

Gives the cutting time only if the part has a Sub-
Routine 

CUT_WAY The length of the cutting path (Laser) 
DATE Date 
DATE_T Date with Time 
DESCR The part’s description 
DRAWNUM The draft’s serial number 
FILE The NC file’s name and partial path 
LENGTH The tool’s length (Punch) 
MATERIAL The part’s material 
MODEL The machine’s model 
MOVE_LEN The rapid movement path (Laser) 
MOVE_T The rapid movement time 
NESTING This token denotes if this is a nesting 
NOTE1 The order number of the part 
NOTE2 The draft's version 
NOTE3 General notes 
NUM_OF_SHEETS Number of Sheets 
P_PREV Part's preview 
PART_DIM The part’s dimensions 
PART_NUM The total number of parts 
PIERC_NUM The number of pierces (Laser) 
PIERC_T  The piercing time (Laser) 
PROC_T Total time for the processing 
PROGLNG The program's length 
PROGNUM The program’s serial number 
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PROGR The programmer’s name 
PUNCH_T The time taken up by punching (Punch) 
QTY The number of parts in a Nest 
REPOSNUM The number of repositions 
ROTTUR Sheet's rotation/turn 
SHEETD The sheet’s dimensions 
STAT The tool’s station number (Punch) 
STROKES The number of hits per tool (Punch) 
THK The sheet’s thickness 
TC_T The time taken up by tool changes (Punch) 
TL_DIE Dies for the Tool 
TOOL_NUM The total number of tools used (Punch) 
TYPES The tool’s type (Punch) 
WIDTH The tool’s width (Punch) 
PB_NAME Part's file name, without the extension 
PB_DX Size of Part in X 
PB_DY Size of Part in Y 
PB_AREA Part Area: when the Nest is generated by Auto Nest, this is 

an exact area, otherwise – area of bounding rectangle 
PRT_WGHT Part Weight in Kg, e.g.: 2.120 kg  When the Nest is 

generated by Auto Nest, this is an exact Weight, otherwise 
– Weight of bounding rectangle  

PB_WU According to current Units, e.g.:  For mm: 2.120 kg  For 
Inch: 4.664 lbs 

PB_WKG Kg without units string: 2.120 
PB_NUM Part Running Number 
SHT_WGHT Sheet Weight in Kg: 52.50 kg 
SHT_WU According to current Units, e.g.: For mm: 52.50 kg  For Inch: 

115.50 lbs 
SHT_WKG  Kg without units string, e.g.: 52.50 
START_CORNER Program Origin, with the following values: 0 - Top-Left Origin 

1 - Bottom-Left Origin  2 - Bottom-Right Origin  3 - Top-Right 
Origin  

X_START_CORNER The Starting Corner X value 
Y_START_CORNER The Starting Corner Y value 

 Decimal Digits: If you want to use in an RTF Report Template, 
ALWAYS use as follows: 

@#S1 = 
@SET_FIXED_DECIMAL_DIGITS{ 3 } 

At start of Report, after an Empty line! 

@#S1 = 
@SET_FIXED_DECIMAL_DIGITS{ -1 }

At End of Report 

SET_FIXED_DECIMAL_DIGITS{ 3 } Generate 3 decimal digits,  e.g.: 35.000 
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SET_FIXED_DECIMAL_DIGITS{ -1 } Return to original decimal settings, e.g.: 35. 

6.1.5.2 Additional Tokens 
Below you can see the list of additional tokens: 
Token Attribute 
ACC Acceleration in X in mm / sec² 
ACCX Acceleration in X in mm / sec² (the same as ACC token) 
ACCY Acceleration in Y in mm / sec²  
AR_SHT_THCK Sheet directives for ARIESII directives 
AR_TBLOCK Tool blocks for old ARIES 245 directives 
ARII_METAL Material Type for ARIESII 
ARIIPROGR Programmer name (for ARIESII) 
AR2STAT_NUM Tool blocks for Nisshinbo directives 
NI_TBLOCK Tool blocks for ARIES 245-II and ARIES 255 directives 
CALL_NCSEC Call to NCSEC from model (MDL) 
CL1 First clamp 
CL2 Second clamp 
CL3 Third clamp 
CL4 Fourth clamp 
CL1F Clamp 1-st position on X with floating point 
CL2F Clamp 2-nd position on X with floating point 
CL3F Clamp 3-rd position on X with floating point 
CL4F Clamp 4-th position on X with floating point 
CL1N Hopper number of the 1-st clamp 
CL2N Hopper number of the 2-nd clamp 
CL3N Hopper number of the 3-rd clamp 
CL4N Hopper number of the 4-th clamp 
CLAMPS_MOVED The value will be equal 1 if ANY  clamp has been moved 

CLAMPS_CHECK 
The value will be equal 1 if the clamps position should be 
checked 

CL_ARII Clamps position (for ARIESII) 
SHT_EFF Sheet efficiency (in percentage) 
CUPS Cups value for FinnPower when loading sheet 
CUT_PRESS Cutting pressure 
DBLSLASH Generate double slash '//' 
DELAYEDPUNCH Notifies when the punch is delayed 
DFT_PATH Path of DFT file 
DFT_XOFS DFT offset on X 
DFT_YOFS DFT offset on Y 
F_HEADPOS Focus the position of cutting head  
F_PRE_PRG Pre Program Functions 
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F_POST_PRG Post Program Functions 
FNAME File name (without extensions) 

FNAME_WITH_ 
Like @FNAME with replacing all Non-Alphanumeric signs 
into '_' 

FEED_MAX The maximum machine feed 
FEED_X_MAX The maximum machine feed on X 
FEED_Y_MAX The maximum machine feed on Y 
FIRST_X First punch position on X 
FIRST_Y First punch position on Y 
FTL_BDC Bottom Dead Center for Forming tools 
FTL_TDC Top Dead Center for Forming tools 
GAP Gap 
GAS The character of the gas  
GLOB_COOLING_TIME Cooling time from Global Cut 
GLOB_CUT_SENSOR Final cutting sensor 
GLOB_PIERCE_SENSOR Final piercing sensor 

LAS 
Gives information about laser (from Material Technology 
Table) 

GEOM 
Gives information about geometry (from Material 
Technology Table) 

ENGRAVE_QTY Quantity of engraved elements 
PIERCE_TYPE_QNT Number of types of piercing 
LCURLY Generate '{' left brackets 

STATION_IN_SETUP 
Station in setup; the value will be 1, if the specific tool is also 
in same station in the current setup 

IS_STATION_LOCKED The value will be 1 if the specific tool is locked in the station 
LENS_NUMB Number of cutting lenses 
THIS_LINE_NUM Number of current line 
LINE_NUM_STEP Step of the line numbering 
LOADING_MODE Loading mode: 0=Manual, 1=Auto 
UNLOADING_MODE Unloading mode: 0=Manual, 1=Auto 
MATNUMBER Material's number 
MAT_TONNAGE Tonnage of material 
DENSITY Density of material 
CLR_MIN Minimal clearance 
CLR_BEST Best clearance 
CLR_MAX Maximal clearance 
MATMNAME Machine's name (Material parameters) 
MATCLASS Material class:  0=Steel,  1=Stainless  2=Aluminium 
MAT_MAX_WIDTH Material Max Width for Dynamic Pierce 
MAT_MACH_NAME2 Machine's Name 2 
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MAT_ID Material ID 
MACHOFSX Machine offset on X 
MACHOFSY Machine offset on Y 
MTG  Material Gage 
MEASURE_SHEET Measure sheet: 0=do NOT measure, 1=Measure 
MEASURE_SHEET_TYPE Type of Sheet Measuring 
MEASURE_CORNER1_X Measure 1-st Corner on X 
MEASURE_CORNER1_Y Measure 1-st Corner on Y 
EDGE1_LENGTH_X First Edge Length on X 
EDGE1_LENGTH_Y First Edge Length on Y 
MEASURE_CORNER2_X Measure 2-nd Corner on X 
MEASURE_CORNER2_Y Measure 2-nd Corner on Y 
EDGE2_LENGTH_X Second Edge Length on X 
EDGE2_LENGTH_Y Second Edge Length on Y 
MEASURE_HOLE1_X Measure 1-st Hole on X 
MEASURE_HOLE1_Y Measure 1-st Hole on Y 
MEASURE_HOLE1_DIA Measure diameter of the 1-st Hole 
MEASURE_HOLE2_X Measure 2-nd Hole on X 
MEASURE_HOLE2_Y Measure 2-nd Hole on Y 
MEASURE_HOLE2_DIA Measure diameter of the 2-nd Hole 

MM_TO_UNITS 

Convert millimeters to inches. For example: 
@MM_TO_UNITS{ 254 }  will generate 254 for mm, and 10 for 
Inch 

TURRET Turret name 
NCEXT NC extension only 
NCPATH Partial NC path 
NESTING Nesting 
NOTEARII Note for ARIESII 
NPART The name of the part 
NUM_ON_X Number of parts on X 
NUM_ON_Y Number of parts on Y 
PART_PATH Partial path without extension 
PB_N Current Part Number (in Multiple Parts) 
PB_PRC_NUM Part: quantity of piercing 
PB_AREA_NO_UNITS Part: area without units 
PB_SUM_PART_AREA Total parts area 
PB_WGHT_NU Part: weight without units 
PB_SUM_PART_WEIGHT Total parts weight 

ALL_VAC_FIELDS1 
Notice all vacuum fields being used in the first arm of Part 
Unloader  

ALL_VAC_FIELDS2 Notice all vacuum fields being used in the second arm of 
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Part Unloader  
AREA_UN Area units 
WEIGHT_UN Weight units 
MAT_THK_ID Material thickness ID 
CUT_WP Cutting way of current part 
PB_WORK_ORDER Part's working order 
PAU_STOP_PUN The punch can be stopped from NCSEC or from Function 

PAU_PUSHOUT_CENTER_PUN 
The punch can be pushed out on center from NCSEC or 
from Function 

PAU_PUSHOUT_RIGHT_PUN 
The punch can be pushed out on right from NCSEC or from 
Function 

PAU_PUSHOUT_LEFT_PUN 
The punch can be pushed out on left from NCSEC or from 
Function 

PAU_PUSHOUT_NOMOVE_PUN 
The punch can be pushed out, without movement, from 
NCSEC or from Function 

PAU_PUSHOUT_FIXED_PUN 
The punch can be set as fixed from NCSEC or from 
Function 

PAU_STOP_CUT The cut can be stopped from NCSEC or from Function 

PAU_PUSHOUT_CENTER_CUT 
The cut can be pushed out on center from NCSEC or from 
Function 

PAU_PUSHOUT_RIGHT_CUT 
The cut can be pushed out on right from NCSEC or from 
Function 

PAU_PUSHOUT_LEFT_CUT 
The cut can be pushed out on left from NCSEC or from 
Function 

PAU_PUSHOUT_NOMOVE_CUT 
The cut can be pushed out, without movement, from NCSEC 
or from Function 

PAU_PUSHOUT_FIXED_CUT The cut can be set as fixed from NCSEC or from Function 
PATH_NAME_EXT Partial path, name and extension (DFT or NST) 
PIN_NUM Pin number 
PRE_PROG_FUNC_1 Pre Program Functions 1 
PRE_PROG_FUNC_2 Pre Program Functions 2 
QTY_OF_SUBS Quantity of Sub-Routines in current NC 
QTY_OF_STATIONS Total number of Stations in the Turret 
QTY_TOOLS Real number of used tools; equals the number of used 

stations. 

Example: 
            RO  6.2 
             RE 50  5 
             RE 50.001  5 
             RE 50  5       Seq=99 
QTY_TOOLS = 2   TOOL_NUM = 4 

QTY_FORMING_TOOLS Number of the forming tools 
NAME_FORMING_TOOLS Name of the forming tool 
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QTY_TAPPING_TOOLS Number of tapping tools 
QTY_MAX_TAPPING_TOOLS Maximum Number of tapping tools allowed 
QTY_LAS_TOOLS Number of active laser stations 

RAINER_TOOLS 
Generates tools for Rainer machine (in the beginning of the 
NC) 

REL_PATH Partial (Relative) Path with NC extension 
REPOSLAST Last Reposition in X 
REPOSTOTALPREVTRANS Total value of reposition of previous Transformation 
REPOSTOTALCUR The Total value of reposition up to this point 
REPOSFIRST First reposition in X 
REPOS2 Second reposition in X 
REPOS3 Third reposition in X 
REPOS4 Fourth reposition in X 
REPOS5 Fifth reposition in X 
TRANSTYPE1 First transformation type 
TRANSTYPE2 Second transformation type 
TRANSNAME1 First transformation name 
TRANSNAME2 Second transformation name 
END_OFFS_DX Sheet End Offset in DX 
END_OFFS_DY Sheet End Offset in DY 
SET_DECIMAL_MODE Set Decimal Mode: 0- Always, 1- Never, 2- Only if needed 
SET_FIELD_SIZE Set Field Size 
SET_FIXED_FIELDS Set Fixed Fields 

SET_G0123 

Set the current interpolation. For example: @SET_G0123{0} 
to set G00, or to force interpolation on next command: 
@SET_G0123{ -1 } 

SET_LINE_NUMBERING 

Set line numbering: 0- OFF, 1- ON 
For example: @SET_LINE_NUMBERING{0} means: do NOT 
put line numbers 

SET_PUNCH_MODE Set Punch Mode: 0- OFF, 1- ON 

SET_STATION 
Set the current station. If you want to force Tool Change, 
use -1:                    @SET_STATION{ -1 } 

SET_X_HEAD 
Set the Head in X. For example: @SET_X_HEAD{130} 
                                   or: @SET_X_HEAD{@#F1} 

SET_Y_HEAD Set the Head in Y 
SET_X_MACH_OFS Set machine offset on X 
SET_Y_MACH_OFS Set machine offset on Y 
SFEVAL Make some calculation; the result is a decimal number, 

according to the current MDL precision and number format. 
For example: @SIEVAL{ @SHTY / 2 } 

SHEAR_IS_USED Notices if the Shear function is being used or not 
SHEETDIM The dimensions of the sheet 
SHEETGAP Sheet Gap 
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SHT_TYPE Sheet Type:  0=Normal,  1=Formed,  2=Irregular 
UsedArea The area of the bounding rectangle of the parts on the sheet
SHT_SIZE_ID Sheet size ID 
SHT_XOFS Sheet offset on X 
SHT_YOFS Sheet offset on Y 
SHTX Sheet size in X 
SHTY Sheet size in Y 

SIEVAL 
Make some calculation, the result is Integer. For example: 
@SIEVAL{ @THK * 10 } 

SHEXEVAL Convert the decimal value to hexadecimal value 
SIZE_AND_DX Part size and distance between parts on X 
SIZE_AND_DY Part size and distance between parts on Y 
ST_ABC Station Size Letter 
ST_ABC_NUM Station Size letter, then Station Number.  E.g.: B 314 
STATION_NUM Number of the station 
STATION_AI Auto Index Station: 1 for AI Station, 0 for Standard Station 
STATION_MULTY Notifies if there is a Multi Tool Station 
ST_OFFSET_X Station offset on X 
ST_OFFSET_Y Station offset on Y 
SUBS_DEFS Code for creating subroutine definitions in the NC program 
SUBS_CALLS Code for creating subroutine calls in the NC program 
TC600ID ID for Tools: a special TC600 feature 
TAP_NUM Number of Tapping tool 
TAP_NUM_ROT Number of rotations of Tapping tool 
TAP_ROT_SPEED Speed of rotations of Tapping tool 
SEC_TO_TIME Converting seconds to time: For example: 6005   => 100:05 
TIME_TO_SEC Converting time to seconds: For example: 100:05 => 6005 
THK2 Thickness displayed with two decimal digits 
US_THK Thickness displayed with one decimal digit 
TL_CHANGE_POS Change tool position 
TOOL_LINE The line of the tool (in NC) 
TOOL_N The number of the tool 
TOOL_FNAME Brings name of Special (F) tool. E.g.: BANANA.T ->"BANANA"
TRAVEL_GAP Travel gap 
TRAVEL_GAP_HOLES Travel gap in cutting of the holes 
TRAVEL_GAP_PARTS Travel gap in cutting of the parts 
END_GAP End of the gap 
TSEQ Tool Sequence number 
TTLSTRK Total number of strokes with tools 
TL_TYPES Tool types defined by two letters  
TOOL_CODE Tool Code. Codes are as follows: 
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            1 - RO  (ROUND) 
             2 - RE  (RECTANGULAR) 
            -2 - SQ  (SQUARE) 
             3 - OB  (OBROUND) 
             5 - SD  (SINGLE D) 
             6 - DD  (DOUBLE D) 
             9 - F   (TOOL FILE) 
           10 - CR  (CORNER RADIUS) 
           12 - RR  (ROUND RECTANGLE) 
           20 - B   (BEAM - Laser, Plasma, Water, Flame, etc) 

TOOL_TYPE 

The shape type of the tool; the shapes parameters are as 
follows:  
TOOL_SHAPE_NONE=0,   
TOOL_SHAPE_CIRCLE=1,  
TOOL_SHAPE_RECT=2, OVAL=3, POLY=4, D=5, 
L=6, GRID=7, MULTIH=8, FILE=9, X=10, Q=11, 
ROUND_RECTANGLE=12, DRILL=13, MILL=14, MJ = 15, 
BEAM=20, SHEAR=30, SQUARE=-2, ROUND_SQUARE=-12, 
TRIANGLE = 16 

TL_CMNT The comment about the tool 
TL_DIE Tool Dies 
TL_F String of ALL the Tool Functions 
TL_FIS String of one Tool functions 
TL_FIN Number of one Tool functions 

TL_WID 

Wilson Wheel Tool ID:  
   1 – Shear      F   WW01  (Wilson Rolling Shear) 
   2 – Rib or RollBall (for Euromac)  F  WW02  (Wilson Rolling Rib)
   3 – Offset      F   WW03  (Wilson Rolling Offset ) 
   4 – Louver     F   WW04  (Wilson Rolling Louver ) 
   5 – Pincher or Grooving MK (for Euromac)     F   WW05  (Wilson 
Rolling Pincher) 
 100 – Beading Trumpf    F   BEAD01.T    
 200 – Marking, RB for Euromac          F   MARK01.T 

TL_S Number of hits per this tool 
TL_H Tool height 
TL_AREA Tool area 
TL_1 First tool size – length 
TL_2 Second tool size – width; for CR – Cutting width 
TL_3 Third tool size; for CR and RR – Radius size 
X_HEAD Current Head Position (in Sheet Coordinate X)  
Y_HEAD Current Head Position (in Sheet Coordinate Y)  
Z_HEAD Current Head Position (in Sheet Coordinate Z)  
X_HEAD_OFS Current Head Position (in Machine Offset Coordinate X) 
Y_HEAD_OFS Current Head Position (in Machine Offset Coordinate Y) 
XLOADPOS Loading position on X 
XPIN Pin position on X 
XRANGE Machine range on X 
YRANGE Machine range on Y 
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X_PROG_ORIGIN Program origin in axis X 
Y_PROG_ORIGIN Program origin in axis Y 
UNLOAD_X_DIM Unload in dimension X 
UNLOAD_Y_DIM Unload in dimension Y 
UNLOAD_X_COR Unload in corner X 
T_DIA Diameter of the tube 
T_WIDTH Width of the tube 
T_HEIGHT Height of the tube 
T_COR_RAD Tube Corner Radius 
T_TYPE Tube profile type 
T_PROFILE Tube profile string 
T_PROC_LEN Tube processed length 
T_SUP1 Tube Support Place 1 
T_SUP2 Tube Support Place 2 
T_SUP3 Tube Support Place 3 
T_SUP4 Tube Support Place 4 
T_SUP5 Tube Support Place 5 
T_CLAMP_TECH Tube clamping technique 
T_PROC_TYPE Tube processing type 
T_WORK_POS Working Position of the tube 
T_SUP_LOAD_POS Support loading position: 1= right side; -1= left side 
T_SUP_DEAD_MINUS_X Support Dead Zone Minus X 
T_SUP_DEAD_PLUS_X Support Dead Zone Plus Y 
T_STAND_OFF1 Tube Nozzle Stand Off – Step1 
T_STAND_OFF2 Tube Nozzle Stand Off – Step2 
T_RED_CUT1 Reduce tube's cutting speed – Step 1 
T_RED_CUT2 Reduce tube's cutting speed – Step 2 
EMPTY Create empty line in NC code 
T_SUP_TYPE Tube's support type 
M_NUM_TEETH Number of teeth in Milling 
M_FEED_PER_TOOTH Feed per tooth 
M_CUT_SPEED Cutting speed for Milling 
M_T_TYPE Milling tool type 
UD_DATA1 Drawing Number (in User Data) 
UD_DATA2 Project/Customer name (in User Data) 
UD_DATA3 Programmer's name (in User Data) 
UD_DATA4 Description (in User Data) 
UD_DATA5 Order Number (in User Data) 
UD_DATA6 Revision/Version number (in User Data) 
UD_DATA7 Note (in User Data) 
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UD_TITLE1 User defined title for @UD_DATA1 
UD_TITLE2 User defined title for @UD_DATA2 
UD_TITLE3 User defined title for @UD_DATA3 
UD_TITLE4 User defined title for @UD_DATA4 
UD_TITLE5 User defined title for @UD_DATA5 
UD_TITLE6 User defined title for @UD_DATA6 
UD_TITLE7 User defined title for @UD_DATA7 
CUR_GAS Gas used for cutting current sheet 
CUR_HEAD Head used for processing current sheet 
CUR_LENS Lens used for cutting current sheet 
GC_ENG_PRICE Engineering rate 
GC_PROG_PRICE Programming rate 
GC_MACH_HOUR_RATE Hourly machining rate 
GC_MACH_SETUP_RATE Machine setup rate 
GC_MACH_SETUP_TIME Total machine setup time 
GC_GRINDING_RATE Hourly Grinding Rate 
GC_PRICE_PER_BEND Hourly rate per Bend 
GC_TIME_PER_BEND Bending time 
GC_BEND_SETUP_RATE Bend Setup Rate 
GC_PRICE_PER_TAP Hourly rate per Tap 
GC_TIME_PER_TAP Tapping time 
GC_PRICE_PER_DRILL Hourly rate per Drill 
GC_TIME_PER_DRILL Drilling time 
C_PUNCH_SPEED Punching speed 
C_NIBBLE_SPEED Nibbling speed 
C_PUNCH_TIME Total punching time 
C_ENG_TIME Total engineering time 
C_PROG_TIME Total programming time 
C_MAT_TYPE Material Type (in Estimation) 
C_THICKNESS Material Thickness (in Estimation) 
C_MACH Machine type name 
C_GAS Used gas type 
C_HEAD Used cutting head type 
C_LENS Used cutting lens size 
C_CUT_SPEED Machine's cutting speed 
C_GRIND_TIME Total Grinding Time 
C_BEND_SETUP_TIME Total Bend Setup Time 
C_MAT_COST Material price 
C_NUM_PUNCHES Quantity of Punches (in Estimation) 
C_PIERCE_QTY Total number of pierces 
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C_BOX_X Sheet size in X (in Estimation) 
C_BOX_Y Part's bounding rectangle size in Y (in Estimation) 
C_EFF Sheet's efficiency in percentage 
C_AREA_GR Part's area gross (in Estimation) 
C_AREA_NET Part's area net (in Estimation) 
C_WEIGHT_GR Part's weight gross (in Estimation) 
C_WEIGHT_NET Part's weight net (in Estimation) 
C_VAP_LEN Vaporization path length 
C_ENGRAVE_LEN Engraving path length 
C_CUT_LEN Total cutting length 
C_TRAVEL_LEN Machine travel path length 
C_CUT_TIME Total cutting time 
C_ENGRAVE_TIME Total engraving time 
C_VAP_TIME Total vaporization time 
C_PIERCE_TIME Total piercing time 
C_TRAVEL_TIME Total machine travel time 
C_GRIND_PRICE Total Grinding Price 
C_MAT_PRICE Material Price (in Estimation) 
C_DRILL_QNT Quantity of Drills 
C_TAP_QNT Quantity of Taps 
C_BEND_QNT Quantity of Bends 
C_DRILL_TIME Total Drilling Time 
C_TAP_TIME Total Tapping Time 
C_BEND_TIME Total Bending Time 
C_DRILL_PRICE Total Drilling Price 
C_TAP_PRICE Total Tapping Price 
C_BEND_SETUP_PRICE Total Bend Setup Price 
C_BEND_PRICE Total Bending Price 
C_CUT_MACH_TIME Total processing time 
C_TOTAL_MACH_TIME Total machining time 
C_ENG_COST Total engineering cost 
C_PROG_COST Total programming cost 
C_SETUP_COST Total setup cost 
C_MACH_COST Total machine use cost 
C_TOOL_QTY Total number of used tools 
C_TOOL_CHANGE_TIME Tool change time (in Estimation) 
C_TOT_COST_1 Total cost for one part with material 
C_TOT_COST_NO_MAT_1 Total cost for one part without material 
C_TOT_COST_10 Total cost for ten parts with material 
C_TOT_COST_NO_MAT_10 Total cost for ten parts without material 
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C_TOT_COST_100 Total cost for hundred parts with material 
C_TOT_COST_NO_MAT_100 Total cost for hundred parts without material 
C_TOT_COST_1000 Total cost for thousand parts with material 
C_TOT_COST_NO_MAT_1000 Total cost for  thousand parts without material 
C_TOT_COST_VAR Total cost for desired amount of parts with material 
C_TOT_COST_NO_MAT_VAR Total cost for desired amount of parts without material 
C_TOT_COST_VAR_AMOUNT Any number of parts you wish to get the pricing for 

6.1.6 ToolBlockOrder Model Key 
The following section is for advanced users only. 

One of the Keys in a machine’s MDL file is ToolBlockOrder. This Key sets the 
ordering of the Tools: 
Value NC ordered by Report file ordered by  
0 
1 
2 
3 

NC order  
NC order  
TURRET order  
TURRET order 

NC order  
TURRET order  
NC order  
TURRET order  

• NC order means: the order in which the tools work. 
• Turret order means: order by Stations – this is easier for doing the setup on 

the machine. Also, tools which are changed several times during the NC 
(when the tool is used with different Tool Sequence), will appear only once. 

By default, this Key is set to "0". 

6.1.7 Key Words for Tool List in NC and in Report  
Supported in V6.3x. 

You can put in the Report Template (and also in the HDR file) the following Key 
Words: 
  
@TL_F                   Tool Functions 
@TL_CMNT             Tool Comment 
  
This is useful for VIPROS machines for the special M-codes, and in other cases also 
where special M-codes, delays, feeds etc. are being used. 
For example, in the HDR file: 
 
Old HDR: 

@TBLOCK_BEGIN  
(*T@STATION_NUM @TOOL_LINE)  
@TBLOCK_END 
 

Change to:  
@TBLOCK_BEGIN 
(*T@STATION_NUM @TOOL_LINE @TL_F) 
@TBLOCK_END 
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Or in the Report Template: 
|ST No.| Type  |Length | Width|Angle  |   M   |Hits   |  
|@STAT |@TYPES |@LENGTH|@WIDTH|@ANGLE | @TL_F | @TL_S |  

  
For example: 

... 
(*SHEET 1000.0 1000.0 1.0) 
(MAT St 37-2  SPC 1.0) 
(*T202  RO 5) 
(*T303  SQ 7 45) 
(*T210  RE 28 3  AI) 
(*T214  F LUVER.T  M536 , M13 PRESS MODE CANCEL) 
(*T201  RE 65 5) 
(*T218  RE 70 3 90  MEDIUM SPEED) 
(*T307  F EMBOSS16.T  M549, M13 PRESS MODE CANCEL) 
(*T218  RE 70 3 90  MEDIUM SPEED) 
G92X1210.00 Y1270.00 
G90 
... 

Another issue is the order of the tools (see the ToolBlockOrder Model Key section). 
Here you can see the same tool list as above, arranged by Turret order: 

(*T201  RE 65 5) 
(*T202  RO 5) 
(*T303  SQ 7 45) 
(*T307  F EMBOSS16.T  M549, M13 PRESS MODE CANCEL) 
(*T210  RE 28 3  AI) 
(*T214  F LUVER.T  M536 , M13 PRESS MODE CANCEL) 
(*T218  RE 70 3 90  MEDIUM SPEED) 

6.1.8 Template Examples 
The following examples illustrate the differences between the types of templates, and 
present what can be done with each type. 

6.1.8.1 A plaintext template example 
The lines and words do not line up in this example; they will when cncKad, or you, 
will open the template in a text editor. 
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6.1.8.2 An RTF example 
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6.1.8.3 A DOC Example 
 

 

6.2 Creating New Functions 
As explained previously in this manual, cncKad contains a list of pre-prepared 
functions that you can assign to a tool, punch or program.  
If, however, you find that you are in need of a special function that does not appear in 
the list, you can create a new function to suit your requirements. 

6.2.1 The Function's Structure 
Each Function is comprised of three parts: 

• ID number – this number is always preceded by /N .  

There cannot be two functions with the same ID number. 
• Name – this is will be the Function’s identification in cncKad. 
• Code – the actions to perform when this Function is called. 

6.2.2 Making the Function available for cncKad 
The Functions are defined in the machine’s MDL file; the name of this file varies 
according to the machine, but it is always named according to the following pattern: 
machine_name.MDL (in this example the machine is a Vipros 367 Queen, and so the 
file is called VIPR367Q.MDL). 
To access this file, go to the Settings => Machine Settings => Machine tab => 
Machine Settings dialog and mark the machine you are using, and from the 
dropdown menu shown below choose machine’s .MDL file and click Edit button. 
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The Editor will open the file and you will be able to write there a new function, using 
the following format: 

/N 221 NAME: "Lubrication ON" 
M212 
G04 X0.5 

In the above example, 221 is the identification number, Lubrication ON is the name, 
and the two other lines are the actions to perform. 

6.2.3 Adding the New Function in the Code 
In this example we will insert the new function before every punch made with an SQ 
10 tool. 
In the Used Tools dialog, mark the Turret Station holding the SQ10 tool: 

 
 
Click Tool Functions… button and the following dialog will open: 
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Define when you want this function to be used, and click OK button. 
You will be able to see the results of this insertion after you create the NC code – the 
lines of code written in the MDL file now precede each punch made with the SQ 10 
tool: 
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6.3 Tool Clearance 
The following section is for Punch and Combination Machines only. 

The Tool Clearance refers to the clearance between tool and die, with respect of the 
material. 
To access the Clearance settings, go to the Material tab in the Workspace Settings 
dialog and click the Edit Material button. The following window will open: 

 
As you can see, for each material you can define a Minimum, Best and Maximum 
values as percentages of sheet thickness. 
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The values for each material were taken from the Amada charts, but you 
can modify them to comply with the recommendations for your specific 
machine. 

The values for the Clearance are indicated in the Report File, with the @CLEARANCE 
token. 

6.4 Repositioning principles 
Depending on your machine, the table size and the sheet size, your machine will 
have to reposition the clamps when working on a sheet that is longer than the table. 
Another reason to reposition is if you want to place punches in the clamps’ Dead 
Zones. 

Normally, the Post Processor generates Reposition and Head Position 
(during the Reposition) commands automatically, however you can add 
manual repositions from the Reposition and Transformation option of 
the CAM menu. 

6.4.1 Clamp Avoidance 
cncKad permits the user to place parts that are going to be processed in the area of, 
or even beneath, the clamps. This option allows manufacturers that produce grids of 
holes on a complete sheet, or nest multiple parts on a single sheet, to maximize 
sheet utilization by punching in the areas around and beneath the clamps, areas that 
are otherwise not accessible.  
This option is activated automatically, as soon as the user positions a CAM in the 
area of the clamps. During the creation of the NC program, the post processor will 
calculate the reposition data, tool size and Dead Zone data and create a program 
that institutes repositioning as is needed, so as not to damage the clamps. 
 
The number of repositions in a program is determined by several factors: 

• The table size 
• The sheet size 
• The size of the Dead Zone 

If the sheet selected is less than, or equal to, the table size – there will only be one or 
two repositions. If the sheet selected is larger than the table – there will be two or 
more repositions, as needed. 
When a tool was selected (for punching), its Dead Zone is represented on the 
graphic creation screen as a blue rectangle surrounding the clamps.  
While the program does most of the work and calculations for the repositioning, there 
are still some points that the user must take into consideration when using this 
option. Understanding and utilizing these points is crucial to the success of the 
automatic clamp avoidance algorithm, executed by the post processor.  
 
For all machines the basic rules are much the same:  

• The sheet is punched at the origin of the sheet and in the area where the 
clamps will be after the first reposition. Having executed a reposition, the 
program will punch the area where the clamps were before the reposition and 
will continue until the next reposition or to the end of the sheet.  

• The position of a clamp is determined by the distance of its center from the 
left edge of the sheet. 

• The general Dead Zone is determined according to the largest Dead Zone of 
the used tools. 



Punching Manual 

167 

• The minimum sheet size for a machine with two clamps is 3.5 times the Dead 
Zone, and for three clamps – 5.5 times the Dead Zone.  

• Initially, the Post Processor will try to use the clamp positions set by the user, 
but if unsuccessful, the positions will be changed automatically. 

6.4.2 Repositioning Example Tables 
Setting the distances between the clamps is crucial, therefore we will give a few 
examples of machines with two clamps and with three clamps: 

 

 

 

 

6.4.3 Automatic Repositioning for Small Sheets 
As mentioned above, the minimum sheet size for utilizing the automatic Clamp 
Avoidance (for a machine with two clamps) is 3.5 times the Dead Zone. 
For sheets smaller than this, a different strategy is needed. The initial position for 
both clamps is on the right side of the sheet and the left side is processed, and then 
both clamps are moved to the left and then the right side is processed. 
 
This strategy is possible under these restrictions: 

• The combined Dead Zones will cover less than half the sheet (otherwise there 
will be an overlap of Dead Zones after the repositioning). 

• The maximum repositioning movement will be less than the distance from the 
sheet’s right edge to the edge of the Table. 

The following example illustrates these principles: 
Table size – 1250 
Dead Zone – 200 
Sheet size – 600 
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(Automatic Clamp Avoidance not possible: 200x3.5 = 700) 
 
Proposed solution: 
Positioning Clamp 1 Clamp 2 Area processed 
Initial  400 540 0 - 300 
After reposition 60 200 300 - 600 
The reposition in this case will be negative: -340mm. 
It is important to note that the initial position of the clamps is at the user’s discretion – 
they can be placed close together, with a resulting small reposition but loss of sheet 
stability, or they can be far apart (under the above mentioned restrictions), with a 
large reposition but a more stable sheet. 

6.5 Laser Processing Long Parts 
The problem of processing long parts comes up when a contour in the part includes a 
Line entity with an X length larger than the machine’s Working Range: 
 

 
 
The solution is in two stages: 

• Use the Split command, from Edit toolbar, to break up the long Line entities 
into segments smaller than the Working Range.  

In order to make the procedure easier, first place a Help Line where you want to 
create the Splits; the simplest way is to set Snap=Center for the Help Line, and then 
return to Snap=Auto for the Splits: 

 
 

• Process the part’s contour as two Chains, where the Chains begin and end at 
the Splits: 
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It is imperative to be precise about the clicking positions when creating the chains: 
 

 
 
After you go through this procedure, cncKad will be able to insert repositions as 
necessary during the Post Processing. 

This procedure is necessary for all Lines longer than the Working Range. 

6.6 Wilson Wheel Programming in cncKad 
The following topics explain how to use Wilson Wheel tools with cncKad. 

6.6.1 Tools 
The standard tool library supplied with cncKad contains the following Wilson Wheel 
tools: 

• WW01.T - Wilson Rolling Shear 
• WW02.T - Wilson Rolling Rib 
• WW03.T - Wilson Rolling Offset 
• WW04.T - Wilson Rolling Louver 
• WW05.T - Wilson Rolling Pincher 

For use with Fanuc controls they are named this way: 
• WW01 
• WW02 
• WW03 and so on. 

For use with Siemens and Nisshnibo, they look this way: 
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• WW11 
• WW12 
• WW13 and so on. 

Below you can see an example of Rounded Rectangle processing (200mm x 
100mm, R=50mm) with WW12: 

 

6.6.2 Programming 
=+Nibble Entity, Nibble Chain or Nibble Contour. 
Make sure Index=ON (to enable Rotation of the Wheel). 
If you want to work on a "smooth" contour (no sharp corners), for example, Round 
Rectangle, you can use the  
      [ x ] Connect  
so the Wheel stays down from cut to cut. 
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Wheel cutting Speed and Depth can be set for the tool and for individual cuts (if, for 
example, you want to reduce the speed at arcs compared with lines). When adding 
the Wheel in Add Punch dialog, mark the Use Tool Data checkbox and there, on the 
Type Properties tab you will be able to enter Speed and Depth values.  

Checking the Use Tool Data box is a shortcut to Tool Data option of Tool 
Library dialog. 

 
Plunge-In: 
For machines that support Plunge-In, select a line in the contour to be processed and 
split, for example into two halves. Start a cut on one half and finish it on the other. 
Using Edit CAM option, click the half you started cutting from, change to Offset and 
set a Plunge-In distance of, for example 10mm. 

6.6.3 Common Cuts 
When you wish to have Common Cuts for Wheel Tools, simply set the distance 
between Parts (dx or dy or both) to 0.01. 
Then, while running the Post-Processor (NC), make sure that in the last screen 
(Post-Processor Options) the automatic testing of common cuts is checked. 
   [ x ] Automatic testing of common-cuts  

6.6.4 Customization 
Customization for the default values is done in the MDL file. 
However, anytime you use a Wheel on your part, you can set the parameters to suit 
the specific cut. For more information on this issue go to Type Properties section of 
Tools Menu chapter of this manual. 

6.6.4.1 Customization using Functions 
• Function 101 – used to start WW01 
• Function 102 – used to start WW02 
• Function 103 – used to start WW03 
• Function 104 – used to start WW04 
• Function 105 – used to start WW05 
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• Function 99 – used to End all the Wheel Tools 
• Function 100 – Wheel Connect (keep cutting/forming, do NOT lift-up 

Head) 

6.6.4.2 Customization using NCSEC 
• [NCSEC_WW_Start] to start any WW tool (Functions 101 -105 will NOT be 

used) 
• [NCSEC_WW_End] to end any WW tool (Function 99 will NOT be used) 
• [NCSEC_WW_Down] lower the Head to start cutting/forming 
• [NCSEC_WW_Up] lift-up the Head to Stop cutting/forming 

6.6.5 Cutting/Forming Speed 
In the NCSEC or Function for the Wheel Start, normally some Feed command is 
placed, e.g. 

F4000 
This will be the default speed of the Tool. 
Normally, the machine operator will adjust it on the machine (see also the Use Tool 
Data option). 

6.6.6 The Wilson Wheel Section in the MDL file. 
 

[Wilson] 
BaseFuncWilsonStart = 100                 // function 100 is: Continue Wilson (NO 
RAM up) 
;                                                          // function 101 is Wilson Rolling Shear Start 
Commands. 
;                                                          // They are inserted as Tool-Change function 
automatically. 
;                                                                                           // 102 is Rolling Rib Start 
Commands, 
;                                                                                           // 103 is Offset, 
;                                                                                           // 104 Louver 
;                                                                                           // 105 Pincher 
ControlSupportG02G03 = Yes                  // can we use G02 and G03 or we 
have to use  
;                                                                         // Nibble commands 
ShedMaterialTravel = 10                 // When working with WW01 (Rolling Shear 
= Cutting), 
;                                                                  // whenever finishing a cut and Lifting Up 
the Head, a 
;                                                                  // 10mm travel is done to "Shake away" the 
Sheet  
;                                                                  // from the Wheel. 
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6.7 Using Sheet Transformation 

6.7.1 Processing with a Sheet Transformation 
Often the sheet in use extends beyond the machine’s Working Range. When this 
happens in the X range, the solution is to use a Reposition, however when the sheet 
extends over the Y range, the solution is using a Transformation. 
 

• The problem: 
Processing a 2000mm x 1100mm part on an Amada Aries245 (Working Range 
1000x1270): 

 
Note above the arrows marking the sheet’s extension beyond machine's Working 
Range. 
 

• The solution: 

o Click the Reposition and Transformation button -  
o Use the Add button to add a 180° rotation: 

 
o In the Transformations section of the dialog select the Rotation 180° 

entry, and then click the Set CAMs to Current button, to select the parts 
you want to process when the sheet is in this position. For that sake you 
can use any of the standard Selection Methods (Single, Window, etc.). 

o Now you have two Transformations; note that when you click on either of 
them, the CAMs that are defined for it will be highlighted. 

After you generate the NC, you will see that there is a Stop Machine (M00) inserted 
in order to allow rotating the sheet before the machining continues.  

You can also use Sheet Rotation when there is a problem with the 
clamps’ Dead Zones and the sheet is too small for using a Reposition – 
first process away from the clamps, rotate the sheet and process the 
rest. 
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6.7.2 Sheet Transformation with Reposition 
Sheet Transformation can be used in conjunction with Reposition in the following 
way: 
 

• The problem: 
Processing a 2000mm x 1200mm sheet on an Amada Pega344 (Working Range 
1000x1000). 
 

• The solution: 
o Process the bottom 600mm, using Repositions for Clamp Avoidance 

and in order to reach the X=2000 position. 
o Insert a Rotation 180° type Transformation, and process the remainder 

of the sheet. 

6.8 The NC to DFT feature 
This section explains the steps needed to turn a given NC file into a DFT file. 

6.8.1 Preparing the GCD file 
To use the NC to DFT option, some changes must be made to the header of the NC 
– several comment lines with information must be added. 
For example, the original GCD file contained the following lines: 

(AD1-OS) 
G92X1830.00Y1270.00 
G90 
U1 
X24.5Y120.T230 
V1 
G73X763.Y563.Q3W1 
G73Q4W1 
G73Q2W1 
U2 
X92.Y62.T150 
V2 
G73Q3W2 
G73Q4W2 
G73Q2W2 
U3 
G72X46.Y46. 
G66I50.J270.P-30.Q-80.T237 
V3 
G73Q3W3 
G73Q4W3 
G73Q2W3 
G50 

 To use this option, the following lines (marked with the asterisk) have to be added: 
(AD1-OS) 
(*MODEL PEGA357 58I) 
(*SHEET 750.0 550.0 1.0) 
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(*CLAMPS 290.0 440.0) 
(*T230 RO 10) 
(*T150 RO 20) 
(*T237 RE 80 30) 
G92X1830.00Y1270.00 
G90 
U1 
X24.5Y120.T230 
V1 
G73X763.Y563.Q3W1 
G73Q4W1 
G73Q2W1 
U2 
X92.Y62.T150 
V2 
G73Q3W2 
G73Q4W2 
G73Q2W2 
U3 
G72X46.Y46. 
G66I50.J270.P-30.Q-80.T237 
V3 
G73Q3W3 
G73Q4W3 
G73Q2W3 
G50 

In this case, the comment lines are added after the first line, the one with the Part 
Name. They contain information about the Sheet size, Clamps position, and Tools. 
If the customer uses a Standard Setup, then a Setup file can be created as explained 
later on. 
These new comment lines can be stored in a file, for example in HDR.PNC . 
In such a case, the steps to prepare the GCD file are as follow: 

1. Open Metalix Editor. 
2. Open HDR.PNC 
3. Mark all the lines and select Edit => Copy (or Ctrl+C) 
4. Open the GCD file. 
5. Place the cursor at the start of the second line (following the Part Name) 
6. Select Edit => Paste (or Ctrl+V) 
7. Correct Sheet Size, Clamps, and Tools if needed. 
8. Use File => Save As with the same name, but with extension .PNC 

6.8.2 Loading the prepared NC file 
Open any part in cncKad, click NC icon in order to generate an NC File, and then go 
to the Simulation program. There select File => Open, and load the .PNC file you 
prepared just before. 
You will be able to see the Part on the Graphic Simulation screen, Run it slowly or 
Line by Line (Line=ON). It is also possible to make manual corrections to the NC 
file, and see and verify them immediately in the Graphic Simulation window. 
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After making changes to any line, remember to press Enter key in order to 
confirm the change. 

6.8.3 Creating a drawing (DFT) 
After finishing the steps described above, you can select File => NC to DFT option in 
the Simulation program. This will generate a Drawing with the CAMs already in 
place! 
Now you can close the Simulation, return to the main cncKad screen, and use File 
=> Open Part to load the newly created DFT file. 

Note that the generated DFT will normally NOT have a valid geometry, 
therefore it is recommended that you correct it manually. 

6.8.4 Creating a Setup file 
In cncKad go to Tools => Turret Setups and create your standard Setup File, for 
example: 

PEGA357.PET 
For more information on Setup file including the procedure of creating a new Setup 
and editing an existing one, see the appropriate sections of Tools Menu chapter of 
this manual. 
In order to use a Setup file, you must add the following lines (marked with asterisk) in 
your HDR.PNC file: 
 

(*MODEL PEGA357 58I) 
(*SHEET 750.0 550.0 1.0) 
(*CLAMPS 290.0 440.0) 
(*SETUP PEGA357.PET) 
 

You must also remove the T lines (the lines that specify Tools). 
If for Part processing the Tools are being used ONLY from the Setup, then adding 
these 4 lines is all you need to do. However if tools for Part processing are being 
used both from the Setup, AND a few tools NOT from the Setup ("Non-Standard 
Tools"), you should add the T lines only for the "Non-Standard Tools". 
For example, the following tools are being used to process the Part: 
RO 6.5 
RO 4 
SQ 12.7 
OB 32 8 90 
RE 50 5 
RE 50 5 90 
 
And from among them, only the OB is "Non-Standard Tool". So in this case your NC 
header will look this way: 

(*MODEL PEGA357 58I) 
(*SHEET 750.0 550.0 1.0) 
(*CLAMPS 290.0 440.0)  
(*SETUP PEGA357.PET) 
(*T303 OB 32 8 90) 
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6.9 Laser Common Cuts 
The Laser Common Cut feature is being used to process the edges of two adjoining 
parts with the same cut; instead of cutting each part individually, the following 
procedure is implemented: 

o When a part is being processed, cncKad checks if any juncture on the 
part’s contour is also the starting point for a future cut – one for cutting 
the contour of an adjoining part.  

o When cncKad prepares to cut this adjoining part, it begins from the 
Preparatory Cut (using an Overlap, to create a smooth transition), made in 
the direction of the future cut, thus avoiding the need to pierce the sheet 
again.  

The advantages of using this method are: 
• Reduced machining time. 
• Savings in cutting \gas and wearing of parts. 
• Reduced material wastage.  
 

Using Laser Common Cuts  is recommended in the following cases: 
• Parts with long, straight contours. 
• Parts cut from thick sheets, where the cutting speed is low. 
• Parts with contours that will be vaporized, as these require two passes, 

resulting in a double reduction of machining time and gas. 

6.9.1 Preparing a Geometry for Common Cut 
In order to use Laser Common Cut on geometry, it is compulsory to prepare 
geometry particularly for it, first; there are two options of doing this: 

• Array a part (using the Part Array option from Transform menu) with the dX 
and dY distances set at Beam diameter (see the Example below). 

• Load parts into a Nest in Auto Nest, set the Buffer size at half the Beam 
diameter (e.g. for a Beam with a 0.2 diameter use a 0.1 Buffer), and then 
send the entire Nest to cncKad as a DFT file. 

6.9.2 Preparatory Cut 
In the Auto Cut dialog, on Auto Cut tab mark the Perform checkbox and click the 
Settings button, like shown below. The Common Cut Parameters dialog will open: 

 
From this dialog you can set the parameters governing this option:  

• Preparatory (Cut Length) – in order to minimize the need of piercing, the 
Post Processor will create a Preparatory Cut in the positions where a new 
cut will start.  
The example below shows how the bottom-left part will be cut: 
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Notice the enlarged sections – when arriving at the middle juncture, the cutting is 
extended upwards and to the right, to prepare for cutting the bottom-right and top-
right parts. The same action is being taken at the bottom juncture. 

• Overlap – this is the distance from the end of the Preparatory Cut, to where 
the actual cutting will start when processing will resume on the adjoining 
parts. 

6.9.3 Example 
This feature can only be used on complete geometries, where the distance between 
parts has been set to the Beam Diameter.  
In this example we will make an Array of the following part: 

 
To array the part we will use the Part Array option from Transform menu. After 
choosing it, click the contour of the part; the entire part will be highlighted in blue 
color. Press Enter key in order to confirm the selection. As soon as you do so, the 
following dialog will open: 
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Fill out the parameters definitions as shown above; note that in the Distance Between 
Parts section, dX and dY are both set to 0.2, which is the Beam diameter value. 
Click the OK button, and the part will be arrayed on the sheet according to the above 
definitions: 

 
Now it is time to process the sheet; click the Auto Cut button. When the following 
dialog will open, select the Auto Cut tab: 
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In this tab, select the Perform checkbox in the Common Cut section, and click the 
Settings button. After doing so, the Common Cut Parameters dialog will open. Enter 
the settings you desire, and click OK button.  
Now go to the Laser Optimization tab and set the path Between Parts as either 
Snake X or Snake Y: 

 
When you have finished, click the Run button. The entire sheet will be processed, 
including the inner contours of the arrayed part. If you don't want to process the inner 
contours, you should check the Only contours to be selected option on the Auto 
Cut tab. 
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Use the Ctrl+B key shortcut (or View => Full Cut Tool Width) for switching the 
Beam’s width on and off, to make sure the cuts are processing the arrayed part 
correctly. 
In order to view the effect of using the Common Cut function on the actual 
processing, we will use the cncKad’s Simulation program. To do that – generate NC 
for the part, and then go to the Simulation window. 
Run the Simulation, and Pause after the contours of the first part have been 
processed. Zoom onto the intersections with the adjoining parts, and note the 
Preparatory Cuts. 

6.10 Additional Options in cncKad's Machine files 

6.10.1 Additions in the MDL file 
These changes have been introduced from cncKad version 6.41: 

6.10.1.1 New MDL Keys 
• NCUnitsMode = ? with values as follow: 

o 0 – Use DFT units 
o 1 – Always generate mm 
o 2 – Always generate Inch 

• MPCornerMode = ? with values as follow: 
o 0 – Q1 is at bottom-left, and Dy is positive 
o 1 – Q1 is at top-left, and Dy is negative 

• AssignStationsMode = ? with values as follow: 
o 0 – Allow smaller tools into bigger stations 
o 1 – Each tool size MUST fit the Station Size 

• [SendToDiskette] 
o CreateFolderIfNeeded = No      // if Yes, the Target Folder will be 

created, if does not exist. 
o AskForConfirmation = No          // if Yes, user is asked to confirm 

copying 
o CopyNCReportToo = No                 // if Yes, the NC Report file (if exists) 

is copied to the same destination as NC. 

6.10.1.2 Functions have moved to MDL files 
Functions Names are now specified in the MDL, and each MDL file contains only 
those functions that belong to specific machine: 

... 
N 0 BEGIN 
/N 1 NAME: "0.5 SEC DELAY" 
G04 X0.5 
/N 2 NAME: "1.0 SEC DELAY" 
G04 X1. 
/N 3 NAME: "2.0 SEC DELAY" 
G04 X2. 
/N 4 NAME: "5.0 SEC DELAY" 
G04 X5. 
/N 5 NAME: "LOW SPEED" 
F4 
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/N 6 NAME: "MEDIUM SPEED" 
F3 
/N 7 NAME: "HIGH SPEED" 
F2 
/N 8 NAME: "MAXIMUM SPEED" 
F1 
/N 9 NAME: "OPTIONAL STOP" 
M01 
... 

6.10.1.3 Functions can be used as Pre-Macro or Post-Macro 
 
/N 1082 #S! NAME: "M82 Macro Only" 
M82 
/N 1083 #S! NAME: "M83 Macro Only" 
M83 

If "M82 Macro Only" is used as Pre-Tool, and "M83 Macro Only" is used as Post-Tool 
and for example, U3-V3 is the Macro for that Tool, you will get: 

M82 
U2 
…. 
V2 
G76 W2 Q1 
M83 

6.10.1.4 Delete comments from NC 
Some machines do not accept the comments that appear between brackets in the 
NC code. In the MDL file, you can set the deletion of these comments as they are 
sent to a diskette. 
All the following fields can be copied from the Example Model File (Examp.mdl) 
situated in the Machines folder, if they are not already existent in the MDL file: 
In your machine’s MDL file, go to the section [SendToDiskette]  
and add New Key =  
Enter: Remove Comments = Yes  
           CopySrc2Trg = Yes 
You can define the Target Extension as you wish, for example: trgext = nc  

If the NC code is modified in the Simulation screen, that change will be 
automatically updated to the .nc file. 

6.10.2 Run Out in cncKad 
A Run Out means that the Turret never passes over a Clamp. This result is achieved 
in the following way: 
When the Turret approaches a Clamp, the Sheet moves away in Y, bypasses the 
Clamp in X and then comes back in Y: 
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To define a Run Out you must edit the machine’s MDL file, in the section called 
General Info.  
There are 3 key values to consider:  

… 
[General Info] 
RunOutRequired = No  
YExtraForRunOut = 0  
MinYForRunOut = 0  
… 

• RunOutRequired – choose Yes or No to use a Run Out option. 
• YExtraForRunOut – when using the Run Out option, this value (in mm) will 

be added to the Dead Zone as defined in the Turret file. 
• MinYForRunOu – this defines the minimum value (in mm) for the Run Out, 

even when the Dead Zone + YExtraForRunOut are less than this value. 

If you are using Inches as your System Units, you must still define the 
values in mm; these will be automatically converted by cncKad. 

For Example for the following definitions: 
… 
[General Info] 
RunOutRequired = Yes  
YExtraForRunOut = 40  
MinYForRunOut = 200  
… 

The result will be that a Run Out will always be used, with a value of 200mm (~ 7.9") 
or Dead Zone + 40 (~ 1.6"), whichever is greater. 

6.10.3 Support for very big arcs 
When the NC codes for generating Arcs contain Angles, we can have an accuracy 
problem when the Arc Radius is very big. 
This happens in all FANUC controlled machines (Amada, Murata, FinnPower, LVD, 
and more) and in some other controls as well. 
The accuracy problem is now resolved automatically by adding the following Keys 
into the MDL file: 
[NC_GENERATION] 
ArcNCByAngles=Yes       // supported from V8.0: correct NC 

for very big Arcs 
AnglePrecision= 0.01 

6.10.4 Additions in the TRT files 
For Round Only stations, it is now possible to set:  

• 0 – Any Shape 
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• 1 – Only Rounds 
• 90 – Used for an Auto Index station; allows rotating the index station only at 

90 degrees 
For more information on these features see the Edit Turret section on Tool Menu 
chapter of this manual. 

6.10.5 Support for Program Origin 
To enable/disable support for Program Origin, do the following: 

• Set the following two Keys in the machine MDL files [Machine 
Info]section: 

• SetOriginEnable = ? with values as follow: 
o 0 – disable, 
o 1 – enable, but default is false,  
o 2 – enable 

• InitialOffset = ? with values as follow for the initial point: 
o 0 – Top-Left Origin, i.e. (0, Sheet Y size) 
o 1 – Bottom-Left Origin, i.e. (0, 0) 
o 2 – Bottom-Right Origin, i.e. (Sheet X size, 0)  
o 3 – Top-Right Origin, i.e. (Sheet X size, Sheet Y size)  

 
The program uses for the latter mentioned Key: 

• Incremental programming – used to set the Initial Head Position. 
• Absolute programming – used to set the Machine Offset. 

 
• In the DIR_xxx.HDR file change the SHEET directive as follows: 

(*SHEET @SHTX @SHTY @THK @MATNUMBER @START_CORNER 
      @X_START_CORNER @Y_START_CORNER) 

cncKad will change its coordinates according to new program origin. 

6.10.6 MDLX per machine file 
Some of the functions defined in the MDL file have been moved to a file with MDLX 
extension –this file is also per machine, and it includes all the machine parameters 
that are editable via cncKad. 

6.11 Inches users upgrading from previous versions to 7.xx 
The following information is intended for cncKad users who are upgrading 

to version 7.xx from a previous one. 
For customers who are using more than one System Units set (mm / Inch): you 
must make sure that the following values are correct: 

6.11.1 Values that are per Working Unit 
These parameters are defined for each Working Unit, and in order for cncKad to 
function properly, they must be set separately for each one of them in the Settings 
=> Workspace Settings => Working Defaults tab: 

• Decimal Digits  
• Bulge 
• Tolerance  
• Angle Tolerance 
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You only must set these values once for Working Unit; thereafter the 

values are saved by cncKad. 

6.11.2 Values translated when switching between Working Units 
Each time you switch from one Working Unit to another, some values are being 
"translated" – multiplied or divided by the mm-to-inch ratio. Therefore every time you 
make the switch, you should go over these values to make sure they have been 
translated correctly: 

• In the Settings => Workspace Settings dialog: 
o Material tab – Default Material => Sheet Thickness. 
o Display tab – Text Size and Arrow Size. 

• In the Settings => Machine Settings dialog: 
o Cutting Parameters tab (for Laser machine users): 

~ Tool Offsets defaults – Start and End. 
~ Entry Length. 
~ Exit Length. 

o Auto tab – Auto Processing => Min Part Size. 
o Machine tab – Sheet and Part parameters. 

• In the Auto Punch dialog (for Punch machine users): 
o In the Auto Punch Parameters tab –   

~ Tool spacing defaults – Minimum tool overlap and Scallop for round 
tools. 
~ Cutting tools restrictions – Minimum and Maximum Widths. 
~ Notches – Minimum and Maximum Offsets . 

o In the Holes tab: 
~ Crunch Holes up to – Width and Length. 
~ Wire Joint – Width and Place Every. 

• Common Cut Parameters (for Laser machine users) –  Auto Cut => Auto Cut 
tab => Common Cut section => Settings button => Preparatory and 
Overlap parameters. 

6.12 cncKad V.8’s new Material List 
This section is meant for laser cutting machines. It describes how to start working 
with the New Material List, being used in version 8.0 and higher ones: 

This section is intended only for those users, who have upgraded to version 
8 (and higher) from previous versions. 

6.12.1 Introduction 
Beginning with version 8.0, cncKad will be using a new format for its Material List – 
where in previous versions there were 15, 20, or even more materials, now there will 
usually be 5-10.  
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This is because in the past, the list contained the same materials, but with different 
Gas, Head or Lens definitions. e.g.: 

  
In this example the same material is defined twice – once for cutting with Oxygen, 
and once with Nitrogen. In the new list, for each Material the Gas, Head and Lens 
definitions can be selected separately; this means a shorter list, but much more 
flexibility. 
In order to use the new list you will need to create a Conversion Table, that will 
allow cncKad to select the correct material from the new list, when you will open a 
part created in a previous version (and therefore having an old material defined for 
it). 
The conversion process, described on the successive pages, is done when you open 
cncKad for the first time, after installing the new version. But can still change the 
conversion settings at any time. For more information on how to do this go to 
Changing the Conversion Definitions section of this chapter. 
The scheme of converting materials looks this way: 

 
When you open cncKad, after the installation completes, a window will open giving 
you the option to convert your old list to the new format: 

 
We highly recommend going through with the conversion process. If you are 
dissatisfied with the results, you can always return to using the old list at any time. 

If you are not interested in converting your old list, check the Don’t show 
this message again option and click the Cancel button. 

To start the conversion, click the Take me to the materials conversion wizard 
button. The following message will appear:  
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Click OK and the Conversion Wizard will open. 
The conversion consists of two stages: 

• Choosing the Materials List for the new list. 
• Converting materials using the Materials Conversion Table. 

6.12.2 Laser Technology Material List 
When the Conversion Wizard opens for the first time, the first dialog you will see is 
the Laser Technology Material List. Each material shown in this list has its own laser 
technology table. 

 
If this list is not extensive enough for your use, simply add other materials. 
In order to move to the next step, click Next button. 

6.12.3 Material Lists 
Now you will see two Material Lists: a long one, containing the materials used in your 
previous version of cncKad: 



cncKad 

188 

 
 
and a new, short one, consisting of just five default materials: 

 
The user chooses which of the lists he wants to be used as a New Material List. In 
order to confirm your choice and move on to the Materials Conversion stage, click 
Next button. 
If this list is not extensive enough for your use, you can simply add other materials. 

6.12.3.1 Adding Materials to Lists 
The instructions given in this section apply for adding materials both to Laser 
Technology Material List as well as to Material Lists.  
Click the Add Material button. The following dialog will appear: 

  
 
Enter the new material’s name and select the base Material Type for it: 
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This Material Type will be used to set the initial attributes for the new material – 
Tonnage, Density, Clearance, etc., so you should select the Type, that resembles the 
new material the most. 
For example, when adding Copper to the list, you will probably select Aluminum as 
the base Type: 

 
 
As a result, Copper will be added to the list with Aluminum’s attributes: 

• In Laser Technology Material List: 

 
 

• In Material List: 

 
You can now change the attributes, so that they reflect Copper’s true nature – click 
inside a table cell and enter the correct value. 
Click Next to continue. 

6.12.4 Materials Conversion Table  
This table tells cncKad how to treat materials from the old list. This means that when 
you open an old file, it stands to reason it will have an old material defined for it; this 
table tells cncKad which new Material, Gas, Head and Lens to select for it instead. 



cncKad 

190 

6.12.4.1 Selecting a New Material for the Old one 
To start material conversion, mark the Use New Materials List checkbox at the top 
of the dialog. Now, for each Old Material, select a New Material from the dropdown 
list: 

 
If you anyways want your new material list to look like the old one, don't 

check the Use New Materials List option. The materials will be 
automatically copied from one column to another. 

After selecting a New Material, you can also change the definitions for Gas, Head 
and Lens, like shown below: 
Selecting a Gas: Selecting a Head: Selecting a Lens:  

 
  

After defining a new materials for all the old ones (you cannot continue unless all 
materials are defined), click the Finish button to create the Conversion Table. 

6.12.4.2 Use for conversion 
When you enable this option, cncKad reads the Laser Technology Material List and 
looks for which material there are no assignments. When it finds such, then 
automatically it marks it with "V". The selected material will replace the standard 
cutting definitions with the ones from the Old Material List. 



Punching Manual 

191 

For example, the first time you select Stainless as the New Material this option will be 
checked automatically, if the new material does not have cutting data in the laser 
technology cutting table, but it will not be checked for subsequent selections of 
Stainless (or if there is already an entry for it within the table). 
This is an useful feature for experienced users who have calibrated their old laser 
cutting tables and know the specific parameters needed for them. 

This option will be used only if the Convert old laser table for selected 
materials checkbox is selected.  

6.12.4.3 Convert old laser table for selected materials  
When this checkbox is selected next to some materials, cncKad knows that it should 
take all the data from the old (pre-existing) version with all the cutting parameters and 
copy it to the new table. When this checkbox is unselected the cncKad will use the 
defaults supplied with the software system. 

This will be done only for those materials, where the Use for conversion 
option is selected.  

6.12.4.4 Using the new list 
After the conversion is complete, cncKad will open and you from now on you will be 
able to use the new material list. Go to Sheet tab of Set Sheet and Clamps dialog 
and see the dropdown Material List: 

 
See the picture shown below.  
In the Technology Parameters section you will see other material definitions like 
Gas, Head and Lens and from dropdown lists will be able to choose various options 
for them, if it will be possible.   
In the Technology Table section you will see the laser technology parameters for 
your settings or material type and sheet thickness. Notice that in our example data 
displayed here differs from the settings entered in above Sheet Thickness field. This 
is because in the Laser Technology Table there is no such thickness for this material 
type. So it offers you the closest value existing in the table for this material. 
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Now, when you'll go to the Laser Technology Table you will see that thickness 
presented here is the same as in Technology Table section of Sheet tab, presented 
above. However in the bottom part of the dialog you will see the actual Sheet 
Parameters displayed in blue color. 

 

6.12.5 Changing the Conversion Definitions 
You can change the conversion settings at any time, by going to the Settings => 
Workspace Settings => Material tab and clicking the Convert Materials button. 
This will re-open the Conversion Wizard, and you will be able to re-define the 
conversions. 
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You can also use this to return to using the old List, but there really is no point of 
doing this – if you take the time to do the Conversion correctly, you will get your old 
data integrated into the new list. 

This action is not recommended. 
To return to using the old materials List: 

1. Open the Wizard as mentioned above 
2. Click the Next button 
3. Unselect the Use New Materials List checkbox and click the Finish button. 

In this Material tab you can also Edit Materials as well as Edit Laser Technology 
Materials, by clicking on the appropriate buttons. When you do, you will be directed 
correspondingly to and to Material List or to Laser Technology Material List. You can 
add new materials here, as well as edit their parameters, if applicable. 

6.13 The cncKad Service Pack 
The cncKad Service Pack is an application that updates cncKad installations 
(seats) with the latest versions of program files. These updated versions may include 
new features, fixes for bugs, etc. 

6.13.1 Installing the cncKad Service Pack 
To use the Service Pack for updating cncKad you need to do two things: 

• Place the Service Pack application on a local/network drive. 
• Set cncKad to use this application for updating. 

For the first of these, we recommend saving the application to a dedicated directory 
on the PC or on the server, as shown in the examples presented below. 
After saving the Service Pack to this directory, do the following: 
Open cncKad, go to Settings => Workspace Settings and select the Live Update 
tab: 

 

Mark the Check for Updates checkbox, and then click the  button for browsing 
to the Service Pack’s directory: 
If this directory is on local PC, searching it might look this way: 
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If the directory is on a network drive, then the browsing may give the following result 
(depending on the drive letter): 

 
Regardless the Service Pack’s directory location, its path will be shown in the 
Downloads' Directory field: 

 
After making sure that the path is correct, do not forget to click the OK button, to 
confirm activating the Update feature. 
Thereafter, each time cncKad is opened, it will check for updates and install them 
when appropriate. 

6.13.2 Working with networked seats 
When there are several cncKad seats working together on a network, we 
recommend saving a single copy of the Service Pack on a network drive, and then 
following the procedure described above for each of the seats. 
There is no need for each seat to save an individual copy of the Service Pack – they 
all can use the same one! This will ensure that all the seats are updated to the same 
version, and will also protect against cross-version compatibility issues. 

If there is a Firewall protecting the network, it must be set to allow the 
cncKad seats to access the Service Pack’s directory. 

6.14 The cncKad Update Manager 
This section gives explanations about cncKad’s Update Manager. 

6.14.1 What is the Update Manager 
The cncKad Update Manager is an application that allows your workstation to keep 
up with the most recent updates released for cncKad. This is done by downloading 
updates from the cncKad website and installing them to the local workstation(s). 
Likewise it was for Service Pack installation, here there are also two basic 
configurations for working with the Update Manager: 

• Local – this configuration is straightforward – a single workstation runs the 
Update Manager and applies the updates. 
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• Network – this configuration is more complex – one workstation runs the 
Update Manager, but the updates are downloaded from the website to a 
network directory, and cncKad gets the update from this directory for each 
workstation connected on a network. 

The diagram below explains this process: 

 

6.14.2 Installing the Update Manager 
After starting the cncKad Update Manager installation you will get the following 
window: 
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Here you will see the default installation directory. If you want to install Update 
Manager elsewhere, click the Change button and choose a different location.  

You must install Update Manager on a computer that has an internet 
connection. 

Click the Next button, and you will be presented with the following window: 

 
Select the Yes, I want to launch Update Manager2006 now checkbox, click the 
Finish button and the Update Manager will open. 

6.14.3 Configuring the Update Manager 
These are the three stages to configuring your Update Manager: 

• Selecting a download path 
• Entering a Customer ID 
• Setting the update check interval 

6.14.3.1 Selecting a download path 
When the Update Manager opens for the first time, you will be asked to select a 
location for storing the updates after downloading them: 
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At this point you must decide if this is a local or network configuration (as explained 
above): 

• Local – select a local directory, e.g. C:\cncKad\SP 
• Network – select a network directory. 

For this example we will choose a network configuration, and select the folder 
F:\cncKad\Update Manager:  

 
It is compulsory that this directory can be accessed from all the computers 

connected to the network; otherwise they will NOT receive the updates! 
Click the OK button and the directory path will be shown on the display, as marked 
on the picture below. You can change this path at any time from this dialog.  
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After confirming the path, a new window will open, asking if we want to check for 
updates now:  

 
At this point choose No, because in order to download updates you must have valid 
Customer ID for your Update Manager.  

6.14.3.2 Entering a Customer ID 
If you try getting updates without first entering a Customer ID, you will receive the 
following message: 

 
In order to enter your Customer ID, click the Settings… button, and when the dialog 
shown below will appear, type-in the ID number and click OK. 

 

6.14.3.3 Setting the update check interval 
In the main window you can set the interval for checking if there are updates: 

 
There are several options for this interval: 
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• Automatic checks – you can specify the frequency of checking for updates 
from one of two options – weekly or daily:  

  
When choosing this option, in the top of the dialog you will see when the Last 
Update Check was done and when the next one is scheduled for. 

 
• Manual checks – in this case a check for updates will be performed only 

when you click the Check for updates now button. 

6.14.4 Configuring the cncKad workstation 
The following configuration must be done for every workstation. 

In cncKad, go to the Settings => Workspace Settings => Live Update tab.  
To receive updates, do the following: 

• Select the Check for Updates option.  
• Browse to the directory in which the program will be looking for updates; this 

will be the directory selected as the destination for downloading the updates 
(in our example this is: F:\cncKad\Update Manager): 

 
The next time when you open cncKad, the Update Manager will check for the 
updates and if it finds any, the following message will appear: 

 
When you click OK button, the updates will be automatically installed on your 
computer, and cncKad will open. 

6.15 Configuring your system to send Problem Report 
In order to send Problem Reports, your Windows system must have email capability 
and be configured to send emails.  
The email capability issue depends on the specific conditions at your workstation 
(e.g. whether the PC is networked, if it is behind a firewall, etc.). If you are not sure, 
consult your System Administrator. 
To configure your Windows system in order to send Problem Reports files, do the 
following: 
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6.15.1 Open the Control Panel 
The procedure to open the Control Panel varies, depending on the Windows version 
you are using.  

• For Win98\ME: 
Go to Start => Settings =>Control Panel 

• For Win2000: 
Go to Start => Settings =>Control Panel 

• For WinXP: 
Go to Start => Control Panel (or Start => Settings =>Control Panel 
depending on which type of View you have chosen for the Start menu) 

6.15.2 Open the Internet Options dialog 
From the Control Panel, select the Internet Options icon: 

 
You can also open the Internet Explorer and select this option from the Tools 
menu: 

 

6.15.3 Select a default application 
In the Internet Options dialog, go to the Programs tab: 
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Use the E-mail dropdown menu to select the program you would like to handle your 
outgoing email massages:  

 
Don’t forget to click the OK button to confirm your selection. 
More information on Sending Problem Report you will find in the Help Menu 
section of Introduction chapter of Drafting and Nesting Manual. 

6.16 Multiple Parts with Reposition 
 

• The Problem: 
When working with Multiple Parts on a sheet bigger then the working range, as 
illustrated on the example below, you encounter the following problem: 
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There are 8 columns of parts on the sheet. Suppose you will process the first 3 
columns, make a reposition, and then process the remaining 5 columns. 
While processing the last 5 columns, the first 3 columns are on MicroJoints – so 
they can easily get disconnected. 
 

• The Solution: 
Lay out the sheet the normal way, including Common Cuts. Alter the DFT file into 
nest, using the command Convert to Nest from File menu. As a result you will get a 
NST file laid out identically to your Multiparts on DFT.  
Now from Nest menu choose the command Split Array. Click the cursor anywhere 
on the array. The parts in the nest will be highlighted with red color, and the following 
window will appear: 

 
For our example change the number of columns to 2, set distance between arrays to 
30mm and check the option Perform 'Cut Sheet' between arrays. The number of 
new columns in new array should be the number of parts overhanging the table 
range. Confirm your choice, clicking OK button. You will get the following result: 
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Go to Used Tools dialog and move the separating tool (the one whose sequence is 
99) to the first position in the table. We want it to be the first tool to work AFTER the 
Reposition. Confirm your settings with OK button. Next generate NC. 
When the simulation module window will open, watch the punching sequence in the 
Graphical Simulator: 

1. The first two columns are being punched. 
2. Reposition is being made. 

Pay attention to how the clamps are holding the sheet after repositioning. 
The left one should be on the right side of the Cut Sheet. 

3. The Sheet is cut off and the machine stopped for the operator to remove the 
first two columns. 

4. The last six columns are being punched. 

6.17 Punching a Perforated Sheet in cncKad 
The problem with perforated sheets is that when we try punching them, we often find 
that the material distorts, gaining a convex shape. This is dangerous and can cause 
a collision with the turret.  
The solution is to avoid punching contiguous lines of the perforation, as described 
further in this section. 

6.17.1 Creating a Perforated Sheet 
Generally, you can get a perforated sheet in two ways: 

• Importing a part into cncKad, e.g. as a DXF file. 
If you have imported the part, go directly to the Punching a Perforated Sheet 
section. 

• Creating one in cncKad. 
If you want to create a part, continue in this section. 
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6.17.1.1 Sheet Dimensions 
Start a regular part and give it the outer dimensions of your sheet. In our example the 
sheet sizes are: 1000 x 700: 

 

6.17.1.2 Perforating the Sheet 
Go to Draw => Shapes => Punched Sheet and define the perforation like shown 
below: 

 
After clicking OK button, the sheet (or part’s inner contour), will be filled with round 
holes. See the example presented below. 

If the Hole Diameter definition does not match any of the tools in your 
Library, you will be asked to add this tool. 
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6.17.1.3 Perforated Sheet example 
The result is: 

6.17.2 Punching a Perforated Sheet 
If the perforated sheet was created with the Punched Sheet feature, go directly to 
the Optimizing the Path section, since the sheet is already punched. 
If our sheet was imported, we will punch it now using Auto Punch feature, and then 
we will set a specific Optimization Path for this punching.   

6.17.2.1 Using Auto Punch 
Open the Auto Punch dialog and go to the Holes tab. There in the Automatic 
Detection section, select the Automatically detect lines of single punches option: 

 
Then click the Auto button to punch the part. 

6.17.2.2 Optimizing the Path 
Open the Used Tools dialog, find the tool you used for the perforation (in our 
example: RO 25) and click the Optimize Path cell for this line: 

 
The Tool Data dialog will open on the Optimization Strategy tab. 
Select the Tool-specific optimization option, and then proceed to define the 
optimization: 

• Starting Corner – use the setting you usually use. 
• Optimization Path – select Snake X. 
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• Cooling distance – this will define the distance between the snake’s 
“curves”, or in our case – how many rows to jump between passes. 

For this example we will use a Cooling Distance of 100: 

 
After clicking OK to confirm these settings, note that the Optimize Path column cell 
shows now the Snake X pictogram: 

 

6.17.3 Testing the Optimization 
Generate NC and run the Simulation. 

You may want to use the Line = On option to follow the optimization path. 
We highlighted the specific lines being punched in each “curve” of the snake: 
First pass – Lines 1, 7, 13 and 19: 

 

Second pass – Lines 2, 8, 14, and 20: 

 
 Third pass – Lines 3, 9, 15, and 21: 

 

Fourth pass – Lines 4, 10, 16, and 22: 
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Fifth pass – Lines 5, 11, 17, and 23: 

 

The last pass takes care of the rest of the lines: 

 

6.18 Installing and Using the NetHASP 
The NetHASP enables networked workstations to use a single HASP hard lock key 
in a floating license configuration.  
We should distinguish between two types of PCs: 

• The License PC – this is the PC where the NetHASP is installed. 
• Workstations – these are the PCs running cncKad. 

6.18.1 Installing the NetHASP on the License PC 
Plug-in the NetHASP Key to a PC, which will be your License PC.  
It is recommended to connect the NetHASP Key on the system server but you can 
also connect it on a different PC that does not have cncKad on it; it is compulsory 
to make sure that this PC is always on and connected to the network!  

The License PC cannot run cncKad. 

6.18.1.1 Installing the NetHASP utilities 
To install these utilities, insert the cncKad installation CD and click the Net HASP 
button. 
The utilities that will be installed are: 

• License Manager (lmsetup.exe): 
This application enables other PCs on the network to work with the NetHASP 
on the server.  
If this application is not running, you won’t be able to run cncKad on any 
computer. 

• Aladdin’s Monitor (aksmon32.exe): 
You may run this application if you want to know, which PCs are currently 
using the NetHASP. 

6.18.2 Using workstations with the NetHASP 
If cncKad is already installed, simply disconnect the Metalix Keys (Time Keys or any 
other Key), and run cncKad. Otherwise, install cncKad and start working with it. 

6.18.2.1 Setting the NetHASP.ini file 
For faster operation over the network, it is recommended to set parameters in 
nethasp.ini on each workstation running cncKad. 
First, you need to know the IP address of the License PC:  
To obtain the IP address: 

1. Go to the License PC. 
2. Click Start => Run and type cmd. 
3. In the command line type ipconfig and press Enter. 

You should get something like this:  
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The second line is the IP address (in the above case 216.70.53.141). 
The NetHASP.ini file should be located in the cncKad folder (where the gkadw.exe 
file is located), for example:  

C:\Metalix\cnckad2006.80  
Double-click this file to open it, and modify it as shown below.  
The important key is: 

[NH_TCPIP] 
;;NH_SERVER_ADDR = xx.xx.xx.xx; 

• First, you must delete the ";;" signs from the beginning of the line. 
• Next, instead of the xx.xx.xx.xx  type the IP address of the License PC, 

e.g.: 
[NH_TCPIP] 
NH_SERVER_ADDR = 216.70.53.141; 

• Save the file and you are done – close the file and open cncKad. 
• Remember to do this on all the PCs running cncKad! 

6.18.3 HASP FAQ 
These are the common questions regarding using the NetHASP.  

6.18.3.1 What is Error 129? 
When you get this message, this means that: 

• No plug is connected to the PC and License Manager was found. 
• The PC, where the License Manager is running, is connected to a non 

NetHASP plug (like time or memo). 
How to solve it: 

• Replace the non NetHASP key with a NetHASP key on the computer where 
the License Manager is running. 

• Use NetHASP.ini file.  

6.18.3.2 “Cannot run cncKad with NetHASP connected directly.”  
If this message appears when running cncKad, then there are two options: 

• NetHASP is connected to the computer. 
• HASP driver 5.12 is not installed. 

How to solve it: 
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• Use local key (memo/ time) or use NetHASP on a different computer with 
License Manager. 

• Install HASP driver 5.12.  

6.18.4 How do I know on which computer the License Manager is 
running? 

Run Aladdin’s Monitor – it will show you exactly which stations are running a 
License Manager.  

6.19 Creating a Trimmed Sheet 
This section explains how to create a Trimmed Sheet in cncKad. 

6.19.1 Why Trim a Sheet 
Trimming a sheet is very useful for those cases where the skeletonized sheet may 
cause a crash with the turret. 
The basic principle is to process the sheet in a way that allows the removal of each 
individual part after it has been severed from the sheet. This removal can be done 
through a Chute, or manually, but the important issue is that the parts are not left on 
the table to rattle around. 
For this example we will use the following parameters: 

• Part Size: 300 x 200 
• Sheet Size: 2000 x 1000  
• Cutting Tool: RE 65 5 (in an AutoIndex Station)  
• Machine Working Range: At least 2000 in X 

All sizes are in mm. 

6.19.2 Creating the initial part 
Create the geometry and punch the holes, using the above mentioned Cutting Tool. 

6.19.2.1 First Nibble 
Add Nibble Entity with Tool Sequence of 1 to the right vertical side of the part. 

Make sure you make this cut with an 3 mm offset on each side. 

6.19.2.2 Second Nibble  
Add Nibble Entity with a Tool Sequence of 2 to the bottom horizontal side of the 
part. 

Make sure you make this cut with an 3 mm offset on each side. 

6.19.2.3 Current Part View 
The results should be as seen on the below picture. Note the offsets of the Cutting 
Tool: 
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6.19.3 Defining the Sheet 
Define the Sheet Size as 2000 x 1000, and set Number of Parts in Y as 1. As you 
can see, we now have a single line with 6 parts in it: 

  

6.19.4 Defining the Common Cuts 

Now, we will define Common Cuts for these parts – click the  button and set the 
parameters as shown below: 

 
 
The result will be: 
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6.19.5 Using Explode Multiple Part 
Now, select the Explode Multiple Part option from the Transform menu: 

 
When you now view the Sheet tab in the Set Sheet and Clamps dialog (click the 

 button to open this dialog), you will see there is only one part currently on the 
sheet: 

 

6.19.6 Deleting extraneous punches 
Delete the punching made with RE 65 5 tool, on the vertical right side of the part 

number 6 (the most right one) and Redraw the screen, using the  button. 

6.19.7 Setting the Trimming 
In the Set Sheet and Clamps go to the Trim Sheet tab, check Trim Sheet option, set 
the trimming tool to RE 65 5, choose the way you want the sheet to be trimmed and 
click OK button: 
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6.19.8 Adding Chute commands 
We will now set Chute (Push Out) commands; in this example we will open the 
chute at part 1, and close it at part 6: 
Select CAM => Push Out (Chute): 
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Set the parameters as shown below and click OK button: 

 
 
Click on the bottom cut of part 1; it will change to green to signify the Push Out 
command: 

 
 
Press on the Space bar to bring back the Push Out dialog, mark all the open 
options, click OK button and click on parts 2,3,4,5 (but not on part 6); the bottom cuts 
on all these parts will be colored green: 
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Press on the Space bar again, check the Close option, click OK button and then 
click on the last  part (the 6-th one). 

Normally, we will want to use the Chute command, but this can work with a 
Stop machine command as well. 

6.19.9 Adding more parts to the Sheet 
Open the Sheet tab in the Set Sheet and Clamps dialog and set the Number of 
Parts in Y to 100; this will ensure that the largest number of parts possible will be 
placed on the sheet. 

Now we will define Common Cuts for the sheet – click the  button and set the 
options as shown below: 

 

6.19.10 Setting the tools’ order  
Now, we will set the Cutting Tool (RE 65 5) as the first tool to be used for 

processing the sheet; from the Common Toolbar click the Used Tools button , 
and the Used Tools dialog will open, showing a list of the tools that will be used for 
processing the sheet. 

Click on the Cutting Tool and using the arrows –  move it to the first position in 
the list: 

 

The tool used to trim the sheet is designated as having a Tool Sequence of  
-99. 

Congratulation, now you have a Trimmed Sheet: 
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You may want to go back to Set Sheet and Clamps => Sheet Processing 
Technology tab, and select to work in Stripes (Line by Line) for all the tools, or just 
for the Cutting Tool. 

6.20 Changing Turret Numbering 
Each Turret has a default Numbering System that can be changed. In some cases it 
comes with a deferent system which is written in the Turret (*.trt) File. 
To change the numbering for your turret, in Machine Settings dialog, go to Machine 
tab => Machine Settings button. There edit your Master *.trt File and go to: 
[TurretInfo] 

 
If this line is not present in your turret file, and you wish to change station numbering, 
you should add it.  
There are three ways of changing Turret Numbering: 

• 0 – This is normal numbering of multi tool station in turret file. That means 
that each Multi-tool station is represented by its base number with two or 
three digit prelude as indication. With this option it is possible to change Multi-
tool numbering from the Tools Menu => Turret Setups => Edit Turret button. 

• 1 – This is a sequential numbering of multi-tool station in turret file. This 
means that each Multi-tool station will be given the next number after the 
single stations, for example in 20-station turret the first Multi-tool stations will 
be numbered as follows: 21,22, 23 and so on. It won't be possible to change 
these station numbers manually. 

• 2 – Here the number equals base station number (/K) * 100 + station index. 
That means that the first number of the Multi-tool station is the number of 
base station multiplied by a hundred and added on to the station index. With 
this option it is possible to change Multi-tool numbering from the Tools Menu 
=> Turret Setups => Edit Turret. 
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6.21 Re-Enabling the DOC Report Addin 
One of the features of cncKad is creating Job Reports from a Microsoft Word© 
template. 
This feature may get disabled because of various inter-application data exchanges. 
If this happens, the next time you try to generate a Job Report you will get this error 
message: 

 
In such a case, use the following procedure: 

1. Restart your computer. 
2. Open Microsoft Word©. 
3. Go to the Help menu and select the About… item: 

 
4. Click the Disabled Items… button at the bottom of the dialog: 

 
5. In the Disabled Item dialog, select the docreportaddin item and click the 

Enable button: 

 
Do not select other items – they are there for a reason! 

6. Close all dialogs and exit Word©. 
Now you can generate Job Reports again. 

6.22 Release Notes for BOSCHERT users 
In this section you will find explanations and instructions on how to Convert Old 
Boschert Tools and adjusting them for work with cncKad. 
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6.22.1 Boschert Tools 
cncKad uses two files for tools: 

• TOOLLIB.MDB – this one contains a list of ALL your tools 
• LABOD.SET – this one contains definitions of BOSCHERT tool numbers 

These files can be created manually (using any text editor or the editor that opens 
while clicking Edit NC in Files Menu in cncKad), or automatically from BOSCHERT 
WZG file in the following way: 

1. In your BOSCHERT machine, create a tool file and for NEW control. Now you 
will have a TOOLS.BIN file (in old controls it was: ECCO.WZG, TRI.WZG or 
PWR.WZG). 

2. Place the diskette with the tool file in your PC. 
3. From Start => Programs => Metalix, or from your Desktop, run Labod Tool 

Convertor. 
The program will look for the Machine Tool File on the Diskette. If it won't find it, you 
will be asked to locate it manually. When the program will find it, it will select and 
automatically ascribe the name of the setup file: LABOD.SET. The Labod Tool 
Convertor will create both the LABOD.SET and the TOOL.LIB files.   

6.22.1.1 Working with new setup file 
Now, in cncKad go to: Tools =>Turret Setups => Add/Create New. You should see 
LABOD.SET file in the dialog. Select it by double-clicking on it, or by clicking it once 
and then clicking Open button. The LABOD.SET file will appear in the Select Setup 
file dropdown list.  
When running the Post Processor (by clicking NC button), you will come to the Used 
Tools dialog, make sure that in Turret Setups section: 

• Use Current NC box is checked, 
• The LABOD.SET file is selected in the dropdown list 

This procedure needs to be done just once. Later on, the correct numbers will be 
automatically ascribed to the tools. 

6.22.1.2 Adding tool to machine 
When you add a new tool to the machine station, you have two options: 

• You can create an updated TOOLS.BIN or WZG file on diskette, and then 
run Labod Tool Convertor 

• In cncKad you can go to Tools =>Turret Setups => Edit Setup button and 
add the new tool.  

6.22.2 ToolN setting in Tool Library 
In the Tool Library Labod Tool Convertor automatically assigns, the ToolN for 
every tool, according to the turret station numbers they are in.  
This option is designated in order not to use LABOD.SET at all. 

6.22.3 Defining Tools' Angle 
Tools for Boschert machines should be defined this: RE 25 5 or this way: RE 25 5 90. 
You should always start naming the tool with the longer side. 

In old controls you could use tool angle ONLY for slanted tools. If you have 
a Rectangular tool of 25x5 at 90 degree, define it as RE 5 25 (and not 
as RE 25 5 90). 
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6.22.4 Setting the Machine Version Parameter 
Depending on the version of the machine controller being used – the program 
created within cncKad will have to be suitable. There are several options of setting 
the program version and they can be defined within the MDL file.  
To set it correctly, first check the size of the PGM file. Then, go to: Settings => 
Machine Settings => Machine tab => Machine Settings button. In the dialog which 
will open highlight your machine, and in Edit Machine Files select the MDL file you 
want to edit and click the Edit button. 
 
In the Editor go to: 
[Machine Info] 
MachineVersion = 11 

The 'MachineVersion' parameter could be one of the following: 
• 1: BOSCHERT PGM file, 26128 bytes 
• 2: BOSCHERT PGM file, 34278 bytes 
• 4: BOSCHERT PGM file, 34428 bytes 
• 6: BOSCHERT PGM file, 34428 bytes (File Version: 7.72) 

Versions 10 and upper ones are reserved for New LABOD format (which has no 
specific size for the file). 

• 10: New BOSCHERT format (Ver.1), no specific size. 
• 11: New BOSCHERT format (since 1999). Only ONE file is generated. 

Subroutine numbers are from 1 to 99. 
• 12: New BOSCHERT format. Each subroutine is in a different file. Main file 

has 4 digits (like 1234) and subroutines filenames has 8 digits: first four are 
the same as the main file name (1234). The following two are the subroutine 
number (from 01 to 99) and the last two digits are 00. i.e. the first subroutine 
for 1234 is 12340100.  

6.22.5 Offsets for Repeated Functions 
If you want the offsets to be the same for ALL the tools, you should make sure that 
all tools start processing from the same corner (e.g. Top-Left) and have the same 
processing Path (e.g. Snake X). 
This can be done in two ways: 

• By setting the corner and path for Parts, Vertical Cuts and Horizontal Cuts in 
Set Sheet and Clamps => Sheet Processing Technology tab. 

You can also set these parameters in Settings => Machine Settings => 
Laser Optimization tab. Then they will be the default for every part to 
be created. 

• By setting corner and path for every tool in Tools => Used Tools. 

6.22.6 Plasma / Roller / Engrave 
cncKad supports Plasma and Roller tools. When using plasma, it can cut the sheet 
or just engrave it. The B tool should be used for all these procedures. 

• For Plasma:  
o Plasma tool declaration: 

B <beam width> 
For example (1 mm plasma): 
B 1 
If you want to engrave using the Plasma – use the command Engrave 
Entities, then the Set Number for Engrave will be used 
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• For Punch: we still use the B tool, and the Add Cut command:  
o "Rollieren"   Roller tool declaration: 

B <roller width> N = 50 
For example (1 mm roller): 
B 1 N = 50 

o "Gravieren"   Engrave tool declaration: 
B <roller width> N = 60 
For example (1 mm engraving): 
B 1 N = 60 

Engrave text is also supported - simply use the Engrave Text feature in cncKad. 

6.22.7 Converting Plasma.bin to cncKad Laser Tables 
More on this feature you will find in Convert Plasma Table to cncKad section of 
Settings Menu chapter of Drafting and Nesting Manual (go to: Settings => Machine 
Settings => Cutting Parameters tab). 
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